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Preface 

(Director)

   Prof. Dhananjay Singh

I am sure that the new courseware of NIELIT will meet the requirements of the students and 
NCPUL will be in a position to discharge its mandate of linking Urdu to the contemporary 
requirements particularly, in the context of ever increasing use of information technology in our 
life.

National Council for Promotion of Urdu Language (NCPUL) is mandated to take action for 
making available in Urdu language the knowledge of scientific and technological development as 
well as knowledge of ideas evolved in the modern context. In the emerging information 
technological scenario, it was necessary that this technology is made available to the Urdu 
speaking population of the country with a view to transform Urdu speaking population into 
employable technical workforce.

It was in 1999 when a humble beginning was made and some Multilingual DTP Computer 
Centres were set up at select locations. From the beginning, attempt was made to provide standard 
course contents and ensure quality in computer education at par with the quality of agencies 
dedicated to computer awareness and education in the country. In this context, NIELIT, which is an 
approved Government of India agency for imparting computer education in non-formal sector, 
was engaged for conducting examination and certification. There has been a demand that curse 
contents need to be upgraded. Therefore, the NCPUL has entered into a MoU with NIELIT and 
delegated the powers of regulating academic standards and examinations to it. This course is now 
Computer Applications, Business Accounting & Multilingual DTP (CABA-MDTP) and it is 
hoped that course will enable the students pursuing this course to get CCC, CABA-MDTP 
Diploma and 'O' Level Certification from NCPUL and NIELIT. The important change in the 
eligibility will enable students with+2 qualification to pursue 'O' Level Diploma and those who are 
with Metric or equivalent qualification to pursue CCC and CABA-MDTP.
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CHAPTER 1 

Fundamentals of Information Technology 

1.1     Computer and Latest IT Gadgets 

The word computer comes from the word “compute”, which means, “to calculate”. Thereby, a 
computer is an electronic device that can perform arithmetic operations at high speed. A 
computer is also called a data processor because it can store, process, and retrieve data whenever 
desired.  
Data is a raw material used as input and the information is processed data obtained as output of 
data processing. The activity of processing data using a computer is called data processing. 

1.1.1   Characteristics of Computer 

 Automatic: Given a job, computer can work on it automatically without human 
interventions. 

 Speed: Computer can perform data processing jobs very fast, usually measured in 
microseconds (10-6), nanoseconds (10-9), and picoseconds (10-12). 

 Accuracy: Accuracy of a computer is consistently high and the degree of its accuracy 
depends upon its design. Computer errors caused due to incorrect input data or unreliable 
programs are often referred to as Garbage- In-Garbage-Out (GIGO). 

 Diligence: Computer is free from monotony, tiredness, and lack of concentration. It can 
continuously work for hours without creating any error and without grumbling 

 Versatility: Computer is capable of performing almost any task, if the task can be reduced to 
a finite series of logical steps. 

 Power of Remembering: Computer can store and recall any amount of information because 
of its secondary storage capability. It forgets or loses certain information only when it is 
asked to do so. 

 No I.Q.: A computer does only what it is programmed to do. It cannot take its own decision 
in this regard. 

 No Feelings: Computers are devoid of emotions. Their judgement is based on the instructions 
given to them in the form of programs that are written by us (human beings). 

1.2     Latest IT gadgets 

1.2.1   Laptop 

A laptop is a personal computer that can be easily moved and used in a variety of locations. Most 
laptops are designed to have all of the functionality of a desktop computer, which means they can 
generally run the same software and open the same types of files. However, laptops also tend to 
be more expensive than comparable desktop computers. 
Because laptops are designed for portability, there are some important differences between them 
and desktop computers. A laptop has an all-in-one design, with a built-
in monitor, keyboard, touchpad (which replaces the mouse), and speakers. This means it is 
fully functional, even when no peripherals are connected. A laptop is also quicker to set up, and 
there are fewer cables to get in the way. 
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Figure 1. 1 (Different Parts of Laptop) 

1.2.2   Digital Camera 

A digital camera is a hardware device that takes photographs and stores the image as data on 
a memory card. Unlike an analog camera, which exposes film chemicals to light, a digital camera 
uses digital optical components to register the intensity and color of light, and converts it 
into pixel data. Many digital cameras are capable of recording video in addition to taking photos. 
 
 

 

Figure 1. 2 (Digital Camera) 

 
Advantages of using Digital Camera 
The following are key advantages that make digital cameras a popular choice compared to film 
cameras. 

 LCD screen 
The rear-mounted LCD screen on a digital camera allows users to see their photos and videos 
immediately after they are taken. The LCD screen can also make it easier to frame your pictures. 
 

 Storage 
A digital camera can store thousands of pictures, instead of only up to 36 pictures. 
 

 Picture development 
Digital camera pictures can be developed like a standard film camera, but you can pick which 
pictures to develop instead of developing the whole roll of film. 
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 Size 
Because a digital camera does not need a place for film (not an SLR), it takes up far less space 
and can easily be carried in your pocket or purse. 
 

1.2.3   Bluetooth 

Bluetooth is a wireless technology that uses a radio frequency to share data over a short distance, 
eliminating the need for wires. You can use Bluetooth on your mobile device to share documents 
or to connect with other Bluetooth-enabled devices. 

 

Figure 1. 3 (Bluetooth Device) 

 

1.2.4   Smart watch 

A smartwatch is a wearable computing device that closely resembles a wristwatch or other time-
keeping device. 
In addition to telling time, many smartwatches are Bluetooth-capable. The watch becomes a 
wireless Bluetooth adaptor capable of extending the capabilities of the wearer's smartphone to the 
watch. The wearer can use the watch's interface to initiate and answer phone calls from their 
mobile phone, read email and text messages, get weather reports, listen to music, dictate email 
and text messages, and ask a digital assistant a question. 

 

Figure 1. 4 (Smart Watch) 

 
1.2.5   Air buds 

Airbuds are popularly known as wireless Bluetooth earbuds. The audio companies introduce such 
terms to diversify their product range for better market capture. The functions and features are 
completely identical. It is nothing but a wireless earbuds device that is also known as Airbuds. 
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Figure 1. 5 (Air Buds) 

 

1.2.6   Smartphone 

A smartphone is a mobile phone with highly advanced features. A typical smartphone has a high-
resolution touch screen display, WiFi connectivity, Web browsing capabilities, and the ability to 
accept sophisticated applications. The majority of these devices run on any of these popular 
mobile operating systems: Android, Symbian, iOS, BlackBerry OS and Windows Mobile. 

 

Figure 1. 6 (Smart Phone) 

 
1.3     Evolution of Computers and Its Applications 

 Blaise Pascal invented the first mechanical adding machine in 1642. 
 Baron Gottfried Wilhelm von Leibniz invented the first calculator for multiplication in 

1671. 
 Keyboard machines originated in the United States around 1880. 
 Around 1880, Herman Hollerith came up with the concept of punched cards that were 

extensively used as input media until late 1970s 
 Charles Babbage is considered to be the father of computer. He designed “Difference 

Engine” in 1822. He again designed a fully automatic analytical engine in 1842 for 
performing basic arithmetic operations. His efforts established a number of principles that 
are fundamental to the design of any digital computer. 

1.3.1   Some Well Known Early Computers 

 The Mark I Computer (1937-44) 
 The Atanasoff-Berry Computer (1939-42) 
 The ENIAC (1943-46) 
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 The EDVAC (1946-52) 
 The EDSAC (1947-49) 
 Manchester Mark I (1948) 
 The UNIVAC I (1951) 

Computer Generation 

 “Generation” in computer talk is a step in technology. It provides a framework for the 
growth of computer industry. 

 Originally it was used to distinguish between various hardware technologies, but now it 
has been extended to include both hardware and software. 

 Till today, there are five computer generations. 

 

Figure 1. 7 (1st and 2nd Generation of Computers) 

 

Figure 1. 8 (Third Generation of Computers) 
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Figure 1. 9 (Fourth Generation of Computers) 

 

Figure 1. 10 (Fifth Generation of Computers) 
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Figure 1. 11 (Generation of Computers) 

 
1.4    Applications of IT Gadgets 

Computers play a vital important role in our daily life. Computer helps in the development of 
communication and information technology around worldwide. It is a social tool that adds job 
skills necessary for the modern world (teach online interaction, how to type, use of programs, 
etc). It is also used to get information about reservation of tickets, books in a library, medical 
history of a person, place in a map, etc. 
The various applications of the computer in the field are as follows: 

 Education 
 Communication 
 Banking 
 Medical 
 Scientific Research 
 Entertainment 
 Government 
 Business 
 Designing 

1.5     Basics of Hardware and Software 

Computer is a device comprising both hardware and software. The functions of hardware and 
software combines together to make the Computer functional. A hardware device helps to enter 
input information. The software processes the input data and gives the output in the monitor, a 
hardware device. Thus a computer is like a human body, where human body is the hardware and 
soul is the software. 
The hardware and the software make up a complete operating computer system. Hardware is the 
mechanical device in a computer system that is interconnected for operation. The user may not be 
able to see all the hardware devices because they are internal to the computer’s casing. 
 
An example of this would be storage drives. Most of the hardware devices are a part of the 
motherboard that is responsible for controlling the computer. 
Software, on the other hand, works on the idea of instructing programs in computer language for 
execution. They tell the device what to perform and how to do it using a set of instructions. 
 
The software developers design the programs in such a way that there are instructions for all 
kinds of tasks. This is by using a high-level programming language which is then translated to 
binary form for the computer to read. 
 



Chapter 1 

8 
   

But software and hardware cannot function without each other. Hardware needs instruction to 
perform while software needs a processor to instruct. Thus they are dependent on each other. 

1.5.1   Hardware 

Hardware is the parts of a computer which we can touch and feel. Hardware includes Input and 
Output devices, Cabinet, Hard Disk, Mother Board, SMPS, CPU, RAM, CD Drive and Graphics 
Card. 

 

Figure 1. 12 (Hardware components of a Computer) 

1.5.2   Software 

Hardware is lifeless without software in a computer. Software are programmed and coded 
applications to process the input information. The software processes the data by converting the 
input information into coding or programmed language. Touching and feeling the software is not 
possible but we can see the functions of the software in the form of output. 
Examples: MS office, MS word, ANSYS, MATLAB, Solid Works HyperMesh etc. 
 
Basic Operation of Computer  
Inputting. The process of entering data and instructions into the computer system 
Storing. Saving data and instructions to make them readily available for initial or additional 
processing whenever required 
Processing. Performing arithmetic operations (add, subtract, multiply, divide, etc.) or logical 
operations (comparisons like equal to, less than, greater than, etc.) on data to convert them into 
useful information 
Outputting. The process of producing useful information or results for the user such as a printed 
report or visual display 
Controlling. Directing the manner and sequence in which all of the above operations are 
performed 
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Figure 1. 13 (Computer Hardware) 

1.6     Central Processing Unit 

 
Figure 1. 14 (Central processing Unit) 

 It is the brain of a computer system. 
 It is responsible for controlling the operations of all other units of a computer system. 

1.6.1   Arithmetic Logic Unit (ALU) 

An arithmetic logic unit (ALU) is a key component of a computer’s central processor unit. The 
ALU performs all arithmetic and logic operations that must be performed on instruction words. 
The ALU is split into two parts in some microprocessor architectures: the AU and the LU. 
 
ALU conducts arithmetic and logic operations. It is a major component of the CPU in a computer 
system. An integer unit (IU) is just an integrated circuit within a GPU or GPU that performs the 
last calculations in the processor. 
 
It can execute all arithmetic and logic operations, including Boolean comparisons, such as 
subtraction, addition, and shifting (XOR, OR, AND, and NOT operations). Binary numbers can 
also perform bitwise and mathematical operations. AU (arithmetic unit) and LU (logic unit) are 
two types of arithmetic logic units. The ALU’s operands and code instruct it on which operations 
to perform based on the incoming data. When the ALU has finished processing the data, it sends 
the result to the computer memory. 
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1.6.2   Control Unit (CU) 

A control unit, or CU, is circuitry within a computer’s processor that directs operations. It 
instructs the memory, logic unit, and both output and input devices of the computer on how to 
respond to the program’s instructions. CPUs and GPUs are examples of devices that use control 
units. 
 
The CPU control unit is a component of the computer’s CPU (central processing unit) that directs 
the processor’s operation. John von Neumann included it in his Von Neumann Architecture. The 
control unit’s job is to instruct the computer’s arithmetic/logic unit, memory, and input and 
output devices on how to respond to the instructions supplied to the processor. 

 

Figure 1. 15 (Working of Control Unit) 

 
The control unit fetches internal program instructions from the main memory to the processor 
instruction register, and it generates a control signal based on the contents of this register to 
supervise the execution of these instructions. 

1.7    The Role of Input Devices 

Input Devices 
Input refers to the data, software, or institutions that we enter into the computer. Input devices are 
computer components with the help of which we enter programs, data etc. into the computer. 
Some examples of input devices are the keyboard, mouse, trackball, and light pen. 
 
An input unit of a computer system performs the following functions: 

 It accepts (or reads) instructions and data from outside world. 
 It converts these instructions and data in computer acceptable form. 
 It supplies the converted instructions and data to the computer system for further 

processing. 
 Provide means of communication between a computer and outer world. 
 Also known as peripheral devices because they surround the CPU and memory of a 

computer system. 
 Input devices are used to enter data from the outside world into primary storage. 
 Output devices supply results of processing from primary storage to users. 
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Figure 1.16 (Role of Input Devices) 

Commonly Used Input Devices 
 Keyboard devices 
 Point-and-draw devices 
 Data scanning devices 
 Digitizer 
 Electronic cards based devices 
 Speech recognition devices 
 Vision based devices 

1.7.1   Keyboard Devices 

 

Figure 1. 17 (Keyboard) 

 

Allow data entry into a computer system by pressing a set of keys (labelled buttons) neatly 
mounted on a keyboard connected to a computer system. 101-keys QWERTY keyboard is most 
popular. 
 
 

1.7.2   Point-and-Draw Devices 

Used to rapidly point to and select a graphic icon or menu item from multiple options displayed 
on the Graphical User Interface (GUI) of a screen. It is used to create graphic elements on the 
screen such as lines, curves, and freehand shapes. 
Some commonly used point-and-draw devices are mouse, track ball, joy stick, light pen, and 
touch screen. 
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1.7.3   Mouse 

 

Figure 1. 18 (Mouse) 

 
Commonly used in personal computers and workstations. The mouse is one of the smallest input 
devices. It helps us to point several things which are displayed on the computer. Modern type of 
mouse has only two buttons. The design of the mouse is arranged in such a way that it can be 
well moved without any opposing force and nicely fits in our palm. In modern operating systems 
like Ubuntu, Windows, Macintosh etc., the mouse helps the user to point images, folders etc. 
without writing commands. 

1.7.4   Trackball 

 

Figure 1. 19 (Trackball) 

 Commonly used in laptop (notebook) computers. This input device can be used as an alternative 
to the mouse. It contains ball which is rolled by our fingers directly. This device is often used by 
travelers who are in need of short space and unable to find a flat surface. 

  

1.7.5   Joystick 

 

Figure 1. 20 (Joystick) 

 Commonly used for video games, flight simulators, training simulators, and for controlling 
industrial robots. 
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1.7.6   Electronic Pen 

 

Figure 1. 21 (Electronic Pen) 

 Pen-based point-and-draw device. 
 Used to directly point with it on the screen to select menu items or icons or directly draw 

graphics on the screen. 
 Can write with it on a special pad for direct input of written information to a system. 
 Pressure on tip of a side button is used to cause same action as right-button-click of a 

mouse. 

1.7.7   Touch Screen 

 

Figure 1. 22 (Touch Screen) 

 Most simple, intuitive, and easiest to learn of all input devices 
 Enables users to choose from available options by simply touching with their finger the 

desired icon or menu item displayed on the screen 
 Most preferred human-computer interface used in information kiosks. 

1.7.8   Image Scanner 

 

Figure 1. 23 (Image Scanner) 

 Input device that translates paper documents into an electronic format for storage in a 
computer. 
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 Electronic format of a scanned image is its bit map representation. 
 Stored image can be altered or manipulated with an image-processing software. 

1.7.9  Optical Character Recognition (OCR) Device 

 Scanner equipped with a character recognition software (called OCR software) that 
converts the bit map images of characters to equivalent ASCII codes. 

 Enables word processing of input text and also requires less storage for storing the 
document as text rather than an image. 

 

 

Figure 1. 24 (OCR) 

 
 OCR software is extremely complex because it is difficult to make a computer recognize an 

unlimited number of typefaces and fonts. 
 Two standard OCR fonts are OCR-A (American standard) and OCR-B (European standard). 

1.7.10    Optical Mark Reader (OMR) 

 

Figure 1. 25 (OMR) 

 Scanner capable of recognizing a pre-specified type of mark by pencil or pen. 
 Very useful for grading tests with objective type questions, or for any input data that is of a 

choice or selection nature. 
 Technique used for recognition of marks involves focusing a light on the page being scanned and 

detecting the reflected light pattern from the marks. 

1.7.11    Barcode Reader 

 Scanner used for reading (decoding) bar-coded data 
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 Bar codes represent alphanumeric data by a combination of adjacent vertical lines (bars) 
by varying their width and the spacing between them. 

 
Figure 1. 26 (Barcode Reader) 

 

 Scanner uses laser-beam to stroke across pattern of bar code. Different patterns of bars reflect 
the beam in different ways sensed by a light-sensitive detector. 

 Universal Product Code (UPC) is the most widely known bar coding system. 

1.7.12     Magnetic-Ink Character Recognition (MICR) 

 

Figure 1. 27 (MICR) 

 MICR is used by banking industry for faster processing of large volume of cheques. 
 Bank’s identification code (name, branch, etc.), account number and cheque number are pre-

printed (encoded) using characters from a special character set on all cheques. 
 Special ink is used that contains magnetisable particles of iron oxide. 
 MICR reader-sorter reads data on cheques and sorts them for distribution to other banks or 

for further processing. 

1.7.13     Digitizer 

 

 
Figure 1. 28 (Digitizer) 
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 Input device used for converting (digitizing) pictures, maps and drawings into digital form for 
storage in computers. 

 Commonly used in the area of Computer Aided Design (CAD) by architects and engineers to 
design cars, buildings medical devices, robots, mechanical parts, etc. 

 Used in the area of Geographical Information System (GIS) for digitizing maps available in 
paper form. 

1.7.14     Electronic-card Reader 

 

Figure 1. 29 (Electronic Card Reader) 

 Electronic cards are small plastic cards having encoded data appropriate for the application for 
which they are used. 

 Electronic-card reader (normally connected to a computer) is used to read data encoded on an 
electronic card and transfer it to the computer for further processing. 

 Used together as a means of direct data entry into a computer system. 
 Used by banks for use in automatic teller machines (ATMs) and by organizations for controlling 

access of employees to physically secured areas. 

1.8     Output Devices 

 An output unit of a computer system performs the following functions: 
 It accepts the results produced by the computer, which are in coded form and hence, cannot be 

easily understood by us 
 It converts these coded results to human acceptable (readable) form 
 It supplies the converted results to outside world 

Commonly Used Output Devices 
 Monitors 
 Printers 
 Plotters 
 Screen image projector 
 Voice response systems 

1.9     Computer Memory and Storage 

The storage unit of a computer system holds (or stores) the following: 

 Data and instructions required for processing (received from input devices) 
 Intermediate results of processing 
 Final results of processing, before they are released to an output device 
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1.9.1   Types of Memory 

 Register Memory 
 Cache Memory 
 Primary Memory 
 Secondary Memory 

 

Figure 1. 30 (Different types of memory and their relative speed) 

1.9.2    Register Memory 

Register memory is the smallest and fastest memory in a computer. It is not a part of the main 
memory and is located in the CPU in the form of registers, which are the smallest data holding 
elements. A register temporarily holds frequently used data, instructions, and memory address 
that are to be used by CPU. They hold instructions that are currently processed by the CPU. All 
data is required to pass through registers before it can be processed. So, they are used by CPU to 
process the data entered by the users. 
 
Registers hold a small amount of data around 32 bits to 64 bits. The speed of a CPU depends on 
the number and size (no. of bits) of registers that are built into the CPU. Registers can be of 
different types based on their uses. Some of the widely used Registers include Accumulator or 
AC, Data Register or DR, the Address Register or AR, Program Counter (PC), I/O Address 
Register, and more. 
 
1.9.3 Types and Functions of Computer Registers: 
 
Data Register: It is a 16-bit register, which is used to store operands (variables) to be operated 
by the processor. It temporarily stores data, which is being transmitted to or received from a 
peripheral device. 
 
Program Counter (PC): It holds the address of the memory location of the next instruction, 
which is to be fetched after the current instruction is completed. So, it is used to maintain the path 
of execution of the different programs and thus executes the programs one by one, when the 
previous instruction gets completed. 
 
Instructor Register: It is a 16-bit register. It stores the instruction which is fetched from the 
main memory. So, it is used to hold instruction codes, which are to be executed. The Control 
Unit takes instruction from Instructor Register, then decodes and executes it. 
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Accumulator Register: It is a 16-bit register, which is used to store the results produced by the 
system. For example, the results generated by CPU after the processing are stored in the AC 
register. 
 
Address Register: It is a 12-bit register that stores the address of a memory location where 
instructions or data is stored in the memory. 
 
I/O Address Register: Its job is to specify the address of a particular I/O device. 
 
I/O Buffer Register: Its job is to exchange the data between an I/O module and the CPU. 

1.9.3   Cache Memory 

 
Figure 1. 31 (Computer Memory) 

 

Cache memory is a very high speed semiconductor memory which can speed up the CPU. It acts 
as a buffer between the CPU and the main memory. It is used to hold the data and program which 
are most frequently used by the CPU. The parts of data and programs are transferred from the 
disk to cache memory by the operating system, from where the CPU can access them. 

1.9.4 Primary Memory (Main Memory) 

Primary memory is also known as main memory or may also refer to "Internal memory. Primary 
memory holds only those data and instructions on which the computer is currently working. It 
has a limited capacity and data is lost when power is switched off. It is generally made up of 
semiconductor device. These memories are not as fast as registers. The data and instruction 
required to be processed resides in the main memory. It is divided into two subcategories RAM 
and ROM. 

 

Figure 1. 32 (Types of Main memory) 
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Characteristics of Main Memory 

 These are semiconductor memories. 
 It is known as the main memory. 
 Usually volatile memory. 
 Data is lost in case power is switched off. 
 It is the working memory of the computer. 
 Faster than secondary memories. 
 A computer cannot run without the primary memory.  

 
 RAM (Random Access Memory) 
The Word “RAM” stands for “random access memory” or may also refer to short-term memory. 
It’s called “random” because you can read store data randomly at any time and from any physical 
location. It is a temporal storage memory. RAM is volatile that only retains all the data as long as 
the computer powered. It is the fastest type of memory. RAM stores the currently processed data 
from the CPU and sends them to the graphics unit. 
 
 Static RAM: Static RAM is the form of RAM and made with flip flops and used for primary 
storage are volatile. It retains data in latch as long as the computer powered. SRAM is more 
expensive and consumes more power than DRAM. It used as Cache Memory in a computer 
system. As technically, SRAM uses more transistors as compared to DRAM. It is faster 
compared to DRAM due to the latching arrangement, and they use 6 transistors per data bit as 
compared to DRAM, which uses one transistor per bit. 
 
Dynamic Random Access Memory (DRAM): It is another form of RAM used as Main 
Memory, its retains information in Capacitors for a short period (a few milliseconds) even though 
the computer powered. The Data is Refreshed Periodically to maintain in it. The DRAM is 
cheaper, but it can store much more information. Moreover, it is also slower and consumes less 
power than SRAM. 
 
 ROM (Read Only Memory) 
ROM is the long-term internal memory. ROM is “Non-Volatile Memory” that retains data 
without the flow of electricity. ROM is an essential chip with permanently written data or 
programs. It is similar to the RAM that is accessed by the CPU. ROM comes with pre-written by 
the computer manufacturer to hold the instructions for booting-up the computer. 
 
There is generally Three broad type of ROM: 
 
PROM (Programmable Read Only Memory): PROM stands for programmable ROM. It can 
be programmed only be done once and read many. Unlike ROM, PROMs retain their contents 
without the flow of electricity. PROM is also nonvolatile memory. The significant difference 
between a ROM and a PROM is that a ROM comes with pre-written by the computer 
manufacturer whereas PROM manufactured as blank memory. PROM can be programmed by 
PROM burner and by blowing internal fuses permanently. 
 
EPROM (Erasable Programmable Read Only Memory): EPROM is pronounced ee-prom. 
This memory type retains its contents until it exposed to intense ultraviolet light that clears its 
contents, making it possible to reprogram the memory. 
 
EEPROM (Electrically Erasable Programmable Read Only Memory): EEPROM can be 
burned (programmed) and erased by first electrical waves in a millisecond. A single byte of a 
data or the entire contents of device can be erased. To write or erase this memory type, you need 
a device called a PROM burner. 
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1.9.5 Secondary Memory 
This type of memory is also known as external memory or non-volatile. It is slower than 
the main memory. These are used for storing data/information permanently. CPU directly 
does not access these memories, instead they are accessed via input-output routines. The 
contents of secondary memories are first transferred to the main memory, and then the 
CPU can access it. For example, disk, CD-ROM, DVD, etc.   

 Magnetic storage media:  Magnetic media is coated with a magnetic layer which is 
magnetized in clockwise or anticlockwise directions. When the disk moves, the head 
interprets the data stored at a specific location in binary 1s and 0s at reading.  
Examples: hard disks, floppy disks and magnetic tapes. 

 Floppy Disk: A floppy disk is a flexible disk with a magnetic coating on it. It is packaged 
inside a protective plastic envelope. These are one of the oldest type of portable storage 
devices that could store up to 1.44 MB of data but now they are not used due to very less 
memory storage.  

 Hard disk: A hard disk consists of one or more circular disks called platters which are 
mounted on a common spindle. Each surface of a platter is coated with a magnetic 
material. Both surfaces of each disk are capable of storing data except the top and bottom 
disk where only the inner surface is used. The information is recorded on the surface of 
the rotating disk by magnetic read/write heads. These heads are joined to a common arm 
known as access arm.   

 Optical storage media: In optical storage media information is stored and read using a 
laser beam. The data is stored as a spiral pattern of pits and ridges denoting binary 0 and 
binary 1. 
Examples: CDs, DVDs, Blue ray disc.    
 

 Compact Disk: A Compact Disc drive (CDD) is a device that a computer uses to read 
data that is encoded digitally on a compact disc (CD). A CD drive can be installed inside 
a computer’s compartment, provided with an opening for easier disc tray access or it can 
be used by a peripheral device connected to one of the ports provided in the computer 
system. A compact disk or CD can store approximately 650 to 700 megabytes of data.  

 DVD: It stands for Digital Versatile Disk or Digital Video Disk. It looks just like a CD 
and use a similar technology as that of the CDs but allows tracks to be spaced closely 
enough to store data that is more than six times the CD’s capacity. It is a significant 
advancement in portable storage technology. A DVD holds 4.7 GB to 17 GB of data.   

 Blue Ray Disk: This is the latest optical storage media to store high definition audio and 
video. It is similar to a CD or DVD but can store up to 27 GB of data on a single layer 
disk and up to 54 GB of data on a dual layer disk. While CDs or DVDs use red laser 
beam, the blue ray disk uses a blue laser to read/write data on a disk.  

 Solid State Memories: Solid-state storage devices are based on electronic circuits with 
no moving parts like the reels of tape, spinning discs etc. Solid-state storage devices use 
special memories called flash memory to store data. Solid state drive (or flash memory) is 
used mainly in digital cameras, pen drives or USB flash drives.  

 Pen Drives: Pen Drives or Thumb drives or Flash drives are the recently emerged 
portable storage media. It is an EEPROM based flash memory which can be repeatedly 
erased and written using electric signals. This memory is accompanied with a USB 
connector which enables the pen drive to connect to the computer. They have a capacity 
smaller than a hard disk but greater than a CD. 

 Memory Card: A memory card is a type of storage device that is used for storing media 
and data files. It provides a permanent and non-volatile medium to store data and files 
from the attached device. Memory cards are commonly used in small, portable devices, 
such as cameras and phones. A memory card is also known as a flash card. Most memory 
cards today range in size from as small as 4 GB (gigabyte) up to as large as 128 GB.  
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 Solid State Drive: An SSD is a storage medium that uses non-volatile memory as a 

means of holding and accessing data. An SSD has no moving parts which gives it 
advantages such as faster access time, noiseless operation, higher reliability, and lower 
power consumption. SSDs have become suitable replacements for a standard hard drive 
in both desktop and laptop computers.  

1.9.6   Functions of Primary storage 

 Used to hold running program instructions 
 Used to hold data, intermediate results, and results of ongoing processing of job(s) 
 Fast in operation 
 Small Capacity 
 Expensive 
 Volatile (loses data on power dissipation) 

1.9.7   Functions of Secondary storage 

 Used to hold stored program instructions 
 Used to hold data and information of stored jobs 
 Slower than primary storage 
 Large Capacity 
 Lot cheaper that primary storage 
 Retains data even without power 

1.10 Application Software 

Application software solve a specific problem or do a specific task. Programs included in an 
application software package are called application programs and the programmers who prepare 
them are called application programmers. An application software is bought by the user to 
perform specific applications or tasks, say for example making a document or making a 
presentation or handling inventory or managing the employee database. An application software 
can be of two types –  

 General Purpose Application Software  
 Special Purpose Application software 

Examples of application software are word processing, inventory management, preparation of tax 
returns, banking, etc. 

1.10.1 General Purpose Application Software 

General purpose software is software that can be used for a variety of tasks. 
 
General purpose software includes office applications, such as presentation software and word 
processing software. For example, presentation software is primarily designed for users to create 
presentations, but it may also be used to create a simple poster or diagram. 
 
Because general purpose software can be used for a number of different tasks, it is likely to 
attract a lot of users, and therefore, it can be sold at quite a low price. 

1.10.2 Special Purpose Software 

Special purpose software is software that can only be used for one particular task. 
 
For example, scientific calculator software can carry out calculations, but it cannot be used to 
perform any other tasks, such as writing an essay or designing a logo. 
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Typically, special purpose software is developed to fulfil a particular business need and therefore 
does not need to offer a wide range of alternative functions. Special purpose software is usually 
more expensive than general purpose software, because it will only be purchased by the users 
who need the particular functionality that it offers. 

1.11  Systems Software 

System Software is the software that is directly related to coordinating computer operations and 
performs tasks associated with controlling and utilizing computer hardware. These programs 
assist in running application programs and are designed to control the operation of a computer 
system. System software directs the computer what to do, when to do and how to do. System 
software can be further categorized into: 

 Operating System 
 Language Translators 

1.12  Utility Software 

A utility software is one which provides certain tasks that help in proper maintenance of the 
computer. The job of utility programs is to keep the computer system running smoothly. 
Nowadays many utility software’s are part of the operating system itself. Even if there is no 
utility software on your computer, the computer works but with the right kind of utility software 
loaded, the computer becomes more reliable and even its processing speed increases. Some of the 
commonly use utility softwares are antivirus, Disk defragmenter, backup, compression etc. 

1.13  Open Source and Proprietary Software 

Open source software is software with source code that anyone can inspect, modify, and enhance. 
"Source code" is the part of software that most computer users don't ever see; it's the code 
computer programmers can manipulate to change how a piece of software—a "program" or 
"application"—works. Programmers who have access to a computer program's source code can 
improve that program by adding features to it or fixing parts that don't always work correctly. 
 
Examples:  GNU/Linux, Mozilla Firefox, VLC media player, SugarCRM, GIMP, VNC, Apache 
web server, LibreOffice. 
 
Proprietary software is any software that is copyrighted and bears limits against use, 
distribution and modification that are imposed by its publisher, vendor or developer. Proprietary 
software remains the property of its owner/creator and is used by end-users/organizations under 
predefined conditions. 
Proprietary software may also be called closed-source software or commercial software. 
Examples: Microsoft Windows, Adobe Flash Player, PS3 OS, Orbis OS, iTunes, Adobe 
Photoshop etc. 

1.13.1     Firmware 

 Firmware is software substituted for hardware and stored in read-only memory 
 Firmware technology has enabled production of various types of smart machines having 

microprocessor chips with embedded software 

1.13.2     Middleware 

 Basic idea is to have a separate software layer to: 
 Act as “glue” between client and server parts of application 
 Provide programming abstraction 
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 Mask heterogeneity of underlying network, hardware, and OS 
 Encourages three-tier software architecture against two- tier popularized by Server-Client 

architecture 

1.14  Mobile Apps 

A mobile app is a software application developed specifically for use on small, wireless 
computing devices, such as smartphones and tablets, rather than desktop or laptop computers. 
Examples: Google Pay, PhonePe, Facebook, Unacademy, Instagram, Whatsapp etc.  

1.15  Number System 

In digital system, number system is used for representing the information. A number system with 
base ‘r’ have r different digits. These numbers are varying from 0 to (r-1).  

1.15.1     Types of Number system 

The following are the important number system used in digital electronics: 
 Decimal system 
 Binary System 
 Octal System 
 Hex-Decimal Number System 

 
Fig. 1.23 Different types of Number System 

 
Number System Different Digits 

Binary 
0,1 

Octal 
0,1,2,3,4,5,6,7 

Decimal 
0,1,2,3,4,5,6,7,8,9 

Hex-Decimal 
0,1,2,3,4,5,6,7,8,9,A,B,C,D,E,F 

Table 1. 1 (Number System) 

1.15.2     What is a Binary Number System? 

Binary Number System: A Binary Number system is a type of number system whose base is 2 
and have 2 different digits ‘0’ and ‘1’. 
The binary system is used by almost all computers and computer-based devices because of its 
direct implementation in electronic circuits using logic gates. Every digit is referred to as a bit.  
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1.16  Decimal to Binary conversion 

The decimal number is converted into a Binary number using following conversion steps: 
 Divide the number by 2. 
 Get the integer quotient for the next iteration. 
 Get the remainder for the binary digit. 
 Repeat the steps until the quotient is equal to 0. 

 
Example 1: Convert 4 in Binary. 
 
Solution:  Here, 4 is represented in the decimal number system, where we can represent the 
number using the digits from 0-9. However, in a binary number system, we use only two digits, 
such as 0 and 1. 
 
The following steps help to convert 4 in binary. 
Step 1: First, divide the number 4 by 2. Use the integer quotient obtained in this step as the 
dividend for the next step. Continue this step, until the quotient becomes 0. 

Dividend Remainder 

4/2 = 2 0 

2/2 = 1 0 

1/2 = 0 1 

Table 1. 2 (Decimal to Binary Conversion) 

 

Step 2: Now, write the remainder in reverse chronological order. (i.e from bottom to top). 
Here, the Least Significant Bit (LSB) is 0 and the Most Significant Bit (MSB) is 1. 
Hence, the decimal number 4 in binary is (100)2. 
 
 
 
 
Example 2: Convert 26 in Binary 
 
Solution:  Here, 26 is represented in the decimal number system, where we can represent the 
number using the digits from 0-9. However, in a binary number system, we use only two digits, 
such as 0 and 1. 
 
The following steps help to convert 26 in binary. 
Step 1: First, divide the number 26 by 2. Use the integer quotient obtained in this step as the 
dividend for the next step. Continue this step, until the quotient becomes 0. 

Dividend Remainder 

26/2 = 13 0 

13/2 = 6 1 
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6/2 = 3 0 

3/2=1 1 

1/2=0 1 

Table 1. 3 (Decimal to Binary Conversion) 

Step 2: Now, write the remainder in reverse chronological order. (i.e from bottom to top). 

Here, the Least Significant Bit (LSB) is 0 and the Most Significant Bit (MSB) is 1. 

Hence, the decimal number 26 in binary is (11010)2. 

1.16.1 What is bit in Binary Number? 

A single binary digit is called a “Bit”. A binary number consists of several bits. 

Examples are: 
 10101 is a five-bit binary number 
 101 is a three-bit binary number 
 100001 is a six-bit binary number 

1.17  Binary to Decimal Conversion 

For binary number with n digits: 
dn-1 ... d3 d2 d1 d0 
The decimal number is equal to the sum of binary digits (dn) times their power of 2 (2n): 
decimal = d0×20 + d1×21 + d2×22 + ... 
Example 
Find the decimal value of (111001)2: 

binary number: 1 1 1 0 0 1 

power of 2: 25 24 23 22 21 20 

Table 1. 4 (Binary to Decimal) 

1110012 = 1*25+1*24+1*23+0*22+0*21+1*20 = (57)10. 

 

1.18 Octal Number System 

A number system which has its base as ‘eight’ is called an Octal number system. It has different 
numbers from 0 to 7. As we said, any number with base 8 is an octal number like (24)8, (109)8, 
(55)8, etc. 
If we solve an octal number, each place is a power of eight. 
(124)8 = 1 × 82 + 2 × 81 + 4 × 80 

1.19 Decimal to Octal Number Conversion 

To convert decimal to octal numbers, the decimal number is divided by 8 each time, it yields or 
gives a remainder. The first remainder we get is the least significant digit(LSD) and the last 
remainder is the most significant digit(MSD).  
Let us understand the conversion with the help example. 
Problem 1: Convert (560)10 into octal. 
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Solution:  

Dividend Remainder 

560/8 = 70 
0 

70/8 = 8 
6 

8/8 = 1 
0 

1/8=0 
1 

Table 1. 5 (Decimal to Octal Conversion) 

So the octal number starts from MSD to LSD, i.e. 1060. 
Therefore, 56010 = 10608 
 
Problem: Convert 0.52 into an octal number. 
 
Solution: The fraction part of the decimal number has to be multiplied by 8. 
0.52 × 8 = 0.16 with carry 4 
0.16 × 8 = 0.28 with carry 1 
0.28 × 8 = 0.24 with carry 2 
0.24 × 8 = 0.92 with carry 1 
So, for the fractional octal number, we read the generated carry from up to down. 
Therefore, (0.4121) is the octal equivalent of the decimal number (0.52)10. 

1.20 Octal to Decimal Conversion 

To convert an octal number to a decimal number we need to multiply each digit of the given octal 
with the reducing power of 8.  
Examples on Octal to Decimal 
 
Example 1: Convert (215)8 into decimal Equivalent. 
2158 = 2 × 82 + 1 × 81 + 5 × 80 
          = 2 × 64+ 1 × 8 + 5 × 1 = 128 + 8 + 5 
          = (141)10 
Example 2: Convert (125)8 into decimal equivalent. 
1258 = 1× 82 + 2 × 81 + 5 × 80 
          = 1 × 64 + 2 × 8 + 5 × 1 = 64+16+5 
          = (85)10 

1.21 Hexadecimal number system  

The hexadecimal number system is a type of number system, that has a base value equal to 16. 
Hexadecimal numbers are represented by 16 different symbols. These symbols or digits are 0, 1, 
2, 3, 4, 5, 6, 7, 8, 9, A, B, C, D, E and F. Each digit represents a decimal value. For example, D is 
equal to (13)10. 
Hexadecimal number systems can be converted to other number systems such as binary number 
(base-2), octal number (base-8) and decimal number systems (base-10).  The list of 16 
hexadecimal digits with their decimal equivalent is given below:  



Chapter 1 

27 
   

 

Hexadecimal 0 1 2 3 4 5 6 7 8 9 A B C D E F 

Decimal 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 

Table 1. 6 (Different digits of hex-decimal ) 

1.22  Decimal to Hexadecimal Conversion 

The decimal number is converted into Hex-decimal number using the following steps: 
 Firstly, divide the number by 16. 
 Take the quotient and divide again by 16. 
 The remainder left will produce the hex value. 
 Repeats the steps until the quotient has become 0. 

 
Example: Convert (242)10 into hexadecimal. 
 
Solution: Divide 242 by 16 and repeat the steps, till the quotient is left as 0. 

Dividend Remainder 

242/16 = 15 
2 

15/16 = 0 
15 (F) 

Table 1. 7 (Decimal To Hex-decimal Conversion) 

Therefore, (242)10 = (F2)16 

 
 

1.23  Hexadecimal to Decimal Conversion 

For hex number with n digits: 
dn-1 ... d3 d2 d1 d0 
Multiply each digit of the hex number with its corresponding power of 16 and sum: 
decimal = dn-1×16n-1 + ... + d3×163 + d2×162 + d1×161+d0×160 

 
Example 1 
3B in base 16 is equal to each digit multiplied with its corresponding 16n: 
3B16 = 3×161+11×160 = 48+11 = 5910 
 
Example 2 
E7A9 in base 16 is equal to each digit multiplied with its corresponding 16n: 
E7A916 = 14×163+7×162+10×161+9×160 = 57344+1792+160+9 = 5930510 
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1.24   MCQs and Exercise Problems 

1. The main system board of the computer is called ____. 

a. Motherboard 
b. Processor 
c. Microchip 
d. None of these 

2. Which of the following system components is the brain of a computer? 

a. Circuit board 
b. CPU 
c. Memory 
d. Network card 

3. What is the built-in permanent memory in a computer called? 

a. RAM 
b. ROM 
c. CPU 
d. CD-ROM 

4. Which of the following is the full form of NTFS? 

a. New Tree File system 
b. New Technology file system 
c. c.New Table file system 
d. Both B and C 

5. Which of the following is not a hardware processing chip? 

a. Processing chip 
b. printer 
c. mouse 
d. Java 

6. 8. The given hexadecimal number (1E.53)16 is equivalent to ____________ 
a) (35.684)8 
b) (36.246)8 
c) (34.340)8 
d) (35.599)8 
 

7. The octal number (651.124)8 is equivalent to ______ 
a) (1A9.2A)16 
b) (1B0.10)16 
c) (1A8.A3)16 
d) (1B0.B0)16 
 

8. The octal equivalent of the decimal number (417)10 is _____ 
a) (641)8 
b) (619)8 
c) (640)8 
d) (598)8 



Chapter 2 

29 
   

9. Convert the Decimal Number to Octal number:8510 
a. 1358 
b. 1248 
c. 1458 
d. 1258 

10. Bernoulli disks are a type of magnetic floppy disks. 
a) True 
b) False 

Exercise Problems 

1. What are the main functions of an ALU? 

2. What are the components of the computer systems? 

3. Differentiate between Data and Information? 

4. Define computer? 

5. What are the characteristics of Computer? 

6. Binary to Decimal Conversion 

(10110.001)2 

7. Binary to octal conversion 

(111110101011.0011)2 

8. Explain some IT gadgets and their applications. 

9. Explain in brief about Application Software, Systems Software, Utility Software. 

10. Explain about Open source and Proprietary Software. 
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CHAPTER 2 

PC Assembly and Operations 

2.1  Personal Computers 

A personal computer is a small computer with a microprocessor, designed for use by an 

individual. Example of personal computers are desktop computers used in homes, schools and 

small businesses. 

2.2  Types of Computers 

A computer is a device that transforms data into meaningful information. It processes the input 

according to the set of instructions provided to it by the user and gives the desired output. 

Computers are of various types and they can be categorized in two ways on the basis of size and 

on the basis of data handling capabilities. 

 

So, on the basis of size, there are five types of computers: 

i. Supercomputer 

ii. Mainframe computer 

iii. Minicomputer 

iv. Workstation 

v. PC (Personal Computer) 

And on the basis of data handling capabilities, there are three types of computer: 

i. Analogue Computer 

ii. Digital Computer 

iii. Hybrid Computer 

Now let us discuss each type of computer in detail: 

2.2.1 Supercomputer 

When we talk about speed, then the first name that comes to mind when thinking of computers is 

Figure 2. 1 (Super Computer) 
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supercomputers. They are the biggest and fastest computers (in terms of speed of processing 

data). Supercomputers are designed such that they can process a huge amount of data, like 

processing trillions of instructions or data just in a second. This is because of the thousands of 

interconnected processors in supercomputers. It is basically used in scientific and engineering 

applications such as weather forecasting, scientific simulations, and nuclear energy research. It 

was first developed by Roger Cray in 1976. 

2.2.2 Mainframe computer 

Mainframe computers are designed in such a way that it can support hundreds or thousands of 

users at the same time. It also supports multiple programs simultaneously. So, they can execute 

different processes simultaneously. All these features make the mainframe computer ideal for big 

organizations like banking, telecom sectors, etc., which process a high volume of data in general. 

2.2.3 Minicomputer 

Minicomputer is a medium size multiprocessing computer. In this type of computer, there are 

two or more processors, and it supports 4 to 200 users at one time. Minicomputers are used in 

places like institutes or departments for different work like billing, accounting, inventory 

management etc. It is smallerthan a mainframe computer but larger in comparison to the 

microcomputer. 

 

Figure 2. 3 (Mini Computer) 

Figure 2. 2 (Mainframe Computer) 
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2.2.4 Workstation: 

Workstation is designed for technical or scientific applications. It consists of a fast 

microprocessor, with a large amount of RAM and high speed graphic adapter. It is a single-user 

computer. It generally used to perform a specific task with great accuracy. 

 

2.2.5  PC 

PC (Personal Computer): It is also known as a microcomputer. It is basically a general-

purpose computer and designed for individual use. It consists of a microprocessor as a central 

processing unit(CPU), memory, input unit, and output unit 

 

This kind of computer is suitable for personal work such as making an assignment, watching a 

movie, or at office for office work, etc. For example, Laptops and desktop computers. 

 

2.2.6 Analogue Computer: 

It is particularly designed to process analogue data. Continuous data that changes continuously 

and cannot have discrete values is called analogue data. So, an analogue computer is used where 

we don’t need exact values or need approximate values such as speed, temperature, pressure etc. 

It can directly accept the data from the measuring device without first converting it into numbers 

Figure 2. 4 ( Workstation) 

Figure 2. 5 (Personal Computer) 
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and codes. It measures the continuous changes in physical quantity. It gives output as a reading 

on a dial or scale. For example, speedometer, mercury thermometer, etc. 

 
Figure 2. 6 (Analogue Computer) 

2.2.7 Digital Computer: 

Digital computers are designed in such a way that it can easily perform calculations and logical 

operations at high speed. It takes raw data as an input and processes it with programs stored in its 

memory to produce the final output. It only understands the binary input 0 and 1, so the raw input 

data is converted to 0 and 1 by the computer and then it is processed by the computer to produce 

the result or final output. All modern computers, like laptops, desktops including smartphones are 

digital computers. 

 
Figure 2. 7 (Digital Computer) 

2.2.8 Hybrid Computer: 
As the name suggests hybrid, which means made by combining two different things. Similarly, 

the hybrid computer is a combination of both analog and digital computers. Hybrid computers 

are fast like an analog computer and have memory, and accuracy like a digital computer. 
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So, it has the ability to process both continuous and discrete data. For working when it accepts 

analog signals as input then it converts them into digital form before processing the input data. 

So, it is widely used in specialized applications where both analog and digital data is required to 

be processed. A processor which is used in petrol pumps that converts the measurements of fuel 

flow into quantity and price is an example of a hybrid computer.  

2.3  Parts of a Computer 

The physical components required to set up a computer system to function are referred to as parts 

of the computer. These physical parts are commonly called computer hardware. 

It is categories in two types External parts and internal parts. 

2.3.1 External Parts 

 Computer Case 

 Monitor 

 Keyboard 

 Mouse 

2.3.2 Internal Parts 

 A motherboard 

 A Central Processing Unit (CPU) 

 A Graphics Processing Unit (GPU), also known as a video card 

 Random Access Memory (RAM), also known as volatile memory 

 Storage: Solid State Drive (SSD) or Hard Disk Drive (HDD) 

 

 

Figure 2. 8 (Hybrid Computer) 
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2.4  Frontside  of a Computer Case 

On a computer case, the bezel or front panel is a removable plastic panel covering the front of a 

computer and empty drive bays. The bezel helps give the computer a more appealing look and 

easy access to power on, sleep, or reset the computer. 

2.5  Backside of a Computer Case 

The back of a computer case has connection ports that are made to fit specific devices. The 

placement will vary from computer to computer, and many companies have their own special 

connectors for specific devices. Some of the ports may be color coded to help you determine 

which port is used with a particular device. 

2.6  Usage of Peripherals in Computers  

The most basic computer setup usually includes the computer case, monitor, keyboard, 

and mouse, but you can plug many different types of devices into the extra ports on your 

computer. These devices are called peripherals. Let's take a look at some of the most common 

ones. 

 Printers: A printer is used to print documents, photos, and anything else that appears on 

your screen. There are many types of printers, including inkjet, laser, and photo printers. 

There are even all-in-one printers, which can also scan and copy documents. 

 Scanners: A scanner allows you to copy a physical image or document and save it to 

your computer as a digital (computer-readable) image. Many scanners are included as 

part of an all-in-one printer, although you can also buy a separate  flatbed  or 

 handheld scanner. 

 Speakers/headphones: Speakers and headphones are output devices, which means they 

send information from the computer to the user—in this case, they allow you to hear 

sound and music. Depending on the model, they may connect to the audio port or 

the USB port. Some monitors also have built-in speakers. 

 Microphones: A microphone is a type of input device, or a device that receives 

information from a user. You can connect a microphone to record sound or talk with 

someone else over the Internet. Many laptop computers come with built-in microphones. 

 Web cameras: A web camera—or webcam—is a type of input device that can 

record videos and take pictures. It can also transmit video over the Internet in real time, 

which allows for video chat or video conferencing with someone else. Many webcams 

also include a microphone for this reason. 
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 Game controllers and joysticks: A game controller is used to control computer games. 

There are many other types of controllers you can use, including joysticks, although you 

can also use your mouse and keyboard to control most games. 

 Digital cameras: A digital camera lets you capture pictures and videos in a digital 

format. By connecting the camera to your computer's USB port, you can transfer the 

images from the camera to the computer. 

 

Mobile phones, MP3 players, tablet computers, and other devices: Whenever you buy an 

electronic device, such as a mobile phone or MP3 player, check to see if it comes with a USB 

cable. If it does, this means you can most likely connect it to your computer. 

2.7  Common Tools used in Assembly of computers 

Tools You'll Need to Build Your Own Computer 

 Screwdrivers and nut drivers. ... 

 Needle-Nosed Pliers or Forceps. ... 

 Cable Ties. ... 

 Anti-Static Kit. ... 

 Heat Sink Compound. ... 

 Canned Air or Canless Air Duster. ... 

 Pill Bottle or a Small Container. ... 

 Multi-meter. 

2.8  Installation of various parts of motherboard 

The following are the various parts of the motherboard: 

 Mouse & keyboard 

 USB 

 Parallel port 

 CPU Chip 

 RAM slots 

 Floppy controller 

 IDE controller 

 PCI slot 

 ISA slot 

 CMOS Battery 

 AGP slot 
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 CPU slot 

 Power supply plug in 

 

1.Mouse & keyboard: Keyboard Connectors are two types basically. All PCs have a Key board 

port connected directly to the motherboard. The oldest, but still quite common type, is a special 

DIN, and most PCs until recently retained this style connector. The AT-style keyboard connector 

is quickly disappearing, being replaced by the smaller mini DIN PS/2-style keyboard connector. 

You can use an AT-style keyboard with a PS/2-style socket (or the other way around) by using a 

converter. Although the AT connector is unique in PCs, the PS/2-style mini-DIN is also used in 

more modern PCs for the mouse. Fortunately, most PCs that use the mini-DIN for both the 

keyboard and mouse clearly mark each mini-DIN socket as to its correct use. Some keyboards 

have a USB connection, but these are fairly rare compared to the PS/2 connection keyboards. 

 

2.USB (Universal serial bus):  USB is the General-purpose connection for PC. You can find 

USB versions of many different devices, such as mice, keyboards, scanners, cameras, and even 

printers. a USB connector's distinctive rectangular shape makes it easily recognizable.  

 

USB has a number of features that makes it particularly popular on PCs. First, USB devices are 

hot swappable. You can insert or remove them without restarting your system. 

 

3.Parallel port: Most printers use a special connector called a parallel port. Parallel port carry 

data on more than one wire, as opposed to the serial port, which uses only one wire. Parallel ports 

use a 25-pin female DB connector. Parallel ports are directly supported by the motherboard 

through a direct connection or through a dangle. 

 

4.CPU Chip: The central processing unit, also called the microprocessor performs all the 

calculations that take place inside a pc. CPUs come in Variety of shapes and sizes. 

Modern CPUs generate a lot of heat and thus require a cooling fan or heat sink. The cooling 

device (such as a cooling fan) is removable, although some CPU manufactures sell the CPU with 

a fan permanently attached. 

 

5. RAM slots: Random-Access Memory (RAM) stores programs and data currently being used 

by the CPU. RAM is measured in units called bytes. RAM has been packaged in many different 

ways. The most current package is called a 168-pin DIMM (Dual Inline Memory module). 
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6.Floppy controller: The floppy drive connects to the computer via a 34-pin ribbon 

cable, which in turn connects to the motherboard. A floppy controller is one that is used to 

control the floppy drive. 

 

7.IDE controller: Industry standards define two common types of hard drives: EIDE and SCSI.  

Majority of the PCs use EIDE drives. SCSI drives show up in high end PCs such as network 

servers or graphical workstations. The EIDE drive connects to the hard drive via a 2-inch-wide, 

40-pin ribbon cable, which in turn connects to the motherboard. IDE controller is responsible for 

controlling the hard drive. 

 

8.PCI slot:  Intel introduced the Peripheral component interconnect bus protocol.  The PCI bus is 

used to connect I/O devices (such as NIC or RAID controllers) to the main logic of the computer. 

PCI bus has replaced the ISA bus. 

 

9.ISA slot (Industry Standard Architecture): It is the standard architecture of the Expansion 

bus. Motherboard may contain some slots to connect ISA compatible cards. 

 

10.CMOS Battery: To provide CMOS with the power when the computer is turned off all 

motherboards comes with a battery. These batteries mount on the motherboard in one of three 

ways: the obsolete external battery, the most common onboard battery, and built-in battery. 

 

11.AGP slot:  If you have a modern motherboard, you will almost certainly notice a single 

connector that looks like a PCI slot, but is slightly shorter and usually brown. You also probably 

have a video card inserted into this slot. This is an Advanced Graphics Port (AGP) slot. 

 

12.CPU slot: To install the CPU, just slide it straight down into the slot. Special notches in the 

slot make it impossible to install them incorrectly. So remember if it does not go easily, it is 

probably not correct. Be sure to plug in the CPU fan's power. 

13.Power supply plug in: The Power supply, as its name implies, provides the necessary 

electrical power to make the pc operate. the power supply takes standard 110-V AC power and 

converts into 12-Volt, 5-Volt, and 3.3-Volt DC power. 
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Figure 2. 9 (Motherboard) 

2.9  System Configuration Summary 

System configuration is a term in systems engineering that defines the computer hardware, the 

processes as well as the various devices that comprise the entire system and its boundaries. 

2.9.1 How to view system information on Windows 10 

In Windows 10 you can easily view basic system information like Windows edition, processor 

and memory configuration, computer name, domain or workgroup details, and Windows 

activation status. You can also view detailed system information like hardware and driver details 

using Windows 10 System Information app. 

 

 View basic system information 

Right click on "Start Menu" and click on "System" in pop-up menu to open "System" window. 

 

Figure 2. 10 (System Information) 
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"System" window will show basic information about your computer like Windows edition, 

Processor type and speed, installed Memory(RAM) on your computer, system type, your 

computer name, domain or workgroup name and Windows activation status. 

 

Figure 2. 11 (System Information) 

 View detailed system information 

Type "System Information" in cortana search box, and select "System Information" from cortana 

search results. 

 

Figure 2. 12 (System Information) 

This will open "System Information" app where you can view detailed system summary, 

hardware resources, hardware devices on your computer and driver details. 
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Figure 2. 13 (System Information) 

You can also open "System information" by opening Windows Run dialog ("Windows key + R" 

shortcut or Right click on Start button and select "Run" from pop-up menu), type "msinfo32" in 

Run dialog, and click on OK button. 

 

Figure 2. 14 (System Information) 

2.10 System BIOS 

A computer's BIOS (Basic Input/Output System) is its motherboard firmware, the software which 

runs at a lower level than the operating system and tells the computer what drive to boot from, 

how much RAM you have and controls other key details like CPU frequency. You can go into 

the BIOS menu to change your boot order, overclock your PC, disable onboard peripherals or 

even set a master password. 

 

The BIOS includes instructions on how to load basic computer hardware. It also includes a test 

referred to as a POST (Power-On Self-Test) that helps verify the computer meets requirements to 
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boot up properly. If the computer does not pass the POST, you hear a combination of beeps 

indicating what is malfunctioning in the computer. 

 

The four main functions of a PC BIOS: 

 POST - Test the computer hardware and make sure no errors exist before loading the 

operating system. Additional information on the POST is available on our POST and beep 

codes page. 

 Bootstrap Loader - Locate the operating system. If a capable operating system is located, 

the BIOS will pass control to it. 

 BIOS drivers - Low-level drivers that give the computer basic operational control over 

your computer's hardware. 

 BIOS setup or CMOS setup - Configuration program that allows you to configure 

hardware settings including system settings, such as date, time, and computer passwords. 

2.11 System Boot Sequence 

System Boot sequence: Step by step computer boot Process 

 You press the power button on your laptop/desktop. 

 

 The CPU starts up, but needs some instructions to work on. Since the main 

memory is empty at this stage, CPU defers to load instructions from the firmware 

chip on the motherboard and begins executing instructions. 

 

 The firmware code does a Power On Self-Test (POST), initializes the remaining 

hardware, detects the connected peripherals (mouse, keyboard, pen drive etc.) and 

checks if all connected devices are healthy. You might remember it as a 'beep' that 

desktops used to make after POST is successful. 

 

 Finally, the firmware code cycles through all storage devices and looks for a boot-

loader (usually located in first sector of a disk). If the boot-loader is found, then 

the firmware hands over control of the computer to it. 

 

 So now that the boot-loader is loaded, its job is to load the rest of the operating 

system. GRUB is one such boot-loader that is capable of loading unix-like 

operating systems and is also able to chain-load Windows OS. Boot-loader is only 

available in the first sector of a disk, which is 512 bytes. 
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 The boot-loader then loads the kernel into memory. Unix-like operating systems 

then run the init process and finally initialize the run-levels. 

 

 In Windows, wininit.exe is loaded along with some other processes like 

services.exe for service control, lsass.exe for local security and authority (similar 

to run-levels) and lsm.exe for local session management. 

 

 After all this, and after some other drivers are initialized, the Graphical User 

Interface (GUI) is loaded and you are presented with the login screen. 

 

2.12 Installation of Windows  

Before we get into the installation walkthrough, it’s worth noting that installing Windows 10 can 

be a lengthy process. Make sure you have enough time to wait it out.  

 

1.  Check your device meets the Windows 10 system requirements.  

Below you’ll find the minimum specs needed to run Windows 10, so check your device is 

capable:  

CPU: 1GHz or faster processor 

RAM: 1GB for Windows 10 32-bit or 2GB for Windows 10 64-bit 

Storage: 32GB of space or more 

GPU: DirectX 9 compatible or later with WDDM 1.0 driver 

Display: 800x600 resolution or higher 

 

2. Create USB installation media.  

Visit Microsoft's windows 10 download page (opens in new tab) and select “Download tool 

now” under the “create Windows 10 installation media” section. Transfer the downloaded 

installer tool to a USB drive. 
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Figure 2. 15 (How to download windows 10) 

 

3. Run the installer tool.  

Open the installer tool by clicking on it. Accept Microsoft’s terms, and then select “Create 

installation media for another PC” on the “What do you want to do?” page. After selecting which 

language you want Windows 10 to run in, and which edition you want as well (32-bit or 62-bit), 

you’ll be asked what type of media you want to use.  

Installing from a USB drive is definitely the preferred option but you can also install from a CD 

or ISO file. Once you choose your device, the installer tool will download the required files and 

put them onto your drive. 

 

4. Create USB installation media 

On Windows 10, you will need a USB bootable media to perform a clean installation, which you 

can easily create using Rufus tool. Rufus is a tool available for free with many options to help 

you create a bootable media of Windows 10 faster. However, it's important to remember that it's 

a third-party option, which Microsoft does not support, so use it at your own risk. 

 

To create a Windows 10 USB installer with Rufus, connect a USB flash drive of at least 

8GB of space, and then use these steps: 

 Open Rufus download page. 

 Click the Download link to save the latest release on your device. 

 Double-click the Rufus-3.15.exe file to launch the tool. 

 Under the "Device" section, select the USB flash drive. 
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 Under the "Boot selection" section, click the Select button to select the Windows 10 ISO 

file. 

 Use the "Image option" to select the Standard Windows install. 

 "Partition scheme “may be MBR/GPT for legacy or new systems. 

 "Target system “may be BIOS/UEFI for legacy or new systems. 

 Now click the Start button and close after completion. 

 
Figure 2.16 i (USB Drive) 

 

2.13 Windows 10 clean install and re-installation process 

Once you went through the preparation instructions, the clean install of Windows 10 is actually a 

straightforward process. 

 

Warning: This is another friendly reminder that this process will erase everything on the 

computer. It's always recommended to make a temporary full backup of your PC before 

proceeding. 

 



Chapter 2 

46 
   

To do a clean installation of Windows 10, use these steps: 

1. Start the device with Windows 10 USB media. 

2. On prompt, press any key to boot from the device. 

3. On the "Windows Setup," click the Next button. 

 

Figure 2.16 ii (Windows setup) 

Click the Install now button. 

 

Figure 2.16 iii (Installing Windows) 
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 If you're doing a reinstallation, click the I don't have a product key option to continue. 

Otherwise, in the case that this is your first time installing Windows 10, enter the product 

key and click Next. 

 

Figure 2.16 iv (Activating Windows) 

 Select the edition of Windows 10 that the product key activates and click Next to accept 

the license terms option to continue. 

 

Figure 2.16 v (Selecting edition of windows) 
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 Click the Custom: Install Windows only (Advanced) option to continue with a clean 

installation. 

 

Figure 2.16 vi (Type of Installation of Windows) 

 Select the partition with the current installation (usually "Drive 0"), and click the Delete 

button. 

 

Figure 2.16 vii (Partition of Drive) 

 

 Select the empty drive (Drive 0 Unallocated Space). 
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Figure 2.16 viii1 (Install Windows) 

 

2.14 Windows 10 out-of-box experience 

After the setup, you have to continue with the out-of-box experience to configure your 

preferences and create a new account. 

To complete the OOBE on Windows 10, use these steps: 

Select your Region option and click the Yes button. 

 

Figure 2.16 ix (Region option) 

Select your keyboard layout option. 
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Figure 2.16 x (Keyboard Layout) 

 

 

Figure 2.16 2 (Setup for usage) 

 Confirm your Microsoft account information to create an account. 
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Figure 2.16 xii (Account Login) 
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2.15    Exercise Problems and MCQs 

1. What are Common tools used in Assembly of computer. 

2. What are Peripherals one can use in various port 

3. Give difference between assembler, compiler and interpreter. 

4. What is assembly language? What kinds of statements are present in an assembly? 

5. What is an operating system? List the typical functions of operating systems. 

6. What are interrupts? How are they handled by the operating system? 

7. Differentiates serial and parallel port? 

 

MCQs Exercise 
1. The Central Processing Unit 

a. is operated from the control panel. 

b. is controlled by the input data entering the system 

c. controls the auxiliary storage unit 

d. controls all input, output and processing 

 

2. Computer follows a simple principle called GIGO which means______ 

a. garbage input good output 

b. garbage in garbage out 

c. great instructions great output 

d. good input good output 

 

3. The term ‘baud’ is a measure of the: 

a. speed at which data travels over the communication line 

b. memory capacity 

c. instruction execution time 

d. all of the above 

 

4. A bootstrap is: 

a. a memory device 

b. a device to support the computer 

c. a small initialisation program to start up a computer 

d. an error correction technique 
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5. Which of the following is not hardware? 

a. Magnetic tape 

b. Printer 

c. VDU terminal 

d. Assembler 
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CHAPTER 3 

Introduction to Operating System 

3.1 Operating System 

An operating system (OS) is the program that, after being initially loaded into the computer by a 

boot program, manages all of the other application programs in a computer. The application 

programs make use of the operating system by making requests for services through a defined 

application program interface (API). 

 An operating system is a program that controls the execution of application programs and 

acts as an interface between the user of a computer and the computer hardware. 

 A more common definition is that the operating system is the one program running at all 

times on the computer (usually called the kernel), with all else being application 

programs. 

 An operating system is concerned with the allocation of resources and services, such as 

memory, processors, devices, and information. The operating system correspondingly 

includes programs to manage these resources, such as a traffic controller, a scheduler, a 

memory management module, I/O programs, and a file system. 

3.2  Basics of Operating System 

Operating system is software that controls system’s hardware and interacts with user and 

application software. In short, an operating system is computer’s chief control program. 

3.2.1 Need for an Operating System:  

The primary need for the OS arises from the fact that user needs to be provided with services and 

OS ought to facilitate the provisioning of these services. The central part of a computer system is 

a processing engine called CPU. A system should make it possible for a user’s application to use 

the processing unit. A user application would need to store information. The OS makes memory 

available to an application when required. Similarly, user applications need use of input facility 

to communicate with the application. This is often in the form of a key board, or a mouse or even 

a joy stick (if the application is a game for instance). 
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Figure 3. 1 (Needs for an OS) 

 
Figure 3. 2 (Needs for on OS) 

The output usually provided by a video monitor or a printer as some times the user may wish to 

generate an output in the form of a printed document. Output may be available in some other 

forms. For example, it may be a video or an audio file. Let us consider few applications.  

 Document Design  

 Accounting  

 E-mail  

 Image processing 

 Games   

We notice that each of the above application requires resources for  

 Processing information  

 Storage of Information  

 Mechanism to inputting information 

 Provision for outputting information  

These service facilities are provided by an operating system regardless of the nature of 

application. The OS offers generic services to support all the above operations. These operations 

in turn facilitate the applications mentioned earlier. To that extent an OS operation is application 

neutral and service specific. 
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3.2.2 Functions of Operating system 

The operating system performs four functions:  

i. Convenience: An OS makes a computer more convenient to use. 

ii. Efficiency: An OS allows the computer system resources to be used efficiently. 

iii. Ability to Evolve: An OS should be constructed in such a way as to permit the effective 

development, testing, and introduction of new system functions at the same time without 

interfering with service. 

iv. Throughput: An OS should be constructed so that It can give maximum throughput 

(Number of tasks per unit time). 

3.3  Booting Process 

Booting is the process of starting a computer. It can be initiated by hardware such as a button 

press or by a software command. After it is switched on, a CPU has no software in its main 

memory, so some processes must load software into memory before execution. This may be done 

by hardware or firmware in the CPU or by a separate processor in the computer system. 

Restarting a computer also is called rebooting, which can be "hard", e.g., after electrical power to 

the CPU is switched from off to on, or "soft", where the power is not cut. On some systems, a 

soft boot may optionally clear RAM to zero. Hard and soft booting can be initiated by hardware 

such as a button press or a software command. Booting is complete when the operative runtime 

system, typically the operating system and some applications, is attained. 

The process of returning a computer from a state of sleep does not involve booting; however, 

restoring it from a state of hibernation does. Minimally, some embedded systems do not require a 

noticeable boot sequence to begin functioning and, when turned on, may run operational 

programs that are stored in ROM. All computer systems are state machines and a reboot may be 

the only method to return to a designated zero-state from an unintended, locked state. 

In addition to loading an operating system or stand-alone utility, the boot process can also load a 

storage dump program for diagnosing problems in an operating system. 

3.4  Sequence of Booting 

Booting is a start-up sequence that starts the operating system of a computer when it is turned on. 

A boot sequence is the initial set of operations that the computer performs when it is switched on. 

Every computer has a boot sequence. 
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Figure 3. 3 (Booting Sequence) 

Boot Loader: Computers powered by the central processing unit can only execute code found in 

the system's memory. Modern operating systems and application program code and data are 

stored on nonvolatile memories. When a computer is first powered on, it must initially rely only 

on the code and data stored in nonvolatile portions of the system's memory. The operating system 

is not really loaded at boot time, and the computer's hardware cannot perform many complex 

systems actions. The program that starts the chain reaction that ends with the entire operating 

system being loaded is the boot loader or bootstrap loader. The boot loader's only job is to load 

other software for the operating system to start. 

1. Boot Devices: The boot device is the device from which the operating system is loaded. A 

modern PC BIOS (Basic Input/output System) supports booting from various devices. These 

include the local hard disk drive, optical drive, floppy drive, a network interface card, and a 

USB device. The BIOS will allow the user to configure a boot order. If the boot order is set 

to: 

 CD Drive 

 Hard Disk Drive 

 Network 

 The BIOS will try to boot from the CD drive first, and if that fails, then it will try to boot 

from the hard disk drive, and if that fails, then it will try to boot from the network, and if 

that fails, then it won't boot at all. 

2. Boot Sequence: There is a standard boot sequence that all personal computers use. First, the 

CPU runs an instruction in memory for the BIOS. That instruction contains a jump 

instruction that transfers to the BIOS start-up program. This program runs a power-on self-

test (POST) to check that devices the computer will rely on are functioning properly. Then, 

the BIOS goes through the configured boot sequence until it finds a bootable device. Once 

BIOS has found a bootable device, BIOS loads the bootsector and transfers execution to the 

boot sector. If the boot device is a hard drive, it will be a master boot record (MBR). 
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The MBR code checks the partition table for an active partition. If one is found, the MBR code 

loads that partition's boot sector and executes it. The boot sector is often operating system 

specific, and however, in most operating systems, its main function is to load and execute the 

operating system kernel, which continues start-up. Suppose there is no active partition, or the 

active partition's boot sector is invalid. In that case, the MBR may load a secondary boot loader 

which will select a partition and load its boot sector, which usually loads the corresponding 

operating system kernel. 

3.4.1 Types of Booting 

There are two types of booting in an operating system. 

 

Figure 3. 4 (types of Booting) 

1.Cold Booting: When the computer starts for the first time or is in a shut-down state and switch 

on the power button to start the system, this type of process to start the computer is called cold 

booting. During cold booting, the system will read all the instructions from the ROM (BIOS) and 

the Operating System will be automatically get loaded into the system. This booting takes more 

time than Hot or Warm Booting. 

2.Warm Booting: Warm or Hot Booting process is when computer systems come to no response 

or hang state, and then the system is allowed to restart during on condition. It is also referred to 

as rebooting. There are many reasons for this state, and the only solution is to reboot the 

computer. Rebooting may be required when we install new software or hardware. The system 

requires a reboot to set software or hardware configuration changes, or sometimes systems may 

behave abnormally or may not respond properly. In such a case, the system has to be a force 

restart. Most commonly Ctrl+Alt+Del button is used to reboot the system. Else, in some systems, 

the external reset button may be available to reboot the system. 
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3.5  Booting Process in an Operating System 
When our computer is switched on, it can be started by hardware such as a button press, or by 

software command, a computer's central processing unit (CPU) has no software in its main 

memory, there is some process which must load software into main memory before it can be 

executed. Below are the six steps to describe the boot process in the operating system, such as: 

 

Figure 3. 5 (Booting Process) 

Step 1: Once the computer system is turned on, BIOS (Basic Input /Output System) performs a 

series of activities or functionality tests on programs stored in ROM, called on POST (Power-on 

Self-Test) that checks to see whether peripherals in the system are in perfect order or not. 

Step 2: After the BIOS is done with pre-boot activities or functionality test, it read bootable 

sequence from CMOS (Common Metal Oxide Semiconductor) and looks for master boot record 

in the first physical sector of the bootable disk as per boot device sequence specified in CMOS. 

For example, if the boot device sequence is: 

 Floppy Disk 

 Hard Disk 

 CDROM 

Step 3: After this, the master boot record will search first in a floppy disk drive. If not found, 

then the hard disk drive will search for the master boot record. But if the master boot record is 

not even present on the hard disk, then the CDROM drive will search. If the system cannot read 

the master boot record from any of these sources, ROM displays "No Boot device found" and 

halted the system. On finding the master boot record from a particular bootable disk drive, the 

operating system loader, also called Bootstrap loader, is loaded from the boot sector of that 

bootable drive· into memory. A bootstrap loader is a special program that is present in the boot 

sector of a bootable drive. 

Step 4: The bootstrap loader first loads the IO.SYS file. After this, MSDOS.SYS file is loaded, 

which is the core file of the DOS operating system. 

Step 5: After this, MSDOS.SYS file searches to find Command Interpreter in CONFIG.SYS file, 

and when it finds, it loads into memory. If no Command Interpreter is specified in 

the CONFIG.SYS file, the COMMAND.COM file is loaded as the default Command Interpreter 

of the DOS operating system. 

Step 6: The last file is to be loaded and executed is the AUTOEXEC.BAT file that contains a 

sequence of DOS commands. After this, the prompt is displayed. We can see the drive letter of 
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bootable drive displayed on the computer system, which indicates that the operating system has 

been successfully on the system from that drive. 

 

3.5.1 What is Dual Booting 
When two operating systems are installed on the computer system, then it is called dual booting. 

Multiple operating systems can be installed on such a system. But to know which operating 

system is to boot, a boot loader that understands multiple file systems and multiple operating 

systems can occupy the boot space. 

 

Figure 3. 6 (Dual Booting) 

Once loaded, it can boot one of the operating systems available on the disk. The disk can have 

multiple partitions, each containing a different type of operating system. When a computer 

system turns on, a boot manager program displays a menu, allowing the user to choose the 

operating system to use. 

3.6  Relation between System software and Application software 
System Software is the type of software that is the interface between application software and 

system. Low-level languages are used to write the system software. System Software maintains 

the system resources and gives the path for application software to run. An important thing is that 

without system software, the system cannot run. It is a general-purpose software.  

Application Software is the type of software that runs as per user request. It runs on the platform 

which is provided by system software. High-level languages are used to write the application 

software. It’s a specific purpose software. The main difference between System Software and 
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Application Software is that without system software, the system cannot run on the other hand 

without application software, the Low-level maintain system always runs. 

 

Difference Between System Software and Application Software 

System Software 
Application Software 

This acts as an interface between the system 

and the applications 

This is designed directly from the user 

perspective 

It is the platform that allows the various 

application software to run on the system 

These are independent applications which can 

be download and installed in the system 

System Software is generally developed in 

low-level languages. This is so that the 

interaction between the software and hardware 

can be simplified and made more compatible 

Each application has a specific purpose and 

thus is developed with high-level languages 

so that the purpose can be fulfilled 

Is working is more automated. Once a system 

is turned on, the system software starts 

working 

User action is required to start application 

software. These applications can only be work 

when the user commands the system to do so 

These are responsible for the working of the 

system 

They have minimum involvement in the 

processing and functioning of the computer 

device 

The system software is installed at the time of 

installing the operating system. A computer 

device cannot work without its presence 

The application software can be installed as 

and when the user requires them 

It is an independent software. Once this is 
This is a dependent software. Applications 

can only be downloaded when the operating 
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installed the computer will work system is installed 

Since a device cannot work without a system 

software, the user has to have it installed in 

their devices 

These are designed to be user interactive, thus 

the application software can be removed as 

and when required by the user 

Example for System Software includes 

Android, Mac Operating system, MS 

Windows, etc. 

Examples of Application Software includes 

Word Processor, games, media player, etc. 

Table 3. 1 (Difference between system and Application software) 

 
3.7  Installation of Windows operating System 
Each version of Microsoft Windows is installed on a computer using similar steps. While there 

are steps in the installation process that differ between versions of Windows, the following 

general steps and guidelines help you install Windows on your computer. 

Before we get into the installation walkthrough, it’s worth noting that installing Windows 10 can 

be a lengthy process. Make sure you have enough time to wait it out.  

1. Check your device 

Whether it meets the Windows 10 system requirements. Below you’ll find the minimum 

specs needed to run Windows 10, so check your device is capable:  

CPU: 1GHz or faster processor 

RAM: 1GB for Windows 10 32-bit or 2GB for Windows 10 64-bit 

Storage: 32GB of space or more 

GPU: DirectX 9 compatible or later with WDDM 1.0 driver 

2. Create USB installation media.  

Visit Microsoft's Windows 10 download page (opens in new tab) and select “Download tool 

now” under the “create Windows 10 installation media” section. Transfer the downloaded 

installer tool to a USB drive. 
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Figure 3. 7 (Downloading windows 10) 

3. Run the installer tool.  

Open the installer tool by clicking on it. Accept Microsoft’s terms, and then select “Create 

installation media for another PC” on the “What do you want to do?” page. After selecting which 

language you want Windows 10 to run in, and which edition you want as well (32-bit or 62-bit), 

you’ll be asked what type of media you want to use.  

Installing from a USB drive is definitely the preferred option but you can also install from a CD 

or ISO file. Once you choose your device, the installer tool will download the required files and 

put them onto your drive.  

 

4. Use your installation media.  

Insert your installation media into your device and then access the computer’s BIOS or UEFI. 

These are the systems that allow you to control your computer’s core hardware.  

The process of accessing these systems is unique to each device, but the manufacturer’s website 

should be able to give you a helping hand here. Generally, you'll need to press the F2, F12 or 

Delete keys as your computer boots up. 

 

Figure 3. 8 (Installation Media) 

 



Chapter 3 
 

64 
 

5. Change your computer's boot order.  

Once you have access to your computer’s BIOS/UEFI you’ll need to locate the settings for 

boot order. You need the Windows 10 installation tool to be higher up on the list than the 

device’s current current boot drive: this is the SSD or HDD that your existing OS is stored 

on. You should move the drive with the installer files to the very top of the boot order 

menu. Now, when you restart your device the Windows 10 installer should load up first.  

6. Restart your device.  

Save your settings in the BIOS/UEFI and reboot your device. 

7. Complete the installation.  

Your device should now load up the Windows 10 installation tool on restart. This will guide 

you through the rest of the installation process.  

 

3.8  Installation of MS Office 
1. Depending on your browser, select Run (in Microsoft Edge or Internet 

Explorer), Setup (in Chrome), or Save File (in Firefox). 

If you see the User Account Control prompt that says, do you want to allow this app to 

make changes to your device? select Yes. 

The install begins. 

 

Figure 3. 9 (Installing MS office) 

2. Your install is finished when you see the phrase, "You're all set! Office is installed 

now" and an animation plays to show you where to find Office applications on your 

computer. Select Close. 



Chapter 3 
 

65 
 

 
Figure 3. 10 (Installed MS Office) 

3. Activate Office 

i. To open an Office app, select the Start button (lower-left corner of your screen) and type 

the name of an Office app, like Word. 

ii. If you have Windows 8.1 or 8.0, type the name of an Office app on 

the Start screen. Cannot find your office apps?  

iii. To open the Office app, select its icon in the search results. 

iv. When the Office app opens, accept the license agreement. Office is activated and ready to 

use. 

3.9  Task Bar 
The taskbar is an element of an operating system located at the bottom of the screen. It lets you 

locate and launch programs throughStart and the Start menu or view any currently open program. 

On the right side of the taskbar is the notification area that lets you check the date and time, items 

running in the background. The taskbar was first introduced with Microsoft Windows 95 and is 

found in all subsequent versions of Windows. 
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Figure 3. 11 (Taskbar of windows OS) 

  

3.10 Icons 
Icon is a small graphical representation of a program or file. When we double-click an icon, the 

associated file or program will be opened. For example, if we were to double-click on the My 

Computer icon, it would open Windows Explorer. Icons are a component of GUI operating 

systems, including Apple macOS X and Microsoft Windows. Icons help users quickly identify 

the type of file represented by the icon. 

 

3.10.1 Types of Icons   

 System Icons:  

 System Icons are displayed along left edge of screen. These icons are created automatically by 

windows during its installation. Example of some system icons are My Computer, Recycle Bin, 

My Documents, Internet Explorer etc. 

 

 Shortcut Icons:  

These are the icons with small arrows in the lower left corner. A shortcut icon provides easy 

access to some objects on our systems, such as a program, a document or a printer. The shortcut 

icons only contain information about the location of the object but not the object itself.  

 

 Program folder and Document Icons:  

These are non-system icons without arrows and they represent the actual objects they describe. 

So if we delete such an icon we are deleting the object itself, from the hard disk.  
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 My Computer icon:  

My Computer is a Microsoft Windows feature first found in Windows 95 and included with all 

later versions that allows we to explore and manage the contents of our computer drives. The 

name My Computer icon in  

Microsoft Windows XP, Vista and Windows 7, as well as the "This PC" icon in Windows 8 and 

in Windows 10. Although the name has changed, "This PC" still has the same functionality as 

"My Computer." This icon lets we browse through all the resources attached to our PC.  

 

Figure 3. 12 (My Computer icon) 

 Recycle Bin  

Windows Recycle Bin is a special folder that stores deleted files from our computer or device, 

they are not permanently removed; they are first moved to this folder. The Recycle Bin Icon 

appears on the Desktop and looks like a waste paper basket. Windows does this as a precaution in 

case we deleted something by mistake.  

 

Figure 3. 13 (Recycle Bin) 

3.11 RUNNING AN APPLICATION 
After a computer program or game is installed on a computer, it can be opened at any time. 

Below are the steps on how you can run a computer program or game on your computer in all 

operating systems. 

   In Windows, to run a program, double click the executable file or double-click the shortcut icon 

pointing to the executable file. If you have a hard time double-clicking an icon, you can click the 

icon once to highlight it and then press the Enter key on the keyboard. 
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3.12 OPERATING SYSTEM SETTINGS 
Computers usually work as you expect them to, but when you use a public computer, for 

example, you often find that the previous user has left the computer’s settings out of order. You 

should also know how to adjust the settings on a newly installed operating system to suit your 

preferences. This is why it is important to have the skills necessary to change the basic settings. 

The topics covered in this section include the following: 

 Date and time settings 

 Region and language settings 

 Display settings 

 Volume control 

 
3.12.1  MANAGING THE OPERATING SYSTEM’S SETTINGS 
Most of the settings on a computer are managed via the operating system’s control panel. The 

following examples are from the settings of the Windows 10 operating system, which can be 

accessed by clicking Start followed by Settings. This will display a window that allows you to 

change the necessary settings. 

In the operating system control panel shown below, the functions are listed by topic, and the most 

commonly used function for each area are shown under the headings. Click the heading row to 

display more functions and settings related to the topic. The settings you can access include the 

following: 

 

 Network settings (Network & Internet, including wireless and wired local networks) 

 Display settings (under Personalization) 

 Time & language settings 

 Applications (Apps, allows you to add and remove applications) 

 Software updates and information security (Update & security) 
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Figure 3. 14 (Operating system settings) 

 

3.13 TIME AND LANGUAGE SETTINGS 
Maintaining the correct date and time settings is important for the computer to work properly. If 

these settings are wrong, you may experience problems such as accidentally replacing a newer 

file with an older version. You can also change the regional settings of the operating system and 

applications, such as the units of measurement and currencies, as well as the date and time 

format. You can also change the operating system language, for example from Finnish to 

English. 

 

3.14 DISPLAY SETTINGS 
The computer’s display settings determine how the picture is displayed. Depending on the 

settings, the quality can range from excellent to very poor. As a previous user may have left 

incorrect display settings on a computer (for example, the wrong resolution can result in the 

display not looking as sharp as it should), it is important for you to know how to change the 

display settings to suit your needs. 

 

You can access the display settings on Windows by clicking Settings and 

then Personalization. This launches a window that allows you to change background colours and 

the wallpaper, as well as the display resolution and text size (this is particularly useful is the 

menu and toolbar texts in the operating system and applications are too small for you). 

All displays have a native resolution at which they look best. The typical resolution for today’s 

desktop monitors and laptop computers is FullHD, or 1920×1080. To find out the native 

resolution of your display, please refer to its operating manual. 
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You can change the display resolution by moving the Resolution slider to your desired setting. 

The larger the number, the higher the resolution, which also makes elements appear smaller on 

the display (also note that various applications have independent zoom functions that are separate 

from your display resolution setting). 

 
3.14.1 VOLUME CONTROL 
The easiest way to change the volume settings of your computer is to click the speaker icon on 

the right of the task bar with your primary mouse button and then select Mixer. Your computer’s 

keyboard will often also include shortcut keys for controlling the volume and muting the sound. 

In most cases, it is recommended that you set the volume near the middle of the range. When 

using headphones, for example, this allows you to hear the sounds without compromising sound 

quality. Also note the Mute checkboxes below the volume sliders. If you tick one of these boxes, 

the computer will completely mute the audio source in question. 

3.14.2  HOW TO ACCESS MOUSE IN WINDOWS OPERATION SYSTEM? 
To change your mouse settings in Windows 10: 

 Launch the Settings app (Win+I keyboard shortcut). 

 Click the "Devices" category. 

 Click the "Mouse" page in the left menu of the Settings category. 

 You can customise common mouse functions here, or press the "Additional mouse 

options" link for more advanced settings. 

 

Windows 10 gives you a range of customisation options for your mouse, so you have flexibility 

in how your cursor behaves. In this guide, we'll walk you through the available settings and the 

impact they have on your pointer. 

 

Before we get going, it's worth mentioning that Windows 10's mouse settings are still split across 

Control Panel and the Settings app. The Settings app's Mouse page is currently extremely basic 

and contains only one option you won't find in the Control Panel. 

 Primary mouse button and scroll wheel 

We will head to Settings first, so open the app (Win+I keyboard shortcut), click the "Devices" 

category and then navigate to the "Mouse" page from the menu. 
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Figure 3. 15 (Mouse Settings) 

The page lets you customise the scroll wheel's operation and change which mouse button acts as 

the primary one. The mouse wheel can be made to scroll through lines or entire screens (as if you 

pressed the Page Up/Page Down buttons), and you can customise how many lines or screens 

should be scrolled at once. 

The last toggle button on the page, "Scroll inactive windows when I hover over them," is the only 

mouse setting not available in the Control Panel. This feature was new for Windows 10. Per the 

description, it lets you scroll the contents of any window on your desktop by hovering over it and 

using the mouse wheel. You don't need to switch focus to the window first, addressing a long-

standing complaint with previous versions of Windows. You'll probably want to keep it enabled 

most of the time. 

The rest of Windows' mouse settings are tucked away in the Control Panel. You can access them 

with the "Additional mouse options" link to the right of the Mouse settings page. This will bring 

up the "Mouse Properties" popup which hasn't changed much through generations of the 

Windows operating system. 
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Figure 3. 16 (Mouse Properties) 

The first tab of this screen provides three options. The first is duplicated from the Settings app 

and lets you customise your primary mouse button. The second lets you change when double-

clicks are registered – if you find Windows isn't detecting when you double-click, or is making 

false positive matches, you can use the slider and test area to finetune how long a double-click 

has to last. 

3.14.3  Clicklock 
The final option on the page controls a little-used accessibility feature called ClickLock. When 

it's enabled, you don't need to hold down your mouse button when clicking and dragging. 

Instead, you hold the button briefly, which starts the selection. You can then release the button, 

move the mouse to complete your selection and press the button again to confirm the operation. 

It's intended primarily for people who may find it hard to depress the mouse button for an 

extended period of time. 

 

The second tab of the Mouse Properties dialog enables you to change the presentation of your 

cursor. You can pick and choose from the themes installed on your device, or specify your own 

images to use for different cursor states. 

3.14.4  Pointer speed and sensitivity 
The Pointer Options tab is more directly applicable to your mouse's operation. The first set of 

options are related to the movement of your cursor. You can control how fast the cursor moves, 

enabling you to reduce or increase the effective sensitivity of your mouse. 
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There's also an "Enhance pointer precision" checkbox, which dynamically adjusts the effective 

sensitivity relative to how fast you move the mouse. When you're moving slowly to select a small 

button, Windows will adjust the sensitivity on-the-fly to keep the cursor motion precise. If you 

have a gaming or professional mouse, you should note that both the pointer speed and precision 

options may conflict with the DPI and sensitivity settings offered by your mouse. 

 

 

Figure 3. 17 (Mouse Pointer speed and sensitivity) 

 

The second section of the Pointer Options tab controls "Snap To," an accessibility feature which 

automatically moves your cursor as new popups open on your screen. Your cursor will 

automatically "snap to" the default button in each popup, so you don't need to move your mouse 

to press "OK." 

 

3.14.5  Finding the cursor 
Finally, the "Visibility" section lets you control when the cursor should be hidden. You can 

disable automatic cursor hiding while typing with the "Hide pointer while typing" 

checkbox.Using the "Display pointer trails" option, it's possible to display pointer trails that track 

your mouse across the screen if you have difficulty following your cursor. A final usability tweak 
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is "Show location of pointer when I press the CTRL key" – a self-explanatory checkbox which 

can come in handy for those "lost my mouse" situations. 

 

That's it for Windows' mouse settings. We're not covering the other Mouse Properties tabs; 

Wheel is duplicated in the Settings page we described while Hardware lists technical information 

about your mouse. It's possible you'll see more tabs in Mouse Properties depending on your 

specific device – for example, many laptop touchpad drivers add additional pages here which let 

you customise their operation. 

 

3.15 Changing the System Date and Time 
Computers connected to the internet should automatically adjust for daylight savings time. 

1. Right-click on the time in the bottom-right of the screen and select Adjust Date/Time. 

 

Figure 3. 18 (Changing system Date and Time) 

 

2. A window will open. On the left side of the window select the Date & time tab. Then, 

under "Change date and time" click Change. 
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Figure 3. 19 (Change Date and Time) 

Note: Both Set time automatically and Set time zone automatically must be Off to make this 

change. 

3. Enter the time and press Change. 

 

Figure 3. 20 (Change Date and Time) 

 

4. The system time has been updated. 

Note: You will need administrative rights on your computer to be able to change the date 

and time. 

3.16 Changing display properties 
Most of the advanced display settings from previous versions of Windows are now available on 

the Display settings page. 

 Select Start > Settings > System > Display. 
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 If you want to change the size of your text and apps, choose an option from the drop-

down menu under Scale and layout. Learn how to change just your text size in make

windows easier to see.

 To change your screen resolution, use the drop-down menu under Display

resolution. Note: You should use the Recommended resolution. If you change the

resolution, content might appear blurry or pixelated.

 To adjust your color calibration, search "calibrate display color" in the Settings search

box and follow the directions.

 If you don't see a setting you're looking for, try searching for it in the search box on the

taskbar.

3.17 To add or remove Program and its features 
1. Click Start, click Run, type regedit in the Open box, and then press ENTER.

2. Locate and click the following registry key:

3. HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Uninstall

4. After you click the Uninstall registry key, click Export Registry File on the Registry

menu.

5. In the Export Registry File dialog box, click Desktop in the Save in box, type uninstall in

the File name box, and then click Save.

6. Each key under Uninstall represents a program that appears in Add/Remove Programs.

To determine which program that each key represents, click the key, and then view the

following values:

7. DisplayName - the value data for the DisplayName key is the name that is listed in

Add/Remove Programs-and-UninstallString - the value data for the UninstallString key is

the program that is used to uninstall the program

8. After you identify the registry key that represents the program that is still in Add/Remove

Programs, right-click the key, and then click Delete.

9. After you delete the key, click Start, point to Settings, and then click Control Panel.

10. In Control Panel, double-click Add/Remove Programs.

11. In Add/Remove Programs, verify that the program for which you deleted the registry key

is not listed.

12. If the program list is not correct in Add/Remove Programs, you can double-click the

Uninstall.reg file on your desktop to restore the original list of programs in the registry.

13. If the program list is correct in Add/Remove Programs, you can right-click the

Uninstall.reg file on your desktop, and then click Delete.
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3.18 Adding, Removing and Sharing Printers 
If your printer connects by a wire, plug it into your device. It'll connect automatically, your PC 

will download the right drivers, and you can use it right away. To connect a wireless printer, 

follow these steps: 

1. Select the Start button, then select Settings > Devices > Printers & scanners > Add a

printer or scanner.

Figure 3. 21 (Add a Printer or scanner) 

2. Wait for it to find nearby printers, then choose the one you want to use, and select Add

device. If you want to remove the printer later, just highlight it and select Remove.

3. If you don't see your printer, try to fix the problem by using the steps in fix printer

connection and printing problems in windows.

3.19 File and Folder management 
Understanding how to work with files and folders is an important part of using your computer. 

Once you understand how files and folder work, you'll use them all the time. In this lesson, we'll 

show you the absolute basics of working with files, including how to open files, move your 

files into folders, and delete files. 

3.19.1 What is a file? 
There are many different types of files you can use. For example, Microsoft Word documents, 

digital photos, digital music, and digital videos are all types of files. You might even think of a 
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file as a digital version of a real-world thing you can interact with on your computer. When you 

use different applications, you'll often be viewing, creating, or editing files. 

Files are usually represented by an icon. In the Fig. 3.21, you can see a few different types of 

files below the Recycle Bin on the desktop. 

Figure 3. 22 (File) 

3.19.2 What is a folder? 
Windows uses folders to help you organize files. You can put files inside a folder, just like you 

would put documents inside a real folder. In the image below, you can see some folders on the 

desktop. 

Figure 3. 23 (File) 

3.20 File Explorer 
You can view and organize files and folders using a built-in application known as File 

Explorer (called Windows Explorer in Windows 7 and earlier versions). 

To open File Explorer, click the File Explorer icon on the taskbar, or double-click any folder on 

your desktop. A new File Explorer window will appear. Now you're ready to start working with 

your files and folders. 
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Figure 3. 24 ( File Explorer) 

From File Explorer, double-click a folder to open it. You can then see all of the files stored in 

that folder. 

Figure 3. 25 (Double click a folder to open it) 
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Notice that you can also see the location of a folder in the address bar near the top of the 

window. 

Figure 3. 26 (Location of a Folder) 

3.20.1 To open a file: 
There are two main ways to open a file: 

 Find the file on your computer and double-click it. This will open the file in its default

application. In our example, we'll open a Microsoft Word document (Cover

Letter.docx), which will open in Microsoft Word.

 

Figure 3. 27 (Open a File) 
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 Open the application, then use the application to open the file. Once the application is

open, you can go to the File menu at the top of the window and select Open.

Figure 3. 28 (More ways to Open a File) 

3.21 Moving and deleting files 
As you begin using your computer, you will start to collect more and more files, which can make 

it more difficult to find the files you need. Fortunately, Windows allows you to move files to 

different folders and delete files you no longer use. 

3.21.1 To move a file: 
It is easy to move a file from one location to another. For example, you might have a file on 

the desktop that you want to move to your Documents folder. 

1. Click and drag the file to the desired location.
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Figure 3. 29 (Move a File) 

2. Release the mouse. The file will appear in the new location. In this example, we have

opened the folder to see the file in its new location.

Figure 3. 30 (Moved file in a new location) 

You can use this same technique to move an entire folder. Note that moving a folder will also 

move all of the files within that folder. 

3.21.2  To create a new folder: 
1. Within File Explorer, locate and select the New folder button. You can also right-

click where you want the folder to appear, then select New > Folder.
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Figure 3. 31 (Create a new Folder) 

2. The new folder will appear. Type the desired name for the folder and press Enter.I our

example, we'll call it School Documents.

Figure 3. 32 (Created a New Folder) 

3.21.3  To rename a file or folder: 
You can change the name of any file or folder. A unique name will make it easier to remember 

what type of information is saved in the file or folder. 

1. Click the file or folder, wait about one second, and click again. An editable text field

will appear.
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Extension Format 

aac, adt, adts 
Windows audio file 

accdb 
Microsoft Access database file 

accde 
Microsoft Access execute-only file 

accdr 
Microsoft Access runtime database 

accdt 
Microsoft Access database template 

aif, aifc, aiff 
Audio Interchange File format file 

aspx 
ASP.NET Active Server page 

avi 
Audio Video Interleave movie or sound file 

bat 
PC batch file 

bin 
Binary compressed file 

bmp 
Bitmap file 

cab 
Windows Cabinet file 

cda 
CD Audio Track 

csv 
Comma-separated values file 

dif 
Spreadsheet data interchange format file 

dll 
Dynamic Link Library file 

doc 
Microsoft Word document before Word 2007 
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docm 
Microsoft Word macro-enabled document 

docx 
Microsoft Word document 

dot 
Microsoft Word template before Word 2007 

dotx 
Microsoft Word template 

eml 
Email file created by Outlook Express, Windows Live Mail, 

and other programs 

eps 
Encapsulated Postscript file 

exe 
Executable program file 

flv 
Flash-compatible video file 

gif 
Graphical Interchange Format file 

htm, html 
Hypertext markup language page 

ini 
Windows initialization configuration file 

iso 
ISO-9660 disc image 

jar 
Java architecture file 

jpg, jpeg 
Joint Photographic Experts Group photo file 

m4a 
MPEG-4 audio file 

mdb 
Microsoft Access database before Access 2007 

mid, midi 
Musical Instrument Digital Interface file 

mov 
Apple QuickTime movie file 
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mp3 
MPEG layer 3 audio file 

mp4 
MPEG 4 video 

mp4 
MPEG 4 video 

mpeg 
Moving Picture Experts Group movie file 

mpg 
MPEG 1 system stream 

msi 
Microsoft installer file 

mui 
Multilingual User Interface file 

pdf 
Portable Document Format file 

png 
Portable Network Graphics file 

pot 
Microsoft PowerPoint template before PowerPoint 2007 

potm 
Microsoft PowerPoint macro-enabled template 

potx 
Microsoft PowerPoint template 

ppam 
Microsoft PowerPoint add-in 

pps 
Microsoft PowerPoint slideshow before PowerPoint 2007 

ppsm 
Microsoft PowerPoint macro-enabled slideshow 

ppsx 
Microsoft PowerPoint slideshow 

ppt 
Microsoft PowerPoint format before PowerPoint 2007 

pptm 
Microsoft PowerPoint macro-enabled presentation 

pptx 
Microsoft PowerPoint presentation 
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psd 
Adobe Photoshop file 

pst 
Outlook data store 

pub 
Microsoft Publisher file 

rar 
Roshal Archive compressed file 

rtf 
Rich Text Format file 

sldm 
Microsoft PowerPoint macro-enabled slide 

sldx 
Microsoft PowerPoint slide 

swf 
Shockwave Flash file 

sys 
Microsoft DOS and Windows system settings and variables 

file 

tif, tiff 
Tagged Image Format file 

tmp 
Temporary data file 

txt 
Unformatted text file 

vob 
Video object file 

vsd 
Microsoft Visio drawing before Visio 2013 

vsdm 
Microsoft Visio macro-enabled drawing 

vsdx 
Microsoft Visio drawing file 

vss 
Microsoft Visio stencil before Visio 2013 

vssm 
Microsoft Visio macro-enabled stencil 
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vst 
Microsoft Visio template before Visio 2013 

vstm 
Microsoft Visio macro-enabled template 

vstx 
Microsoft Visio template 

wav 
Wave audio file 

wbk 
Microsoft Word backup document 

wks 
Microsoft Works file 

wma 
Windows Media Audio file 

wmd 
Windows Media Download file 

wmv 
Windows Media Video file 

wmz, wms 
Windows Media skins file 

wpd, wp5 
WordPerfect document 

xla 
Microsoft Excel add-in or macro file 

xlam 
Microsoft Excel add-in after Excel 2007 

xll 
Microsoft Excel DLL-based add-in 

xlm 
Microsoft Excel macro before Excel 2007 

xls 
Microsoft Excel workbook before Excel 2007 

xlsm 
Microsoft Excel macro-enabled workbook after Excel 2007 

xlsx 
Microsoft Excel workbook after Excel 2007 

xlt 
Microsoft Excel template before Excel 2007 
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Table 3. 2 (List of File extension) 

Type the desired name on your keyboard and press Enter. The name will be changed. 

Figure 3. 33 (Rename a Folder) 

You can also right-click the folder and select Rename from the menu that appears. 

3.21.4 To delete a file or folder: 
If you no longer need to use a file, you can delete it. When you delete a file, it is moved to 

the Recycle Bin. If you change your mind, you can move the file from the Recycle Bin back to 

xltm 
Microsoft Excel macro-enabled template after Excel 2007 

xltx 
Microsoft Excel template after Excel 2007 

xps 
XML-based document 

zip 
Compressed file 
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its original location. If you're sure you want to permanently delete the file, you will need 

to empty the Recycle Bin. 

1. Click and drag the file to the Recycle Bin icon on the desktop. You can also click the file 

to select it and press the Delete key on your keyboard. 

2. To permanently delete the file, right-click the Recycle Bin icon and select Empty 
Recycle Bin. All files in the Recycle Bin will be permanently deleted. 

 

3.22 File extensions 

Below is a list of common Windows file name extensions and formats. 

3.23 System tools – Disk clean-up and Disk defragmenter 

Computer users always want to keep their computers in tip-top shape so that they would 

encounter fewer problems and experience an optimized performance from their devices. One of 

the few parts that you can maintain yourself is the hard disk drive of your computer, where all 

your files reside. The operating system also gives you the tools to combat the conditions that 

degrade the performance of your drive and the whole computer along with it. 

 

The first of these tools is Disk Clean-up. This tool helps you by freeing up more disk space so 

that you can use it. Most programs don’t clean up too well after itself, leaving files that are no 

longer used and are just taking up disk space. It is the job of Disk Clean-up to track all these files 

along with a few other possible options you can take to free up more space. Disk Clean-up would 

also check the trash bin and old restore files that you may not need. It does ask you for a 

confirmation before deleting these files to make sure that you wouldn’t need them anymore. 

 

The second tool is the Disk Defragmenter. As you use your computer you create files and delete 

files as well. These create unused spaces in between used spaces. Whenever you save a large file, 

sometimes there is no continuous area to put it and your system is forced to cut the files into 

smaller sections in order to be able to save it properly. This is called fragmentation, and the 

longer you use your computer the worse it gets. Fragmentation degrades the overall performance 

of your computer since reading a fragmented file would take longer. 

The Disk Defragmenter helps you by examining the files and trying to plan out the locations of 

each and every file and which files cannot be modified. Once it has done that, it would then try to 

relocate all of the files that it can move so that every file would occupy a single continuous space 
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to help speed up reading processes in the future. It is not a full proof operation though since some 

files that are being used by the system cannot be moved. 

The Disk Clean-up and Disk Defragmenter are the two tools that you can use to keep your disk 

drive working efficiently. The effects of a single use would diminish after sometime, so you 

should regularly run these programs to make sure that your computer is in the best shape 

possible. 
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3.24 Exercise Problems and MCQs 
1. Explain the main purpose of an operating system? 

2. What is demand paging? 

3. What are real-time systems? 

4. What is a virtual memory? 

5. Describe the objective of multiprogramming. 

6. What is time- sharing system? 

7. How are server systems classified? 

8. What is asymmetric clustering? 

MCQs 

1. Which shortcut key is used to copy and paste a file folder? 

a. Ctrl +X and Ctrl +V 

b. Ctrl +A and Ctrl +V 

c. Ctrl +Z and Ctrl +V 

d. Ctrl +Cand Ctrl +V 

2. What should be done, if the pen drive is not deducted? 

a. Device Manger - right click on USB root hub - disable device 

b. Device Manger - right click on USB root hub - enable device 

c. Device Manger - right click on USB root hub - scans for hardware changes 

d. Device Manger - right click on USB root hub - Update drives 

3. Where does the minimized application reside in windows? 

a. Task bar 

b. My computer 

c. My Document 

d. Recent documents 

4. Which is the order of files and directories in Windows Explore? 

a. Serially 

b. Sequentially 

c. Hierarchically 

d. Alphabetically 
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5. Which control panel applet gives the information of computer? 

a. System and security 

b. Hardware and sound 

c. Programs 

d. Appearance and personalization
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CHAPTER  4 

Word Processing 

4.1  Word Processing Basics 

Word processing refers to the creation of documents such as letters, reports, and novels through 
the use of a computer system or software application. Word processing software is used by the 
majority of computer users. The ability to produce text documents with images and drawings is 
provided by word processing software. The word processing tools like Microsoft Word, 
Libreoffice Writer etc. are flexible and simple to use. 
Word Processing uses are as given below 

 A word processor enables users to create documents like letters, resume, letter heads & 
business usage. 

 Store it electronically on a disk. 

 Enter and modify characters using keyboard and print with the help of printer. 

 The Word processor has different variety of uses and applications within the business 
circle, home and education departments. 

 It saves time of the user and enhances document appearance. 

4.1.1 Ms Word 

There are numerous functions in MS Word, including the ability to highlight text, create tables, 
justify text, change fonts, insert bullets and numbers, edit a document, add graphics, make group 
letters, and do grammar and spelling checks. 

Users of MS Word can compose articles, produce documents, resumes, contracts, etc. One of the 
programs in the Office family that is most frequently used is this one. 

We will be using MS Word 2016 in this chapter. 

 

Figure 1.1 (MSWORD options) 
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4.1.2    Opening a Word Processing Suite 

There are numerous ways to launch the word processing programme, including: Single-click the 
Word icon in the task bar Double-click the Word icon on the Desktop. 

Users can reach the word icon if it's not on the Taskbar or Desktop by clicking 

Start → All Programs → Microsoft Office → Microsoft Office Word 2016 

 

 

Figure 1.2 (New Document) 

4.2  Saving a Document 

 You can easily do that by pressing the CTRL+S keyboard shortcut or the Save button 
under File menu. Saving document is also used to update existing document. 
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 Before saving a new document, decide as where to save it as shown in figure 1.3.  Word 
saves documents in the current drive and folder, when the location is not specified. 

 As soon as a user creates or modifies a document, it is temporarily kept in memory until 
the user saves it permanently. 

 If there is a power outage or a hardware issue with the computer, the data may be lost. It 
is therefore wise to regularly save your work.  

 To save an existing document with a new name, use the Save As option under File menu. 
The original document isn't modified when you save as because a new file is created. 

 Saved File has extension or file format of .docx. It can be saved in many other formats 
which we talk further in this chapter. 

 

s  

Figure 1.3 (Save As & Save option) 

 

 

Figure 1.4 (Browser Window to save Word File) 

4.3 Closing a Document  

After completing work on a document, the user must save it then close it and then can exit Word. 
The simplest methods for terminating Word and closing a document are 

 In the Word window's upper right corner, click the Close button. 
 From the File tab, select the Close command. 
 The short cuts on the keyboard for closing words are 
 In order to close a document, press Ctrl + W. 
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 To end Word, press Alt + F4. 
 

4.4 Opening and Existing Document 

Steps to open existing document 
 Choose the File Menu, click Open 
 The user will be directed to the Open window. 
 From the list of files, choose All Word Document. 

 

 

Figure 1.5 File Menu 

 

 Select the drive and folder from which to open the file. 
 Click Open after selecting the desired file to open, or you can just double-click the file. 

Figure 1.6: Browser Window to open file 
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4.5 Title Bar 

The name of the presently running program or document is displayed. It can be found in 
practically any window that is open on your computer. As a result, if there are multiple windows 
on the screen, you can recognise each one by its title bar. 
 

 

Figure 1.7 (Title Bar) 

 

4.6 Menu bar 

The menu is visible in the bar directly beneath the title bar. File is the first item on the menu, 
followed by Edit, View, Insert, Design, Layout, Reference, Mailings , Review, View&Tell me. 

 

4.7 Toolbar 
Just below the menu bar is where you'll find the toolbar or formatting toolbar with the ribbon. It 
includes icons for common commands of selected menu respectively. As shown in Figure 1.9 it 
has icons for text-modifying options including bold, sorted lists, and font size. 

Figure 1.8 (Menu Bar) 
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4.8 Help option 
You can easily access the features or actions you want to utilise by using the text field "Tell me" 
to input the words and phrases that describe what you want to do next. 

 Click on the top left corner “Tell me Option”. 

 Type Command or name of the tool you want to perform. 

 It will show different command suggestions likes commands, Get Help and Smart Lookup. 

 
 Get Help will show you help pages from Microsoft Help documentation and Smart lookup 

will search from insight feature by using internet. 

 
Figure 1.12 (Layout option) 

Figure 1.9 (Toolbar) 

Figure 1.11 (Tell me option) 
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4.9 Page Setup 

The user-defined parameters aid in deciding how a printed page will look. These specifications 
range from size and margins to page rotation and print quality.  

 Options for page setup are found in the "Layout" menu.  
 Word always opens a blank document with the current formatting defaults unless you 

access an existing document. 

 

Through the Page Setup option, you can use these default settings or change them for 
characteristics like margins, paper size, and layout. 

 
 Click the page setup menu to adjust the settings. 
 The page setup window will display a margins icon. 
 To raise the top, bottom, left, or right margins as needed, click on any of the up or down 

arrows. 
 The header and footer positions can also be changed. 

Figure 1.12 (Layout option) 

Figure 1.13 (Page Setup Toolbar) 

Figure 1.14 (Page Setup Menu) 
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 Choose either landscape or portrait to adjust the page's orientation. 
 You can also alter the paper source and layout by selecting the corresponding icons. 

Under layout, you can also set the margins for headers and footers. 

4.10   Page Layout 
 You can also alter the page layout by selecting the corresponding icons. Under layout, 

you can also set the margins for headers and footers. 

 Header and Footer can be set different for odd, even pages as well as different on first  

page. 
 Vertical Alignment of page can be set. 
 You can apply this change to whole document or you can select a point where you want 

to apply changes. 
 Set as Default to set every page setting to default. 
 You can add line Numbers in documents with starting number and margin from text with 

count by options. 
 Numbering can be set continuous, restart at each page as well as each section. 

 
 
 
 
 
 
 
 

Figure 1.15 (Page Layout Option) 
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4.11   Borders 

 

Figure 1.17 (Border and Shading option) 
 To draw border around document or any content on document you have to select border 

and shading in the Home tab. 
 Then click on the square box option in the paragraph toolbar and select Border and 

Shading. 

4.11.1 Borders Dialog Box 

 

Figure 1.18 ( Border and Shading Dialog Box) 

Figure 1.16 (Line Numbers) 
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 You can set border setting like Box, Shadow, 3-D or any custom border around the 
paragraph. 

 Type of style of line in border can also set using style. 
 Color can also be given to borders and width of the border can be set. 
 Options are present to set left, right, top and bottom margin between text and the borders. 
 After all setting click on ok to draw border around paragraph. 

4.11.2  PAGE BORDER 

 You can also set page border setting like Box, Shadow, 3-D or any custom border around 
the paragraph. 

 Type of style of line in page border can also set using style. 
 Color can also be given to page borders and width of the border can be set. 
 Options are present to set left, right, top and bottom margin between text and the borders. 
 After all setting click on ok to draw page border. 

 

 

Figure 1.18 ( Page Border Option) 

4.11.3  SHADING 

 

Figure 1.19 ( Shading Option) 
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 You can add shading to the paragraph using shading option. 
 select fill color and pattern of your desired choice. Click ok to apply changes.  

4.12 Watermark 

Watermark is a picture or piece of text that shows primarily behind another document. For 
instance, documents with watermarks typically show the status of the document, such as 
"confidential" or "Draft," among other things. It is significant to remember that watermarks 
might take the shape of language or even graphics, such as logos, photos, and other valuable 
items. Typically, watermarks are intended to deter copying. As they are downloaded from the 
internet and shared, documents frequently wind up being faked and changed. In order to stop or 
make it more challenging for anyone to use these papers as their own, watermarking is used. 
 

 

Figure 1.9 (Watermarking option in Design Tab) 

 On the Design tab, click. 
 Select the Watermark option under "Page Background" in the drop-down menu. 
 Choose the Confidential watermark option from the list or a watermark from the 

Disclaimers list. 
 You can select custom watermarking from the drop down list to create your own 

watermarking. 
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Figure 1.20 (Custom Water marking) 

 Custom watermarking is of two type Text watermark and picture watermark 
 Select Text watermark to create text watermarking with desired color, font, size and 

layout. 
 In picture watermark you have to select picture which you want to put as watermark in 

document by clicking on select picture. 
 

 

Figure 1.21( Picture Watermark Option) 

 Pick File from the menu. 
 Choose the Save option. 
 The watermark will be added to the document once you've finished the procedures. 

4.13 Print Preview Tap the File Tab 

 Access the Print tab. 
 As an alternative, press Ctrl + P 
 On the right side, preview of the page will be shown and in the bottom page navigation to 

move to certain page is also available. 
 Zoom in the preview can also be performed. 



  Chapter 4 

106 
 

 

 

 

Figure 1.22 ( Print Preview) 

4.14 Printing of Document 

Printing a document is simple after creating it. The following techniques are available to users. 
 Select Print under the File Tab or Press Ctrl and P 
 It will enable print preview as well as Word’s default print setting on the word screen. 
 Click the print button to accept the default print settings. 

 

 

Figure 1.23 ( Print Preview) 

 Setting which are present in document are as follows: 
o Copies: To give number of copies to be print of that document. 
o Printer: You can select printer of your choice in case of multiple printers. 
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o Page: Either select print all page or give range in page text box like 1-3 if you 
want to print from page no. 1 to page no. 3 

o Collated: Print document in collated or uncollated group form. 
o Orientation: To select Portrait or landscape orientation. 
o Size: Set page size of the paper such as A4, A5, A3 e.t.c. 
o Margin: To custom margin. 
o Page per sheet: To print number of sheet in one page. 

4.15  Saving of Document as a PDF File 

Document can also be converted to pdf file which will make document presentable and readable 
format. 

 Select Print under the File Tab or Press Ctrl and P 
 It will enable print preview as well as Word’s default print setting on the word screen. 
  Click the printer option and select Microsoft Print to PDF in the drop down menu. 
 Browser window will be opened to save document as pdf. 
 Give name to the document which you want to save as pdf and click on Ok to save as pdf 

 

Figure 1.24 (Save document as PDF) 

 

Figure 1.25 (BrowserWindow ) 
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4.16 EDITING TEXT 

With the help of Word, users can easily and rapidly alter previously-written content. A document 
can be edited in a variety of ways. 

4.16.1 Inserting Text 

 Simply begin typing to edit the text; the content will appear where the flashing cursor is. 
 The left button on the mouse or the arrow keys on the keyboard can be used to move the 

cursor. 
 The keyboard shortcuts that are described below can be used while entering text into a 

document. 
o HOME and END keys are used to start and end lines respectively. 
o CTRL+ HOME key to go to top of the document. 
o  CTRL+ END key to go to the bottom. 

 

4.16.2 Cut, Copy & Paste 

Any of the following techniques can be used to insert text into a document. 
 Drag Text to the desired location in document  
 Cut and Paste Text 
 Copy and Paste Text 

4.16.3 Overtype Mode 

 The user should position the cursor where they want to add text and then type. 
 Check to see if the user is in overtype mode. 
 When altering text in overwrite mode, all characters to the right of the insertion point are 

replaced. 
 Take these actions to make it in non-overtype mode. 
 Choose File from the menu, then select Option from the bottom. 

 

Figure 1.26 ( Use Overtype Mode) 
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 Click Advance in the left pane. 
 Select or deselect the Use Overtype mode check box under editing options. 

4.17 TEXT SELECTION 

Selecting text is a simple trick that makes document revision simple. The block of text that has 
been chosen is referred to as the selection and is highlighted in the document. Any character, set 
of characters, word, sentence, paragraph, or entire document might be considered a selection. 
Depending on the size of the region you want to pick, the user has different options for selecting 
the text. 
Text Selection Procedure 

 Select the text by moving the mouse pointer over it while holding down the left mouse 
button, or use the arrow keys on the keyboard while holding down the SHIFT key to 
highlight the text. 

 The information that follows includes shortcuts for picking a section of text. 
 Double-click on a word within the word. 
 Triple-click within the text to select the entire paragraph. 
 Drag the mouse pointer over a few words or lines, or use the arrow keys while holding 

down the SHIFT key. 
 Press Ctrl+A to select the whole document, or select Edit | Select | Select All from the 

Ribbon. 
 By holding down the Ctrl button while selecting the text with the mouse in Word, the user 

can pick noncontiguous text. 
 

 

Figure 1.27 (Selected Text) 

4.18 CUT, COPY AND PASTE 

 Use Ctrl + C or the Copy button under the Home tab to pick a word or a line, 
respectively. 

 Put the cursor where you want to paste the copied text after that. 
 Press Ctrl + V or the Paste button located beneath the Home tab. 
 Text Copy and Paste 
 Choose a word or a line, then press Ctrl+X or the Cut button on the home tab. 
 Next, position the cursor where you want to paste the text. 
 Press Ctrl + V or the Paste button located beneath the Home tab. 
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Figure 1.28: Clipboard section on the ribbon 

4.19 FONTs 

 Click on the Home tab. 
 There is font section on the ribbon that contain all formatting related to font name, color, 

style and size. 

 

Figure 1.29 (Font section) 

4.19.1  FONT NAME 

 Inside font section font name can be selected based on the requirement from the drop 
down menu. 

 

Figure 1.30: Font name 

4.19.2  FONT COLOR 

 Inside font section font color can be changedby choosing a color from color selector.  
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Figure 1.31 (Font color) 

4.19.3  FONT STYLE 

Font style can also be changed. 
 To make text bold select ‘B’ from Font section or use shortcut CTRL + B. 
 To make text italic select ‘I’ from Font section or use shortcut CTRL + I 
 To make text underlined select ‘U’ from Font section or use shortcut CTRL + U. 

Underline can be set with different style and color by clicking on drop arrow button. 

 

Figure 1.32: Font Style section 

 

Figure 1.33 (Underlined style) 

4.19.4  FONT SIZE 

 To change size of the font select choose any size by selecting drop down arrow on font 
section. 
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 To grow size by 1 pixel click on grow font. 
 To reduce size by 1 pixel click on shrink font. 

 

Figure 1.34 (Font Size) 

4.20 ALIGNMENT OF TEXT 

There are three types of alignment 
 Align the text left or right  

o Select the text to align.  
o On the Home tab, in the Paragraph group, click Align Left or Align Right button. 

 Center the text 
o Select the text to center. 
o On the Home tab, under Paragraph group, click Center button. 

 Justify the text 
o Select the text to justify. 
o On the Home tab, under Paragraph group, click Justify button. 

 
 

 

Figure 1.35 (Text Alignment) 

4.21 UNDO AND REDO 

 Word allows users to undo or redo modifications they have made to a document by 
keeping track of their changes. For instance, if a user unintentionally deletes a text, they 
can undo the action and recover the content by pressing Ctrl + Z. 

 If the user changes their mind and decides to maintain the deletion, they can undo it by 
pressing the Redo command (Ctrl + Y). 

 You can reverse changes using any of the following techniques. 
 Go to the Quick access toolbar, and click the Undo button or use the keyboard shortcut 

(Ctrl + Z). 
 Click the Redo button on the Quick access toolbar to undo changes or use the keyboard 

shortcut (Ctrl + Y). 
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Figure 1.36 (Quick Access toolbar) 

4.22 AUTOCORRECT 

Common typographical errors are automatically fixed by the AutoCorrect feature when they 
occur. Learn how to utilise Word's auto-correct feature to have the spelling of words in your 
papers corrected as you enter them. 
Setting Autocorrect 

 The Word Options dialogue box will appear when you click the File tab, select Options, 
and then select the Proofing option found in the left-most column. 

 Select Autocorrect tab in dialog box. You must now verify that each option—particularly 
the Replace Text as You Type option—is turned on. Additionally, it is advised to exercise 
caution whenever an option is disabled. 

 

Figure 1.37 (Autocorrect Dialog box) 

 Depending on your preferences, pick one from the autocorrect choices as shown in Fig 
1.37 based on your requirement. 

 Though Word already has hundreds of AutoCorrect items configured, you may manually 
add more by using the Replace and with text boxes in the dialogue box. You can utilise 
the add button to add many entries. 
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Figure 1.38  (Add new text to autocorrect list.) 

 Once more click OK to close the Word Options dialogue box after closing the 
AutoCorrect Options dialogue box. Try typing pounds now; as soon as you do, Word 
replaces it with the appropriate pound word. 

4.23 SPELLING AND GRAMMAR 

 As the contents are typed, Word frequently checks the spelling and grammar. 
 When a word is underlined with a red squiggly line, Term believes the word has been 

spelled improperly. 
 The grammar can be wrong if the line is green. 
 If the line is blue, the word is spelt correctly but is being used incorrectly. 

 
Checking Spelling and Grammar 

 With the help of the spelling and grammar button, the user can check all or a portion of 
the text for errors. 

 Click the Spelling & Grammar button on the Review tab. It will then display the Spelling 
and Grammar window. 

 

Figure 1.39 (Spelling Suggestion) 

Suggestion words 
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 Word will attempt to provide one or more suggestions for every error it finds in your 
document. 

 The problem can be fixed by choosing a suggestion and clicking Change. 
 Word will go to the next error until the user has reviewed every one. 
 When the spelling and grammatical check is finished, a dialogue box will show up to 

confirm that the last error has been evaluated. 
 Click "OK." 
 The user can manually type the correct spelling in his work if none are suggested. 

 
Ignore Error 
Grammar and spelling checks don't always work perfectly. There are numerous mistakes that 
Word frequently makes that are grammatical in nature. Additionally, the spelling and grammar 
checker will occasionally state error when anything isn’t. This frequently occurs with people's 
names, which might not be spelled correctly. When Word flags something as an error, the user 
has the option of leaving it alone. 
 
For spelling errors 
Suggestion: It will show you autocorrect word suggestions. 
Ignore All: This will ignore the word without altering it and ignore it other occurrence also. 
Adding to dictionary: Itadd word to preloaded dictionary so that it will never be misinterpreted. 
 
For Grammar Errors 
Suggestion: It will show you autocorrect grammar suggestions. 
Ignore: Ignore will simply skip over any grammatical problems without altering them. 
When anything is grammatically incorrect, Word explains why it believes it is so. You can use 
this to decide if you want to change it or not. 
 

 

Figure 1.40 ( Right click on spelling error) 

 

Figure 1.41  (Right click on grammar error) 
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4.24 AUTOMATIC SPELLING AND GRAMMAR CHECKING 

The user may not even need to conduct a separate check because Word checks the document for 
spelling and grammar mistakes by default. These mistakes are shown as coloured, wavy lines. A 
misspell word is indicated by the red line. Misused words and other grammatical errors are 
indicated by the blue line. When a word is spelt correctly but used inappropriately, it is 
considered to be abused. 
 
Modify Automatic Spelling and Grammar checking 
The user may not even need to conduct a separate check because Word checks the document for 
spelling and grammar mistakes by default. These mistakes are shown as coloured, wavy lines. 
A misspell word is indicated by the red line. Misused words and other grammatical errors are 
indicated by the blue line. When a word is spelt correctly yet used improperly, it is considered to 
be abused. 
 

 Click Options after selecting File tab. 
 There will be a dialogue box. Select Proofing from the menu on the dialogue box's left. 
 The dialogue box provides numerous possibilities for selection. 

 

Figure 1.42 (Spelling &Grammar check option dialog box) 

 Uncheck the box if the user does not want Word to check spelling automatically.  
 Uncheck the box that says, "Mark grammar errors as you type," if the user does not want 

grammar problems to be marked. 
 Uncheck this box if the user does not want Word to look for frequently confused word 
 Uncheck grammar and spelling if user does want to check spelling and grammar 

automatically 
 By default, Word does not check for run-on phrases and sentence fragments (incomplete 

sentences). 
 Click Settings in the dialogue box, then choose the Fragments and Run-ons checkbox to 

enable this feature. 
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4.25 FIND AND REPLACE 

 Use the Find button in the Editing group on the Ribbon of Home tab or the keyboard 
shortcut Ctrl + F to search for a certain word or phrase in a document. 
 

 

Figure 1.43 ( Editing section in Home tab) 

 Click the Replace button on the Editing group tab to search for and replace a word or 
phrase in the document. 

 

 

Figure 1.44 (Find and Replace dialog box) 

 Enter the text in Find What to find text and Replace with text to replace text as shown in 
Figure 1.43. 

 Click on replace button to replace for single instance and Replace all to replace it in 
whole document. 

4.26 FORMATTING THE TEXT 

 The user document's text is fairly simple. In order to add interest and emphasis to the text, 
the user can apply formatting tools like BOLD, ITALIC, UNDERLINE, FONT, FONT 
COLOR, etc. 

 
 

 
 

Figure 1.45 ( Font Tab) 
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 Select a word using the mouse. The selection highlighting disappears when you click 
anywhere else in the document. 

 The text's font style can be changed as necessary. The user has a variety of font styles 
from which to choose. 

 By selecting the necessary size, the font size can be maintained as needed. 
 By selecting the text and picking the proper colour from the colour palette, font colours 

can be altered. 
 To add bold formatting, click the bold button. When text is selected, it becomes 

somewhat larger and darker. 
 In addition, formatting can be applied to an entire block of text rather than just one word 

or line at a time using mouse drag select. 
 Users can also add underlining and italics. Italic formatting tilts the characters left and 

take care while using this in papers. Although it slows down the reader, it is appropriate 
for emphasis. 

 To underline the text, click the Underline button. 
 Select the text or number you want and select Superscript button or Subscript button to 

superscript and subscript text respectively. 
 Strike through is used to draw line in the middle of the words. 
 By clicking on the relevant buttons once again, you can additionally add or delete the 

bold, italic, and underline formatting. 

4.27 USER DEFINED STYLES 

Styles are essential to Word's fundamental power. They enable you to specify the visual style of 
your text consistently across a page or a collection of documents. There are many different ways 
to define styles. 

 In Word, the Style dialogue box is displayed on the home tab. 
 You can select one of the pre-defined styles from the Style dialogue if you'd like. For 

typical text treatments, these can frequently save you a ton of time and effort. 
 
 

 
Figure 1.46 (Style Section) 

 Right click on style and select modify if you want to modify selected a predefined style. 
 

 

Figure 1.47 ( Modify Style) 
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Figure 1.48 ( Modify Style formatting) 

 Click on New to create a new style definition. In either case, you see roughly the same 
dialogue box where you can modify the style's characteristics. 

 

Figure 1.49 (Create new Style) 

 Make sure to include the name and category of the new style you are creating when 
defining it. Additionally, you can say whether this new look is based on or derived from 
an existing style. 

 To modify the formatting attributes actually allocated to the style, click theformat button. 
Depending on whether you are working with a paragraph style or character style, several 
formatting options are available. 
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Figure 1.50 ( Create New style formatting) 

 To close the dialogue box after finishing setting the formatting attributes, click OK. Your 
style is shown in the list of possible styles when Word's Style dialogue box is displayed 
once more. 

 

Figure 1.50 (New style added) 

4.28 Format Painter 

To easily apply the same formatting to numerous pieces of text or pictures, such as colour, font 
style, size, and border style, use the Format Painter on the Home tab. You can apply all of the 
formatting from one item to another with the format painter; think of it as copying and pasting 
for formatting. 
 

 Choose the text or image that has the desired formatting. 
 Select Format Painter by clicking the Home tab. A paintbrush icon appears in place of the 

pointer. 

 

Figure 1.51 ( Format Painter) 
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 To apply the formatting, use the brush to paint over a selection of text or visuals. It only 
functions once. Double-clicking Format Painter is necessary before you may change the 
format of several selections in your project. 

 Press ESC to stop formatting. 

4.29 PARAGRAPH FORMATTING 

4.29.1  PARAGRAPH INDENTATION 

There is multiple way through which you can indent paragraph. Following are the method to 
perform paragraph indentation 

 Press the "Increase indent" or "Decrease indent" button in the "Paragraph" section in 
Home tab after choosing the line to which the indent should be applied. 

 

Figure 1.52 (Indentation) 

 Paragraph dialog box  
o Click the little arrow to display the "Paragraph" dialogue box in the lower right 

corner. This can be accessed by the user by selecting the "Paragraph" group under 
the "Home" or "Page Layout" tabs. 

 

Figure 1.53 (Paragraph Dialog Box) 

Decrease Indent Increase Indent 



  Chapter 4 

122 
 

o Look for the part under "Indentations." The "Indents and Spacing" tab contains 
this information. 

o Select "Special" from the drop-down option. When you choose "First Line," the 
first line of each new paragraph is automatically indented. 

o The amount by which each line should be indented should be entered. 
o The size that is most frequently used is 0.5 or 1/2 inch. 
o In the Preview section at the bottom of the dialogue box, the user can view a 

preview of the changes. 
o To apply user modifications to the document and save them, click OK. 
o If the user wants to set the modifications to automatically take effect only after 

new documents, click the "Set as default" button. 

4.29.2  BULLETS AND NUMBERING 

 To give the chosen text Bullets and Numbering. Use the numbering button and bullets in 
the Paragraph section under the Home tab. 

 On the Bullets button, click the tiny down arrow. 
 The user can go to a display box. The user can choose any bullet from the several sorts of 

bullets in that display box to insert. 
 

 

Figure 1.54 (Bullets and Numbering) 

4.29.3  CHANGE CASE 

 Choose the text whose case you want to change. 
 Select Change case under Home tab in font section. 

 

Figure 1.55 (Change case in font section) 

 Choose one of these: 
o Click Sentence case to capitalize the initial letter of a sentence while keeping all 

other letters lowercase. 
o Click lowercase to remove capital letters from your text. 
o Click UPPERCASE to make all of the letters capitalized. 
o Click Capitalize Each Word to capitalize the initial letter of each word while 

keeping the remaining letters lowercase. 
o Click toggle case to switch between two case views. 

Bullet

Numbering 
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4.30 HEADER AND FOOTER 

Footers are displayed at the bottom of the Word document while Headers are displayed at the top 
of the document. Information such as the title, file name, date, page numbers, etc. are inserted in 
headers and footers. Your document looks more professional and is simpler to read and 
understand if it has a header and footer in Word. 

 Open a document and Select the Insert tab from the Ribbon's top menu. 
 In the Header & Footer section, select either the header or the footer from the drop-down 

menu. If you want to insert Page number use Page number option in Header & Footer 
section 

 

Figure 1.56 (Header & Footer) 

 The built-in Header and Footer options will be listed in a drop-down menu that will 
appear on the screen. Choose the item you want from the Built-in list. 

 The ribbon will display a Design tab with a Header & Footer option. 
 

 

Figure 1.57 (Design Tab) 

 In the header or footer section, type the information you want to see. 

 

Figure 1.58 (Header in Document) 

 Click on Close Header and Footer under the Design section of the Ribbon. You can now 
see that the Word document has the Header inserted. 

4.31 TABLE 

There are rows and columns in a table. A cell is the point where a row and a column meet. 

4.31.1 TABLE CREATION 

 On the Ribbon, select the Insert tab. 
 Select Table from the menu and choose Insert Table. 
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Figure 1.59 ( Tables section) 

 To choose the required number of columns and rows. 
 You can also choose AutoFit behavior to have fixed columns, Auto fit to contents or auto 

fit to window. 

 

Figure 1.60 (Insert table) 

 Press OK to create table. 

4.31.2  TABLE MANIPULATION 
4.31.2.1 Inserting row or column 

o Place the cursor where the user wants to add a row or column in the table. 
o When using the right mouse button, select the Insert option. 
o Click the Insert Row Above or Insert Row Below button to insert a row. 
o Click the Insert Columns to Left or Insert Columns to Right button to insert a 

column or you may use the layout tab. 

 

Figure 1.62 (Insert column or row) 
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4.31.2.2 Deletion of row or column 

o Place the cursor in the desired deletion row or column. 
o Right-click the mouse, and then select the Delete Cells option. 

 

Figure 1.63 (Delete Cells) 

o To delete an entire row or column, click Delete entire row or Delete entire 
column, respectively. 

 

Figure 1.64 (Delete cells dialog Box) 

4.31.2.3 CHANGING WIDTH AND HEIGHT 

 Table can be resize using drag at the right edge of the table. 
 Other way of changing width and height is to select whole table using mouse. 
 Then You can also right click on table and select table properties from the drop down 

menu. 

 

Figure 1.65 (Table Properties) 

 Under table properties dialog box you can select row tab and modify height. 
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Figure 1.66 (Row tab in Table Properties Dialog Box) 

 Under table properties dialog box you can select column tab and modify width. 

 

Figure 1.67 (Column tab in Table Properties Dialog Box) 

 Next Column, Next Row button present on the dialog box is to change height and width 
individual row and column. 

4.31.2.4 ALIGNMENT OF TEXT IN CELL 

 Inside Table Properties Dialog Box, you can select cell to set the vertical alignment of 
text in cell. 

 Select all the cell in which you want to apply alignment and open Table Properties Dialog 
box 

 

Figure 1.68 (Cell option in Table Properties Dialog Box) 
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 Click on the cell tab and select vertical alignment of your choice then click Ok to apply. 
 For Horizontal alignment of text in cell, select the cell. 
 Go to home tab and select horizontal alignment from the paragraph section. 

 

Figure 1.69 (Horizontal Alignment) 

4.31.2.5 MERGING CELLS 

 Select a group of cells which you want to merge. 
 Right click over those cell and select merge cells option in drop menu as show in figure 

1.70. 

 

Figure 1.70 (Merge Cells) 

4.31.2.6 SPLITING CELLS 

 Right click on the cell which you want to split. 

 

Figure 1.71 ( Split Cells) 

 Click on split cells then dialog box will be opened to enter number of rows and columns 
 Enter rows and Column and click Ok to split cell. 

 

Figure 1.72 (Split cells dialog box) 
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4.32 MAIL MERGE 

A helpful tool that makes it simple to create a collection of papers is mail merge. Although the 
information in each paper is the same, part of it is unique. For instance, the basic points of 
advertisements or invitation letters will be the same, with the exception of the customer's name 
and address. Each letter's content is derived from entries in a data source, such a spreadsheet. 
Create a new address list if there isn't one already if necessary. 
The information and fields for document merging are imported from the MS Excel database into 
a Mail Merge document that is prepared in MS Word to print mailing documents. Knowing what 
information should be printed and how to format it is crucial for creating papers. 

4.32.1 MAIL MERGE CREATION 

 Open Microsoft Word and enter the letter's content. 
 Next select Start Mail Merge from the mailings tab. 

 

Figure 1.73 ( Start Mail Merge) 

 Select Step-by-step mail merge wizard by clicking. A mail merging window will 
appear on the right side of the screen. 

 

Figure 1.74 ( Mail Merge Wizard) 

 Then select the appropriate document type. Below is a list of each type's 
definitions. then select next. 

 Select the current document. With this selection, mail merge will be created using 
the open document. Select next. 
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Figure 1.75 ( Selecting mail merge document) 

 Use a list that is already in existence. For client information, this will use the 
already-existing Excel document. Then choose the current customer details 
document by clicking the browse option. 

 If there isn't a customer details document already, make one by choosing the 
create new option, then choose the brand-new customer details document. Select 
next. 

 

Figure 1.76 (Choose or make recipients) 

 A dialogue box for the mail merging recipient will now appear. Choose the people 
you want to send mail to from there. then press "OK" 

 Place the cursor where the recipient's address will be added to the document now. 
 Next, select the required recipients' name format from the mail merge wizard 

window by clicking the Address block option. The document will now have the 
address block. 

 Then, with the pointer in the document's right side, select the greeting line choice 
and the appropriate greeting line format by clicking on it. Next, click. 

 The mail merge document preview will now appear on screen. By pressing the 
forward and backward buttons, the user can examine the prepared document for 
each recipient. 

 When the user previews the recipient document, they have the option to exclude 
recipients by selecting the Exclude the recipient button. Next, click. 

 Finally, choose All, click OK, and then select the Edit Individual option to make 
any necessary modifications. 
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Figure 1.77 (Mail Merge  Recipients.) 

 Save the newly formed merged document after that, or the user can print it right 
away by clicking the print button and choosing the "All" option from the Print 
option dialogue box. 

 

Figure 1.78 (Preview of Merged Document) 

4.32.2  PRINTING MAIL MERGE DOCUMENT 

 A combined document can be printed just like a regular document. 
 The user is given an additional window where they may choose the data source to utilise 

and the records they want to print. 
 To print mail merge document following steps should be followed. 

o Open any previously prepared mail merge envelopes, labels, or letters in order to 
start printing a merge document. 

o Under the mailing tab, select Finish & Merge -> Print Document, and then select a 
printer from the Merge to Printer dialogue box.  

 

Figure 1.79 (Printing of Mail merge document) 
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o Select the page of the document that needs to be printed. The user has the option 
of all, Current record, certain page intervals, etc. 

 

Figure 1.80 (Merge to Print) 

o Click “OK” and print dialog box will open to customise your printing. 
o Click on print to print records. 

 

4.33 TABLE OF CONTENTS 

The reader can be taken directly to the section they need to be in by employing by using table of 
contents. A table of contents not only makes the text more readable, but it also makes it simpler 
for the author to go back and alter the content as needed. 
Insert 

 Place the cursor where the table of contents should be added. 
 Select an automatic style by going to References -> Table of Content which will create 

table of contents. 
 

 

 

 

Figure 1.81: Table of Contents 

 
 If you add some more text update the table of contents by right-clicking it and selecting 

Update Field if you make any changes to your document that has an impact on it. 

Table of Contents 

Remove Table of Contents 

Table of Contents 

Update Table 
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Figure 1.82 (Update Field) 

 To manually change your table of contents, select update table the contents table on the 
ribbon. 

 
Missing Entries 

 If any entries are missing, headers that aren't formatted as headings frequently result in 
missing items. 

 Select the heading text for each heading you want to appear in the table of contents. 
 Navigate to Home -> Styles and select Heading 1 will insert a heading 
 Publish an updated table of contents. 

 
Update 

 Update the table by going to References as show in figure 1.82. 
 Then choose from the following option: 

o If you want to update the page numbers. This ignores any changes to the heading 
text and simply refreshes the pages that the headings are on. 

o Second is Complete table update. Any changes to the heading text and any page 
changes will be reflected in this. 

 Choose OK. 
 

Remove 
 To remove table of contents, click on Table of Contents in ribbon under Reference Tab. 
 Select remove Table of contents from the drop down menu as shown in figure 1.82. 

4.34 INDEXES 

The essential terms and phrases in a document are typically listed in an index at the end of the 
document, together with the page numbers on which they are written in a document. 
 
Indexes Entries 

 Simply click where you want to place the entry or choose the text you want to use as an 
index entry. 

 

Figure 1.83 ( Index Option) 

 Click Mark Entry in the Index group under the References tab. 
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Figure 1.83: Mark Entry Dialog box 

 The text in the Mark Index Entry dialogue box is editable. 
 A second level can be added in the Subentry box. If a third level is required, place a colon 

after the subentry text. 
 Click Cross-reference under Options, then enter the text for the other entry in the box to 

create a cross-reference to it. 
 Select the Bold check box or the Italic check box beneath Page number format to format 

the page numbers that will be displayed in the index. 
 To mark the index entry, click Mark. 

 
Insert Indexes 

 Wherever you wish to add the index, click. 
 Click Insert Index in the Index group under the References tab. 

 

Figure 1.84 (Insert Index) 

 You can customise the format for text entries, page numbers, tabs, and leader characters 
in the Index dialogue box. 

 

Figure 1.85 (Insert Index Dialog Box) 

 By selecting an option from the Formats dropdown menu, you can alter how the index 
appears overall. The window on the left-hand side of the screen shows a preview. 

 Select OK. 
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Update 
 Click the index and then press F9 to refresh it. As an alternative, select Update Index 

from the Index group on the References tab. 

 

Figure 1.86 (Update Index) 

Remove 
 Press DELETE after selecting the full index entry field, including the braces ({}). 

4.35 ADDING COMMENTS 

Comments can be added to the document to provide review or feedback to the document author. 
 Select any object like word, character paragraph etc. 
 Right click on the object to select New comments option in menu. 

 

Figure 1.87 (New Comments) 

 A comment Box will appear in right side of the document to write comment. 
 Write your comments and you can further add sub comment by click on the add icon 

provided in the comment box. 

 

Figure 1.88 (Comment Box) 

4.36 TRACKING CHANGES 

 Pick Track Changes from the Review tab's options. 
 The section is highlighted when Track Changes is enabled. A strikethrough is used to 

indicate deletions, whereas an underlining is used to indicate additions. Changes made by 
various authors are denoted by various colours. 

 The section is not highlighted when Track Changes is disabled. The coloured underlines 
and strikethroughs remain in the document after Word stops tracking changes. 
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Figure 1.89 (Track Changes) 

 Reviewing Pane will show you all the history of changes during track changes is enabled. 

 

Figure 1.90 (Reviewing Pane) 

4.37 MACROS 

A saved set of instructions or keystrokes that are kept for future usage is known as a macro. Due 
to the macro language's extreme flexibility, both easy and difficult activities can be automated. 
When you need to repeatedly complete the same task in the same manner, macros are quite 
helpful. 
Usage pre-written macros or the built-in macro recorder, which records keystrokes and saves 
them for use, are the typical approaches for beginners. 
 
Record Macros 

 Open a Word document. It can be existing or new document. 
 Click the View tab on the Ribbon, then select the Macros section's drop-down icon by 

selecting it. 
 From the drop-down option, select Record Macro. 

 

Figure 1.91 (Macros Option) 

 The screen will display a Record Macro dialogue box where you can perform the 
following actions: 

o In the text area labeled "Macro name" type the name of the macro. 
o Select All Documents (Normal.dotm) from the Store macro in drop-down menu to 

apply the same macro to a subsequent document. 
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o To execute your macro, click the Button icon in the Assign macro to section. 

 

Figure 1.92 (Record Macro) 

 Perform the action which you want to record. 
 Next, select the Macros drop-down option from the View tab. From the drop-down 

option, select Stop Recording Macro to stop recording. 

 

Figure 1.93 (Stop Recording) 

Edit or Run Macro 

 Click the View tab on the Ribbon, then select the Macros section's drop-down icon by 
selecting it. 

 From the drop-down option, select View Macro. 
 Either select run to run the macro or edit to modify a macro. 

 

Figure 1.94 (Run a macro) 

 You can also delete macro using delete button shown in figure 1.94. 

4.38 Introduction To Google Docs 

You can create and modify documents online using the Google tool known as Google Docs, 
which can be viewed from a computer or other internet-connected device. The user can create 
writings and documents that are stored online, or in the cloud, using this word processor. 
A Gmail account (Google's email service) and internet connectivity are prerequisites for using 
Google Docs. The utility is then available for free use. Google Docs documents can be sent 
through email, downloaded to a computer, or shared online with other users for editing or making 
suggestions for changes. 
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Figure 1.95 (Google Docs) 

Features 
 It features a word processor that enables document writing and editing. 
 It can be utilised from a computer or from electronic devices like cell phones or tablets as 

it run on web browser. 
 It is a no-cost service that doesn't need any special software to be installed. 
 All newly created documents can be downloaded to a computer or other device and are 

automatically kept in Google Drive, Google's online storage service. 
 Because it doesn't save information in the computer's memory, it frees up a lot of space 

on the device. 
 One or more people can collaborate on the same document with it.You can share same 

document with multiple people and they can also edit it. 
 To increase functionality, it is often and automatically updated. 

 
Create Google Doc  

 Sign in to Google Docs using your Gmail account. 
 Select the required selection from the "Start a new document" section, which includes 

blank documents and templates for letters, brochures, resumes, and more. 

 

Figure 1.96 (Start a new document) 

 Any of the choices when pressed launches a document (blank or template as the case may 
be). 

 Enter the document's name by selecting "Untitled Document" and clicking. 
 
 Put the cursor on the page of blank paper and begin typing. 
 To make changes to the font size or typeface, page orientation, paragraph formatting, or 

to add photos or graphics, use the toolbar at the top of the document somewhat similar to 
MS word. 
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Figure 1.97 (Untitled Document) 

 The blue share rectangle in the top right corner must be clicked, and the user's email must 
be entered, if you want to share the document with other users. 

 

Figure 1.98 (Share option) 

 You can find the document in "Recent Documents" after it is automatically saved. 
 
Some Functions 

 Letter Formatting enables you to choose from a wide variety of fonts that may be altered 
in size, colour, boldness, and other aspects. 

 Format for paragraphs provides options for line spacing, orientation, spaces, and 
indentation for text paragraphs. 

 Orientation of the page allows you to choose between landscape and portrait as the 
document's orientation. 

 Graphics and images enables you to include in the document many types of photos, 
illustrations, graphics, and drawings. 

 Table It enables you to create and add tables. 
 Links let you associate a specific URL with a specific section of the document. 
 Grammar and spelling. Spelling and grammar errors should be highlighted after an 

automatic text check. 
 Edition enables multiple users to collaborate on a document at once. 
 Alter the control. It enables document users to view all text repairs and modifications that 

have been done. 
 Comments enable any user who has access to the document to post a written comment on 

a particular passage of text or image. Other users have the ability to reply, edit, or delete 
these comments. 

 Transferring and downloading files. It enables you to upload documents created with 
various word processors to the cloud as well as download files from the cloud to your 
computer or other device. 

 It enables offline document creation and editing, with subsequent automated saving. 
 Voice dictation translates the user's verbal expressions into written text. 
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4.39    Exercise Problems and MCQs 

 
 What do you mean by basic concepts of word processing? 
 Describe how to insert table of contents in your document. 
 Describe how to do character and paragraph formatting in document. 
 What are all the different shortcuts available in Microsoft Word? 
 What is Google Docs and what are its features? 

 
MCQs

1. What is the shortcut to create hyperlink in a document? 
a) CTRL + H 
b) CTRL + B 
c) CTRL + A 
d) CTRL + K 

2. Which of following account is required to access Google Docs? 
a) YAHOO 
b) BING 
c) MICROSOFT 
d) GMAIL 

3.  Portrait suggests the page is oriented _________, whilst landscape means the page is 
oriented ___________. 

a) Vertically, Horizontally 
b) Horizontally, Vertically 
c) Vertically, Vertically 
d) Horizontally, Horizontally 

4. What is the shortcut to select whole document? 
a) CTRL +A 
b) CTRL +ALL 
c) CTRL + X 
d) CTRL + Y 

5. In Microsoft Word, which shortcut key is used to close a document? 
a) CTRL +S 
b) CTRL + O 
c) CTRL + W 
d) CTRL + D 
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CHAPTER 5 

Elements of Spreadsheet-Excel 

 
5.1   Basics of Excel  
 
The most popular spreadsheet programs are Microsoft Excel, which enables users to list their 
data, summaries it, compare it, and present it graphically. The software application package that 
replicates a paper worksheet and is frequently used by people in management is referred to as a 
spreadsheet. 
 
A digital spreadsheet is one that uses Microsoft Excel. Financial statement automation is one of 
the many jobs that MS-Excel is capable of. An interactive computer application program called a 
spreadsheet is used to organise and analyse data in tabular form. 
 
Data is represented in the spreadsheet program as array cells that are arranged in rows and 
columns. Each member of the array, or cell, includes data that can be either numerical, textual, or 
the output of formulas that compute and display values dependent on the contents of other cells. 
Access to data that is stored in database formats is possible using MS-Excel. Excel proves to be a 
strong and adaptable tool for graphic presentations. Based on data, graphs or charts can be made 
to quickly assess a situation. 
 
 
 
 
 

 

Figure 5.1 (Spreadsheet) 

5.2   Opening MS EXCEL 2016  
 
Select "Start Menu" =>Go to all program=> Find Microsoft Excel directory => select Microsoft 
Excel. 

Quick 
Access Tab List 

Title Bar 
Ribbon Formula

Cell 

Column List 

Row number 

Name Box 

Sheet per sheet   Zoom 
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 Name Box 
o A huge spreadsheet's Name box makes it quick and simple to navigate and choose 

ranges. 
 Office Button 

o The Microsoft Office button is located in the Excel 2007 window's upper left 
corner. 

o When the Office button is clicked, a drop-down menu with various options is 
displayed. 

 Ribbon 
o Ribbon in Microsoft Excel 2016, the Ribbon is found above the Quick Access 

Toolbar in the Excel window. 
o Ribbon includes numerous tabs; hitting a tab reveals several related command 

groups and related command buttons within each group. 
 Title bar 

o The Title bar is located next to the Quick Access Toolbar. Microsoft Excel shows 
the name of the current workbook on the Title bar. 

 Quick Access Toolbar 
o The Quick Access Toolbar can be found next to the Microsoft Office button. 
o The Save, Undo, Redo, and Print buttons are clustered together on the Quick 

Access Toolbar. 
 Column Letter 

o Column Letters are letters that are used to identify columns, which are vertical 
lines of cells that are named from A to Z and then AA to AZ, BA to BZ, and so 
on. Total there are  16,384 columns. 

 Row Number 
o Row numbers refer to the horizontal rows of cells in a row.Each row is identified 

by a number. 
o From 1 to 1,048,576 are the rows' numbers. 

 Sheet Tab Scroll Button 
o The Sheet Tab Scroll Buttons for the First sheet, Previous sheet, Next sheet, and 

Last sheet are located on the bottom left of the worksheet. 
 Cells 

o Intersection of row and column represented as block. 
 

5.3    Closing MS Excel 2016 

Either click on close button on the right top most corner or enter shortcut key  
 
 
5.4   Creating Spreadsheet 
 

 Creating a Blank Workbook  
o To create a new Excel file, click the File tab and  double-click Blank Workbook, 

or choose Create. 
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Figure 5.2 (Blank Workbook) 

 Creating a Sample Template 
o  To open a template, go to the File tab, select the New button, and then either 

double-click a template or select the Create button. 
o To search template from internet click on the search bar on the top with 

placeholder “Search for online templates”. 
 

 

Figure 5.3 (Template) 

5.5   Concept of Cell Addressing 

 Row Number 
o Row numbers refer to the horizontal rows of cells in a row. Each row is identified 

by a number. 
o From 1 to 1,048,576 are the rows' numbers. 

 Column Number 
o Column Letters are letters that are used to identify columns, which are vertical 

lines of cells that are named from A to Z and then AA to AZ, BA to BZ, and so 
on. 

o Total there are 16,384 columns. 
 Cell Address 

o Cell address is composed of Column no and row no. For e.g.: if you choose 
column B and Row 4 then cell address is B4. 

o Cell address can be seen in Name Box 
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Figure 5.4 (Cell Address) 

 

5.6    Entering Data into Cell 

By entering text in the active cell, you can add data to a spreadsheet.When you type and 
press ENTER, the following cell becomes active.The arrow keys can also be used by the 
user to move between cells. (Display keyboard arrows) 
 

 Text 
o Enter the text which you want to enter in active cell. 

 Number 
o Enter the numeric data which you want to enter in active cell. 
o You can enter fractional part of decimal number by dot (.). 

 Date 
o Enter the date of you format like 22-06-2022, 22/06/22 etc. which you want to 

enter in active cell. 
o Once the date format is set it will automatically insert each date in that format for 

those columns 
o You can also specify date using  “=DATE (year, month, day)”  into cell will return 

the date as day/month/year 
 
 
 

 

Figure 5.5 (Entering Data) 

 

Name Box 

Row Number 

Column Number 
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5.7    Page Setup 

The user-defined parameters aid in deciding how a printed page will look. These specifications 
range from size and margins to page rotation and print quality.  

 Options for page setup are found in the "Page Layout" menu.  
 Excel always opens a blank document with the current formatting defaults unless you 

access an existing sheet. 

 

Figure 5.6  (Page Layout) 

 Through the Page Setup option, you can use these default settings or change them for 
characteristics like margins, paper size, and layout. 

 Click the page setup menu to adjust the settings. 

 

Figure 5.7 (Page Setup Toolbar) 

 The page setup window will display a margins icon. 
 To raise the top, bottom, left, or right margins as needed, click on any of the up or down 

arrows. 

 

Figure 5.8( Margin Option) 

 The header and footer positions can also be changed. 
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Figure 5.9(Page Setup Dialog Box) 

 Choose either landscape or portrait to adjust the page's orientation. 
 You can also alter the paper source and layout by selecting the corresponding icons. 

Under layout, you can also set the margins for headers and footers. 

 

Figure 5.10 ( Sheet Option) 

 Sheet option can be used to print selected area from excel using mouse drag select, 
title can also be given.  

 Printed sheet can be gridlines, black and white and with or without row column 
headings. 

 Printing page order of sheet can also be given using page order section under sheet 
tab. 

5.8    Printing of Sheet 

 From the File tab, select the Print option or press the shortcut key Ctrl + P. 
 The print preview is now visible to the user. 
 At the bottom of the window, click "Next Page" or "Previous Page" to view the other 

pages that will be printed. 
 Under Print, choose how many copies you want to print. 
 Select the printer's name under Printer. 
 The first drop-down list in the Settings contains three choices. Print Active Sheets - 

For only active sheets printing.  
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 Print the complete workbook - To print the entire worksheet. 
  Print Selection - For printing on a single sheet. 
 Page numbers can be entered in the text field to specify specific pages. 
 You can switch between Collated and Uncollated if one copy has numerous pages. 
 The user can choose between Landscape Orientation and Portrait Orientation, which 

has more rows but fewer columns (more columns but fewer rows). 
 User-defined paper size selection. 
 From the Margins drop-down list, choose one of the predefined margins (Normal, 

Wide, or Narrow). 
 From the Scaling drop-down list, choose "Fit Sheet on One Page." 
 To acquire a printout after all changes have been made, click the Print button. 
 

 

Figure 5.11 (Print Preview) 

5.9    Saving Spreadsheet 

 Click the File tab, choose Save or Save As, or use the keyboard shortcut Ctrl + S to save a 
workbook. 

 Choose the necessary drive, enter the file name, verify the file type, and then click the 
Save button to save the workbook. 
 

 

Figure 5.12 (Save Option) 
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5.10    Manipulation of Cell and Sheet 

5.10.1    Cells 

Rows and columns can be moved around, much like cells. To do this, first right-click on a 
cell or range of cells.  

 

Figure 5.13 (Cell Manipulation) 

 Cut, copy, and paste cells will be available under the cell manipulation menu. Use this to 
copy cells between locations in your worksheet. 

 Insert cells - Keep in mind that you must instruct Excel how to insert a cell (you must 
either shift rows or columns in the existing sheet to accommodate the new cell). 

 Delete cells - Deletion moves your sheet in the same way that insertion does. When you 
delete a cell, Excel will ask you where you want the cells to move. 

 Cell Formatting - Apply formatting to every cell using this option. Possible formatting 
options include background colours, text colours, and borders 

5.10.2    Sheet 

 

Figure 5.1(Sheet Options) 

 The command “Insert” brings up a window where we can select whether to insert an 
ordinary worksheet or a special worksheet (chart, macro, form, template, etc.) 

 Delete: Using this option, we can remove an active worksheet. 
 Rename: When a new worksheet is added, it automatically receives a name that consists 

of the word “Sheet” and the current sheet number. We can use this option to rename the 
worksheet such that it emphasizes the data or reports it includes. 
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 Opens the dialogue box for moving or copying the active worksheet using the Move or 
Copy command. The dialogue window first gives us the option to select which worksheet 
we want to move or copy the current worksheet in front of, as well as whether we want to 
move or copy it to one of the existing or new workbooks. There is an optional field at the 
bottom of the window that, if filled out, shows that we are copying and that the worksheet 
is not being relocated. 

 

Figure 5.14 (Move or Copy) 

 By selecting the “Color” option, a menu allowing us to choose the worksheet card’s 
colour will appear. 

 These options are used to either detect one or more hidden worksheets or to hide the 
current worksheet. 

 By selecting select all sheet, all of the current worksheets will be selected. 

5.11    Modifying / Editing Cell Content 

There are numerous ways you can edit content in a cell 
 The most common way to edit a cell is by simply double-clicking it in the first 

approach. 
 You can select a cell and press F2 button to edit content. 
 Formula Bar 

 First select the cell in which you want to edit and its content will be shown 
in formula bar. 

 

Figure 5.15 (Formula Bar) 

o Edit the content in the formula bar and click on tick or cross icon  to confirm or 
clear the edit respectively as shown in figure 5.16. 

 

Figure 5.16  
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 5.12   Formatting Cell 

5.12.1Font 

 Click on the Home tab. 
 There is font section on the ribbon that contain all formatting related to font name, color, 

style and size. 

 

Figure 5.17 (Font section) 

5.12.2    Font Name 

 Inside font section font name can be selected based on the requirement from the drop 
down menu. 

 

Figure 5.18 (Font name) 

5.12.3    Font Color 

 Inside font section font color can be changed by choosing a color from color selector.  
 

 

Figure 5.19(Font color) 
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5.12.4  Font Style 

Font style can also be changed. 
 To make text bold select ‘B’ from Font section or use shortcut CTRL + B. 
 To make text italic select ‘I’ from Font section or use shortcut CTRL + I 
 To make text underlined select ‘U’ from Font section or use shortcut CTRL + U. 

Underline can be set with different style and color by clicking on drop arrow button. 

 

Figure 5.20(Font Style section) 

 

Figure 5.21(Underlined style) 

5.12.5   Font Size 

 To change size of the font select choose any size by selecting drop down arrow on font 
section. 

 To grow size by 1px click on grow font. 
 To reduce size by 1px click on shrink font. 

 

Figure 5.22( Font Size) 
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5.12.6    Alignment 

The process of formatting involves altering how the data in a worksheet appears.Labels and 
column headers, for example, are always aligned to the left of a cell by default.Values, often 
known as numbers, formulas, and dates, are always aligned to the right.Excel makes it simple to 
enhance the layout and appearance of a worksheet by using the cell alignment icons on the Home 
tab of the ribbon because these default alignments are not always the greatest option for user’s 
data. The Home tab has a group called Alignment. 

 

Figure 5.23( Alignment Group) 

5.12.7     Vertical Alignment 

 In the Vertical Alignment three options are there to do Top Align, Middle Align, and 
Bottom Align. 

 Select a cell or range of cells. 
 Click the Top Align, Center, or Bottom Align command. 

 

Figure 5.24( Vertical Alignment) 

5.12.8    Horizontal Alignment 

 The text is aligned Left, Center, and Right using horizontal alignment. 
 Choose a cell or range of cells to align text or numbers in a cell. 
 On the Home tab, select one of the Align Left, Center, or Right commands. 

 

 
5.12.9      Styles 

 Predefined Styles 
o Choose which cells you want to format. See Select cells, ranges, rows, or columns 

on a worksheet for further details. 
o Select the cell style you want to use by clicking the dropdown arrow in the style 

gallery under the Styles group on the Home tab. 
o You can also modify existing style by right clicking on it and select modify. Then 

click on format and apply modification. 
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Figure 5.26( Styles) 

 User defined styles 
o Click the dropdown arrow in the style gallery under the Styles group on the Home 

tab, and then click New Cell Style at the bottom of the gallery. 

 

Figure 5.27( New Cell Style) 

o Enter a suitable name for the new cell style in the Style name box. 
o Click on Format. Choose the formatting you desire from the tabs in the Format 

Cells dialogue box, and then click OK. 
o Clear the check boxes next to any formatting you don’t want to be included in the 

cell style in the Style dialogue box by going back to Style Includes (By Example). 
o Select OK. 

 

Figure 5.28( Format Cells) 
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5.13     Cut, Copy and Paste 

 Use Ctrl + C or the Copy button under the Home tab to pick a word or a line, 
respectively. 

 Put the cursor where you want to paste the copied text after that. 
 Press Ctrl + V or the Paste button located beneath the Home tab. 
 Text Copy and Paste 
 Choose a word or a line, then press Ctrl+X or the Cut button on the home tab. 
 Next, position the cursor where you want to paste the text. 
 Press Ctrl + V or the Paste button located beneath the Home tab. 

 

Figure 5.29( Clipboard) 

5.14    Paste Special 

Paste Special provides a variety of choices to paste only particular parts of copied cells or 
execute a mathematical function on the copied data in circumstances where a conventional 
copy/paste is not acceptable. You could, for instance, copy data with formulas and only paste the 
computed values into the same or different cells. The Paste Special instructions all function both 
inside the same worksheet and between worksheets and workbooks. 

 The quickest method is to select the cell or cells you want to copy, then click the shortcut 
Ctrl + C. 

 Choose the final cells. 
 Use one of the techniques listed below to see the Paste Special dialogue  

o Hit the Paste Special shortcut CTRL+ALT+V. 
o Click on Paste dropdown under home tab and select paste special 

 

Figure 5.30( Paste Special) 

 Click OK or press the Enter key after choosing the preferred pasting option as shown in 
figure 5.32. 
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Figure 5.31( Pasting Options) 

5.15     Cell, Height and Width 

 Row Height 
o Either select one row or all rows using left edge of the sheet as show in figure 

5.32. 

 

Figure 5.32( Select All) 

o Right click on the left corner of the rows will show you row height option. 

 

Figure 5.33( Row Height) 

o Click on Row Height and modify height. 

 

Figure 5.34( Enter Row Height) 

 Column Width 
o Either select one row or all rows using left edge of the sheet as show in figure 

5.32. 
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Figure 5.35( Select All) 

o Right click on the left corner of the rows will show you row height option. 

 

Figure 5.36( Column Width) 

o Click on Row Height and modify height. 

 

Figure 5.37 ( Enter Column Width) 

5.16     Insert and Delete 

 Insert Row 
o Right click on the row number where you want to insert row if you want to insert 

single row. 
o To insert multiple row select multiple rows. 
o Insert can be chosen from the drop-down menu by right-clicking one of the 

chosen rows. The same number of rows that you chose will be inserted by Excel. 

 

Figure 5.38 ( Insert option) 

o Click on Insert and it will insert row 
o If you want to insert between already inserted rows then you have to choose an 

appropriate from the insert dialog box as show in figure 5.39 
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Figure 5.39( Insert Dialog Box) 

 Delete Row 
o Select rows which you want to delete. 
o Right click on the rows will show you option shown in figure 5.40 

 

Figure 5.40 ( Delete option)  

o Click on delete  
o If you want to delete between already rows then you have to choose an 

appropriate from the insert dialog box as show in figure 5.39 

 

Figure 5.41 (Delete Dialog Box) 

 Insert Column 
o Right click on the column number where you want to insert row if you want to 

insert single column. 
o To insert multiple column select multiple column. 
o Insert can be chosen from the drop-down menu by right-clicking one of the 

chosen rows. The same number of column that you chose will be inserted by 
Excel. 

 

Figure 5.38  (Insert option) 

o Click on Insert and it will insert row column. 
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o If you want to insert between already inserted column then you have to choose an 
appropriate from the insert dialog box as show in figure 5.39 

 

Figure 5.39 (Insert Dialog Box) 

 Delete Row 
o Select rows which you want to delete. 
o Right click on the rows will show you option shown in figure 5.40 

 

Figure 5.40 (Delete option) 

o Click on delete  
o If you want to delete between already column then you have to choose an 

appropriate from the insert dialog box as show in figure 5.39 

 

Figure 5.41 (Delete Dialog Box) 

5.17     Autofill 

Fill Excel cells with data that adheres to a specific pattern recorded in other cells by using the 
autofill tool. A succession of cells are filled automatically. For Example you want to generate a 
serial number in Excel where s.no.is contained in one of the columns. Each day's number can be 
entered manually or automatically filled in for you in cells that match a pattern using the autofill 
option. 
We initially require data in one or two cells to recognise the pattern in order to use this 
functionality based on which other cells will be filled with the data. It can produce any kind of 
values. 
 

 In cells A1 and B1, we have first entered the names of the years. 
 Select multiple cells at this point, then move the mouse to the bottom right corner of each 

selected cell. There will be a tiny, bold Plus sign. It is also called as Excel Fill Handler. 
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Figure 5.42 (Excel Fill Handler) 

 In the Excel sheet, vertically drag the plus sign. It will identify the pattern as a year and 
automatically fill in the other cells' remaining years. 

 

 

Figure 5.43 (Autofill Entries) 

 If you want to autofill entries horizontally then you have to drag Excel Fill Handler horizontally. 
 If you want to autofill one entries in multiple column then select single entry and drag it to 

multiple rows or column vertically or horizontally respectively. 
 

 

Figure 5.44 (Same Entry Auto fill) 

 

5.18     Sorting and Filtering 

5.18.1     Sorting 

Data sorting is always necessary for speedy search since it organises the data in a way that makes 
it simple to search. Finding any record in the table or Excel sheet is simple if the data has been 
sorted. Data analysis requires the sorting of the data. Data can be sorted in many different ways, 
including alphabetically (from A to Z, Z to A), from highest to lowest, from lowest to highest, 
according to date and time, and in a variety of other ways. 
 

 Launch the Excel sheet that contains the data you wish to sort. 
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 To sort the full Excel sheet using one column value, select all the data on the sheet. It 
implies that the accompanying column data will also be sorted when column values are 
sorted. 

 You may find a Sort function option in the Sort & Filter group by going to the Data tab in 
the Excel menu bar. 

 
 This Sort option can be selected to display a pop-up dialogue box. 

 

Figure 5.46 (Sort Dialog Box) 

 Enter or choose a column from the list in this dialogue box as the basis for sorting the 
data. To sort the table, for instance, use Marks. 

 Click the OK button after specifying Order. We'll choose the ascending order smallest to 
largest. 

 

Figure 5.47(Enter Criteria) 

 Verify that the entire table's data has been successfully sorted according to the sorting 
order and column you selected. Their corresponding row data was also sorted. 

5.18.2     Filtering 

When data is filtered in Microsoft Excel, only the rows that satisfy specific criteria are displayed. 
Users frequently use Auto Filter to remove data, and Advanced Filter for more difficult data 
problems. These techniques are quick and effective, yet they lack dynamic qualities. Simply put, 
these solutions do not immediately update anytime the source data changes. 
 
Auto filter 

 Select the header row. 
 To set a filter, select Data Tab => Filter as shown in figure 5.45. 
 Remove the check mark from Select All by clicking the drop-down arrow in the Area 

Row Header.  
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Figure 5.48 (Filter) 

 This will deselect everything then choose the checkbox next to the data you wish to filter. 
 The rows with the filtered (hidden) data are those for which some of the row numbers are 

missing. 
 The Area column's drop-down arrow now displays a different visual, an indication 

indicating that the column has been filtered. 
 

 

Figure 5.49 (Filtered Icon) 

5.18.3     Advance Filter 

 

Figure 5.50 (Range and Criteria) 

 To use advance filter you have to type your data as well as criteria on the basis you want 
to filter data. 

 Click on advanced on sort & Filter Group under data tab. 

 

Figure 5.51 (Advanced) 

List Range 

Criteria 
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 Select list range of data and criteria which you want to apply using drag mouse over 
criteria. 

 

Figure 5.52 (Setting Criteria) 

 Click on OK to filter the data. 

 

Figure 5.53 (Filtered Data) 

5.19     Freezing Panes 

Go to the View tab to Freeze Panes to lock select rows and columns in place or Split Panes to 
create two windows of the same worksheet if you want to keep a portion of a worksheet visible 
while scrolling to another portion of the worksheet. 

 To froze First column  
o Choose View => Freeze Panes => Freeze First Column. 
o Column A and Column B have a tiny line between them that indicates the first 

column is frozen. 
 To froze First two columns 

o Choosing the third column. 
o To freeze panes, select View => Freeze Panes. 

 To froze Freeze rows and columns 
o Choose the cell that you wish to keep visible when you scroll below the rows and 

to the right of the columns. 
o To freeze panes, select View => Freeze Panes. 

 

Figure 5.54 (Freeze Panes) 

 

 

Filtered data 
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 Unfreeze Pane 
o Go to the View tab => Freeze Panes => Unfreeze Panes. 

 

Figure 5.55 (Unfreeze Panes) 

5.20    Conditional Formatting 

Excel have a feature called conditional formatting that enables you to apply unique formatting to 
cells that satisfy particular requirements. It is most frequently used to draw attention to, 
emphasise, or distinguish between different pieces of data and information in a spreadsheet. 
Users can access a variety of features using conditional formatting to make the data more 
understandable and informatics. Additionally, formatting cells and data that satisfy the required 
standards is possible. 
Many pre-set conditions that a user typically needs are available with conditional formatting, 
including greater than, less than, duplicate values, unique values, etc. Excel provides various pre-
set conditions as a result, saving users’ time when developing formulas. 
 

 It may be found under Home => Style => Conditional Formatting on the Home tab. 
 You can set pre-set condition and create custom formatting as shown infigure 5.56. 

 

Figure 5.56 (Conditional Formatting) 

 Highlight Cells Rules 
o By applying pre-set conditions that satisfy the required parameters, this conditional 

formatting rule enables users to highlight specific cells. Users of Excel can choose from 
conditions like Greater than, less than, Between, Equal to, Text that contains, and 
Duplicate Values. 
 

 Top/Bottom Rules 
o The top/bottom rules in this conditional formatting format the cell data by highlighting 

the cells. The top 10 cells or the bottom 5 cells of a column are typically highlighted 
using this technique. 

Pre-set Condition 

Custom Condition 
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o Such pre-set criteria as Top 10 things, Bottom 10 items, top 10%, Bottom 10%, Above 
Average, and Below Average are all included in Top/Bottom rules. 
 
 

 Data Bars 
o Data bars are coloured bars applied to Excel data to depict a cell’s value. The two 

conditional formatting examples above are not the same as these data bars. They serve as 
a clear indicator of the higher/lower status of the data stored in the cells. 

o Data is represented graphically by data bars. Or you may say that the data is displayed 
graphically. 

o By marking the cells with a colour according to the high and low value in the cell, Data 
Bars assist Excel users in displaying the clear status on the basis of overall data. 

o One thing to keep in mind is that the data bars only apply to data that is numerical in 
nature. 

o Data bars can be represented using a variety of colours thanks to conditional formatting. 
 Color Scale 

o A colour scale is applied to a group of cells using conditional formatting. Where each cell 
value falls within the cell range is shown by the colour. Twelve different colour scales are 
available in Excel’s conditional formatting to depict the data. 

o Only numerical values in an Excel worksheet are applicable to this conditional formatting 
with a colour scale. 
 

 Icon Sets 
o The many icon sets in Excel can be used to represent the data in cells. Several other sorts 

of icon sets, including Directional, Shapes, Indicators, and Ratings, are included in 
conditional formatting. 

How to apply condition formatting 

 Choose a set of cells in your Excel spreadsheet. 

 

Figure 5.57 (Selected cells) 

 Click on the Conditional Formatting button under the Home tab. 
 Click any conditional formatting rule which you want to apply. Here we are applying 

greater than condition rule by hovering the mouse over the highlighted cells rules in the 
dropdown list. 
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Figure 5.58 (Conditional Formatting) 

 Similar to this, you can select any other parameters from this list and carry out the process 
as necessary. 

 Enter a value to check all the selected values against in this field. 
 Press the OK button after adding the colour to emphasise the higher values. 
 All of the values in the figure 5.59 that are more than 33 are highlighted in green. 

 

Figure 5.59 (Output) 

5.21    FORMULAS 

A rule expressed using mathematical symbols is the formula. An “=”sign is typically used to 
connect two or more values. When you are aware of the value of one quantity, you can use the 
formula to determine the value of the other. It facilitates speedy question resolution. Formulas are 
used in algebra, geometry, and other subjects to speed up and simplify the process of arriving at 
the result. 
A formula in Excel is an expression that manipulates values in a cell or a range of cells. Consider 
the formula “=C1+D1”, which calculates the sum of the values in cells D1 AND D1.”=” sign is 
used before expressing any formula. 

5.21.1    USING FORMULA FOR NUMBERS 

 Formulas can be used in Excel to compute and analyse data in a worksheet. 
 In a formula, the values in the cells are used to carry out operations like addition, 

division, multiplication, and subtraction. 
 Formulas can use the cell and require mathematical operators like (+, -, *, and /). 
 A formula must always start with the equal (=) symbol. 
 Using formulas in Excel, a user can calculate and examine data in their worksheet. 

 
Addition 

 Operator :  + 
 Example : = (A1 + B1) 

Subtraction 
 Operator :  - 
 Example : = (A1 – B1) 

 
Multiplication 

 Operator :  * 
 Example : = (A1 -* B1) 

Division 
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 Operator :  + 
 Example : = (A1 / B1) 

 

Figure 5.60 (Formula) 

5.22     Function 

 In Excel, a function is a predefined formula. 
 Similar to formulae, functions start with the equal sign (=) and the function's name. 
 The function name instructs Excel on the calculation to be carried out. 
 Round brackets are used to surround the arguments. 
 There are many different sorts of functions in spreadsheets, including 

o Math Function 
o Logical Function 
o Statistical Function 
o Text Function 
o Date and Time Function 

 

Figure 5.61 (Function Library) 

Math Function 
 Excel offers the Excel Math Functions to do many of the simple mathematical operations, 

such as arithmetic, are conditional, the trigonometric ratios, sums, and products.E.g. LOG 
(), COS (), SIN (), COS (), ABS (), etc. 

Logical Function 
 Excel offers logical functions to assist users in working with logical values, such as 

TRUE and FALSE. 
 They contain functions that return constant logical values, boolean operators, and 

conditional tests. E.g. IF (), NOT (), "TRUE (), "FALSE (), "AND (), etc. 
Statistical Function 

 A wide range of statistical functions in Excel can be used to accomplish the majority of 
typical statistical computations, from simple mean, median, and mode calculations to 
more intricate statistical distribution and probability tests. 

 Examples include AVERAGE (), COUNT (), CORREL (), FDIST (), FINV () and others. 
Text Function 

 Excel offers text functions to make it easier for users to work with text strings. 
 They contain tools for extracting data from text strings, formatting them, converting 

between text and other data formats, and splitting and joining text strings. 
 For E.g. FIND (), "CONCATENATE ", "LOWER ", "UPPER ", "MID ", etc. 

Date and Time Function 
 Dates, Times, and Days are calculated using Data and Time functions, such as DATE (), 

DAY (), MONTH (), HOUR (), MINUTE (), etc. 
  
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5.22.1      Function Wizard 

 The user is prompted by the Function Wizard to enter the information required for each 
function. 

 If users are unsure of the proper format to use while entering the formula, Function 
Wizard may be helpful. 

 Along with displaying the formula result, the Function Wizard also provides a description 
of the function at the bottom. 

 Additionally, it provides a variety of built-in features that users can employ. 

 

Figure 5.62: Function Wizard 

 

Figure 5.63 (Function Wizard Dialog Box) 

5.23    Auto Sum 

 To perform autosum select all the cells which is to sum up. 

 

Figure 5.64 (Selected Cells) 

 Click on formulas tab on the ribbon. 

 

Figure 5.65 (Formulas tab) 

 Click on the drop down Autosum option present in Function Library group. 
 Select Sum. 
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Figure 5.66 (Sum function) 

 Autosum will appear on the next cell as shown in figure 5.67. 

 

Figure 5.67 (Autosum) 

5.24    Charts 

A chart is a tool for communicating data in a visual manner. Typically, charts are used to 
examine trends and patterns in large data sets. Excel has 15 various types of charts, and each one 
is better suited for particular jobs due to its unique capabilities. The information will be simpler 
to grasp and easier to communicate with others in your small business if you pair a chart with the 
appropriate data style. 
Excel provides the main chart kinds listed below: 

o Column Chart 
o Line Chart  
o Pie Chart  
o Doughnut Chart 
o Bar Chart  
o Area Chart  
o XY (Scatter)  
o Chart Bubble 
o Chart Stock 
o Chart Surface  
o Chart Radar Chart 
o Combo Chart 

 Create Chart 
o Click on the first cell of data to choose it, then move the cursor over the remaining 

cells to include them in the chart by dragging the cursor over them. 
o Click on the right arrow in the charts group on the Insert tab. 

 

Figure 5.68 (Charts) 
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Figure 5.69 (Insert Chart dialog box) 

o You can select any of the chart from dialog box shown in figure 5.69.It also 
contain preview of the chart. 

 

Figure 5.70 (Line Chart) 

o By initially clicking on the chart to open the Design tab on the ribbon, users can 
update the chart layout, style or change chart type etc. 

 

Figure 5.71 (Chart Design Tab) 

o Select Data from the data group on the Design tab of the Chart Tools window. 

 

Figure 5.72 (Data Group) 
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Figure 5.73 (Data Source) 

 Data Range: Range of all select cells. 
 Legend Entries: These entries will be plotted in chart. 
 Horizontal Axis : To edit horizontal axis labels in the chart 

o You can alter all the above element of chart by click on add, edit or remove option 
shown in figure 5.73. 
 

 Modify Charts 
o Click on the change chart type option under chart group in Design tab. 

 

Figure 5.74 (Change Chart Type) 

o Select chart from the change type window and click OK. 

 

Figure 5.75 (Change Chart) 

 Delete Charts 
o Click on the chart and select delete button on keyboard to delete chart. 

 

5.25    Database Functions 

The functions in Excel databases are created in a way that a user can utilise an Excel database to 
conduct operations like Sum, Average, Count, Deviation, etc. on it. The built-in database 
function in Microsoft Excel only operates on the appropriate database or table. The Excel 
Database Functions are intended to assist you in working with an Excel-stored database. 
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The database functions carry out fundamental calculations like sum, average, count, etc., but they 
also take into account criteria arguments that let you limit the computation to a specific subset of 
the database records. 
 
Database: The set of cells that contain the data. The labels for each column are located in the 
range's top row. 
Field: It is the column to be utilized in calculations. A column's position or label (name) can be 
entered. Using quote marks, you can type a name such as "Result" or a position index such as 7th 
column. 
Criteria: The set of cells containing the criteria used to select the records to be considered in the 
calculations. The label of the columns to be filtered and any conditions that go with it make up 
the criteria. 

 

Figure 5.76 (Database function syntax) 

The following list includes some database functions that are built-in: 
 DSUM: This will return sum of the values from the selected databases that meet the user's 

requirements 
 DCOUNT: It will count the cells in the chosen database that contain a certain number 

and meet the user's requirements. 
 DCOUNTA: It will count the non-blank cells in the chosen database that meet the user's 

requirements. 
 DMAX: It will return the highest value from the database that was chosen and that 

satisfies the user's criteria. 
 DMIN: It will return the database's minimal value that satisfies the user's requirements. 

 
How to use database functions 

 Make headers for the DSUM results where we will add up the marks of students. 
 Using the equal sign, calculate the DSUM of the provided data using the DSUM function. 
 In Cell F2, type database range i.e. A1 TO E6. 

 

Figure 5.77 (DSUM database) 

 When it asks for your field now, choose cell E1. 

 

Figure 5.78 (Field) 

 After that it will ask for criteria where the condition will be applied then select E2 to E6. 
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Figure 5.79 (Criteria) 

 Press Enter. 

 

Figure5.80 (DSUM Output) 

5.26    What if-Analysis 

What-if analysis is the practice of altering values in worksheet cells to evaluate how those 
changes may impact the results of calculations. To examine all the possible results, you can 
utilise a variety of different sets of values in one or more formulas. 
Using Excel, you can use the following Tools for what-if analysis that you can employ based on 
your demands for data analysis. 
 

 Goal Seek 
 Data Tables 
 Scenario Manager 

 
Goal Seek 
If you know the outcome you desire from a formula but are unsure of the input value the formula 
requires to produce that outcome, Goal Seek can be helpful.Let's look at an easy example.  

 A student uses the spreadsheet depicted in the image below to keep track of his final 
exam marks. He has so far received all of the grades for all subjects with the exception of 
the one with the question mark as shown in figure. 

 

Figure 5.81 (Student Marks) 

 He needs at least a 55 to pass the class even though the average marks is 51. What grade 
does he need to get on the Hindi exam to pass the course? Goal seek could be used in 
place of manually attempting random values.  

 Using Goal Seek 
o Click on the What-if Analysis option in data tab under forecast group. 
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Figure 5.82 (Forecast option) 

o Select Goal Seek. 
o Goal seek dialog box will open.  

 Set cell: Select cell which is the target  
 To value: what is the target 
 By changing cell: cell that’s value need to be changed 

 

Figure 5.83 (Goal Seek Dialog box) 

o Press OK after setting all values and it will show you the mark student have to 
achieve to get average of 55. 

 

Figure 5.84 (Goal Seek Result) 

Data Tables 
Data Table is a range of cells in which you can change values in some of the cells and come up 
with different answers to a problem. For example, you might want to know how much book you 
need to sell to gain different profits. 
 
Scenario Manager 
Scenario is a list of values that Excel stores and can automatically fill in worksheet cells with. 
What happens though if you sell 70% for the highest price?  How would it be if you sold 80% of 
it for the highest price or maybe 90%, maybe 100%? A distinct situation applies to each different 
proportion. These situations can be made using the Scenario Manager. 

 Let take the example of student marks which was discussed earlier in goal seek to create 
different scenarios based on student marks. 

 Using Scenario Manager 
o Click on the What-if Analysis option in data tab under forecast group. 
o Select Scenario Manager and dialog box will appear. 

 

Figure 5.85 (Scenario Manager) 
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o Click on add. 

 

Figure 5.86 (Scenario ManagerDialog box) 

o Another dialog box will appear to set name and changing cell by select cell using 
mouse drag on marks column. 

 

Figure 5.87 (Add Scenario) 

o Click on OK. 
o Next windows will be shown to edit multiple values of field to create scenario. 

 

Figure 5.88 (Scenario Values) 

o Click OK after changing values and scenario will be added. 

 

Figure 5.89 (Scenario Added) 

o To get summary click on summary on scenario manager. 
o Summary report dialog box may be opened. Select scenario summary and click 

OK. 
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Figure 5.90 (Scenario Summary) 

 

Figure 5.91( Scenario Summary Output) 

5.27     Pivot Charts 

An effective tool for calculating, condensing, and analysing data that enables you to spot 
comparisons, patterns, and trends in your data is the pivot table. Using pivot tables, we can 
condense vast amounts of data into a matrix that resembles a grid. In the table’s rows and 
columns, you can select the fields you want to use. The pivot table is graphically represented for 
us by the pivot chart. There are many different chart kinds and layouts to pick from. 
A pivot table in Excel is represented visually by a pivot chart. Pivot tables and pivot charts are 
related to one another. 
 

 Create Pivot table 
o Choose the cells from which you wish to build a pivot table. 
o Select PivotTable under Insert. 

 

Figure 5.92( Pivot table) 
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Figure 5.93 (Create PivotTable) 

o By doing this, a PivotTable based on an existing table or range will be created. 
o Select the location where the PivotTable report will be displayed. Choose Existing 

Worksheet and then choose where you want the new PivotTable to appear if you 
want to add the PivotTable to an existing worksheet. 
 

 

Figure 5.94 (Select pivot fields) 

o Select OK. 

 

Figure 5.95( Pivot Table) 
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 Create Pivot Chart 
o Click on the cell to select pivot table 
o Click PivotChart under the Tools section of the PivotTable Analyze tab. 

 

Figure 5.96 (Pivot Chart Option) 

o The dialogue window for inserting charts appears. Select any chart of your choice  

 

Figure 5.97(Insert Chart) 

o Select OK. 

 

Figure 5.98(Pivot Chart) 

 Filter Chart 
o Only the fields utilised in your pivot table can be filtered.  
o The Triangle symbol next to bank details should be clicked. 
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Figure 5.99 (Filter button) 

o Filter options will be opened. 

 

Figure 5.100 (Filter Box) 

o You can choose field to filter from filter list and click on OK. 
 

 Change Chart Type 
o Click on the chart and design tab may be opened in the ribbon. 
o Click on the Change chart type under type group in design tab. 

 

Figure 5.101 (Change Chart Type) 

o Change charge type dialog box will appear where you can select chart of your 
choice. 

o Select Ok to apply changes. 
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Figure 5.102 (Change chart type dialog Box) 

5.28     Data Validation 

Microsoft Excel has a function called data validation that limits what a user can type in a cell. 
For instance, limit the inputs in a sheet to a date range or only whole integers. Dropdowns can 
also be made, which saves space and displays the values in a single cell. Additionally, we may 
design a notice that will appear if a user enters an invalid value or format. 

 Choose one or more cells to validate, then click the Data Validation button on the Data 
tab’s Data Tools group. 

 

Figure 5.103( Data Validation) 

 Set the validation criteria as needed under the Settings tab. You may include any of the 
following in the criteria: 

o Values: Enter numbers in the fields for the criterion as seen in the screenshot 
below. 

o Make a rule based on a value or formula in another cell using cell references. 
o Formulas – enable the expression of more intricate circumstances, as in this case. 

Let’s create a rule that limits users to entering whole numbers between 10 and 99 
as an illustration: 

 

Figure 5.104(Validation Criteria) 
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 Select another tab to add an input message or/and error warning after configuring the 
validation rule, or click OK to close the Data Validation window. 

 Open the Input Message tab and carry out the following steps to show a message 
informing the user what information is permitted in a particular cell: 

o Check the box next to Show input message when cell is selected. 
o Put your message’s title and content in the corresponding fields. 
o To close the dialogue box, click OK. 
o The user should be informed what to enter in a cell by adding an input message. 
o The input message appears when the user chooses the cell. 

 

Figure 5.105(Input Message) 

 When erroneous data is entered in a cell, you can display one of the following error 
messages in addition to the input message. 

o Stop Style 
 The most stringent alert kind, which stops users from submitting 

inaccurate data. 
 You can erase the entry by clicking Cancel or Retry to enter a different 

value. 
o Warning sign 

 Users of the data’s invalidity but does not stop them from entering it. 
 You can enter a false entry by clicking Yes, change it by clicking No, or 

cancel by clicking Cancel. 
o Information Alert Information 

 The most flexible alert kind, which merely alerts users to incorrect data 
entry. 

 You can input an invalid value by clicking OK or delete it by clicking 
Cancel. 
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Figure 5.1060( Error Alert) 

 

Figure 5.107(Validation Output) 

5.29   Integrating Word Processor, Spreadsheet and Web Page 

5.29.1   Word Processor 

 Word document can be inserted into spreadsheet 
 Go to Insert and click on Object in Text section 

 

Figure 5.108 (Text Section) 

 Object window will open which will show option to create object type Microsoft word 
document,presentation,text e.tc.  

 You can select above option and click ok if you want to copy paste document content 
from doc file. 
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Figure 5.109 (Create new object) 

 Click on Create from file to import document file directly into spreadsheet using browse 
button. 

 

Figure 5.110 (Create from file) 

 

 

Figure 5.111(Select File) 

 Select OK to integrate document into excel sheet. 
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Figure 5.112(Document integration) 

5.29.2     Spreadsheet 

 Another spreadsheet can be integrated with excel sheet by following all the steps involve 
in integrating word document already shown above. 

 Instead of importing word document file you need to import excel sheet. 
 

5.29.3     Web Page 

 Select Data tab from ribbon  

 

Figure 5.113 (From Web) 

 Click on From Web under the Get External Data group on the Data tab. 
 Click Go after entering the website address from which the user wishes to retrieve data. 

The user may need to scroll to find the information they’re looking for on the website 
after the page loads in the preview box. 

 Any web tables that a user can import into Excel will have a little arrow next to them. 
After selecting the data with the arrow, press the Import button at the bottom of the 
dialogue box. 
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Figure 5.114 (Preview Box) 

 Click OK after selecting the location the user wants Excel to store the online data. 

 

Figure 5.115 (Import data) 

 A notification that Excels is getting the data in the spreadsheet and little while later, web 
data will show up in Excel. 

5.30    Introduction to Google Sheet 

A free online spreadsheet programs called Google Sheets is available through the Google Drive 
service. The program is also accessible from desktop application and a mobile app for iOS, 
Android, and Windows. Other Google products including Google Docs, Slides, and Forms are 
also hosted via the Google Drive service. 
 
Users of Google Sheets can edit, arrange, and analyse various kinds of data. It supports 
collaborations, enables simultaneous editing and formatting by several users, and keeps track of 
all spreadsheet revisions. 
 
Features 

 It can be access at anywhere and anytime via internet connection on device like mobile or 
computer. 

 It is one of the most widely used spreadsheet programs on the planet, and it is simple to 
use and learn. 

 It can be applied to both work and daily life, for example, to develop a family budget. 
 Huge community support exists for it. 
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 Google continues to provide templates and you and others can reuse the templates. 
 It can used as collaborative sheet where more than one user can edit the sheet at the same 

time.  
 You can share sheet with link provided via share button. 
 You can analyse more quickly and with fewer mistakes thanks to helpful tools like Smart 

Fill and formula suggestions. 
 It's simple to examine data from Google Forms in Sheets, and you can embed Sheets 

charts in Google Slides and Docs. 
 
How to open spreadsheet in Google sheet 

 Click "New" in the top left corner of the Google Drive Dashboard and then choose 
Google Sheets. 

 Go to File > New in the spreadsheet window's menu bar. The interface will be as follows, 
and it will produce a blank spreadsheet 
 

 

Figure 5.116 (Google Sheet) 

 
 Click on the "Untitled spreadsheet" field in the upper left corner of the spreadsheet and 

enter the new name there. 
  A new Google spreadsheet is immediately saved in the drive's root folder when it is 

generated.  
 Click and hold the file and drag it to the desired folder to move the spreadsheet there. 
 Click on the share button on the spreadsheet to share document with open by email or 

directly by link. 
 Document can only be accessed using internet. 

 

Figure 5.117 (Share Button)
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5.31     Exercise problems  and MCQs 

 
 Explain Word processing with examples. 
 What is pivot chart? How to create a pivot chart? 
 What is Google Sheet and how to share it using internet? 
 Explain all Database Functions  
 How to perform Autosum in MS - Excel? 

 
MCQs 

1. What is the name of the region on a worksheet when a column and a row intersect? 
a) Cell 
b) Sheet 
c) Column 
d) Row 

2. Which Excel function displays the number of numerical entries? 
a) SUM 
b) AUTOSUM 
c) COUNT 
d) NUM 

3. MS Excel's ___ feature efficiently completes a series of data. 
a) Auto 
b) Auto fill 
c) Automatic 
d) Sorting 

4. When we create a new Excel file, how many sheets are there by default? 
a) 1 
b) 3 
c) 5 
d) 6 

5. Which one in Excel stood for the range B1 through E5? 
a) B1:B5 
b) B1-B5 
c) $B1:$B5 
d) B1B5 
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CHAPTER 6 

Power Point Presentation 

Microsoft created Microsoft PowerPoint, a tool for creating slide shows. For making polished 
slides, PowerPoint is an easy-to-use, versatile program. A user can create a presentation using 
PowerPoint's many views and capabilities, which can include text, images, and other media. 
Presentation packages use slides and presentations to effectively and attractively display 
information such as company proposals, reports, and plans. 

6.1    Creation of Presentation 

 To open a blank presentation, select New from the File menu, then click blank 
presentation. 

 To obtain a blank Presentation, click Create next. 
 

 

Figure 3.1(Creating Blank Presentation) 

6.2    Creation of Presentation Using Template 

 When you select New from the File menu, a box with the available templates and themes 
will appear. 

 There are many other templates to choose from in the Templates pane, which will appear 
on the right side of the window. 

 Choose any slide design from the Sample templates menu. 
 To create a new presentation with templates, click the Create button. 
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Figure 3.2 (Creating template presentation) 

6.3     Inserting And Editing Text On Slides 

6.3.1     Inserting Text Into Slides 

 Open a blank presentation and place the mouse pointer where it reads "Click to add title" 
or "Click to add text" to add text to a presentation slide. 

 

 

Figure 3.3 (Blank presentation with “click to add title”) 

 Start typing when the cursor starts to blink. 
 Follow these directions to add text to a new text box. 

o Click Text Box in the Text section under the Insert tab. 
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Figure 3.3( Text Box in Text section.) 

o Place the mouse over the location of the new text box and click. The textbox will 
show up automatically. 

o Type the text once the text box's cursor starts blinking. 
 

 

Figure 3.4 (Text Box created) 

 Text Box Movement 
o To move a text box, first click inside it and then click once more on theline that is 

dashed and surrounds the text box. 
o The text box's outline should be changed to a solid line. 

 

6.3.2.     Editing Text On The Slides 

Using the presentation, users can easily and swiftly alter previously-written slides. A slide’s 
content can be edited in a variety of ways. 

 Tying and Inserting Text 
o Simply begin typing to edit the text; the content will appear where the flashing 

cursor is. 
o The left button on the mouse or the arrow keys on the keyboard can be used to 

move the cursor. 
o The keyboard shortcuts that are described below can be used while entering text 

into slides. 
 HOME and END keys are used to start and end lines respectively. 
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 CTRL+ HOME key to go to top of the document. CTRL+ END key to go 
bottom. 

 Copy and Paste text 
o Any of the following techniques can be used to insert text into a slide. 

 Drag Text  
 Cut and Paste Text 
  Copy and Paste Text 

 Undo and Redo changes 
o Presentation allows users to undo or redo changes they have made to a slide by 

keeping track of their changes. 
o For instance, if a user unintentionally deletes a text, they can undo the action and 

recover the content by pressing Ctrl + Z. 
o If the user changes their mind and decides to maintain the deletion, they can undo 

it by pressing the Redo command (Ctrl + Y). 
o You can also reverse changes go to the Quick access toolbar, and click the Undo 

button or use the keyboard shortcut (Ctrl + Z). 
o Click the Redo button on the Quick access toolbar to undo changes or se the 

keyboard shortcut (Ctrl + Y). 
 

 

Figure 3.5 (Undo and Redo Toolbar) 

 Drag Text 
o To drag text within a single document 

 From any of the selection options, choose the section of text that the user 
wants to drag. 

 Next, move the mouse pointer to the chosen text and move the document 
while holding down the left mouse button. 

 Take the mouse pointer to the desired location. 
o To drag text between several presentation 

 Keep both papers open, then select Arrange all from the View tab. 
 Two documents will then appear after that. 
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Figure 3.6 (Display two presentation in one window by arrange all option from View tab.) 

 
o Holding down the left mouse button while dragging the selected text from one 

document to the next. 
o The Alt + Tab keys allow the user to navigate between different windows in order to 

move the content. 

6.4 Inserting and Deleting Slides in a Presentation 

6.4.1 Inserting Slide 

After the current slide or where the mouse was clicked, the next slide can be added. To add a 
slide to a presentation, there are multiple equivalent methods. 

 Select the New Slide option under the Slides panel of the Home tab. 

 

Figure 3.7 (New Slide option in slides panel) 

 Click on Insert Tab and click on New Slide. 
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Figure 3.8 ( Insert Tab) 

 Right-click on the Slides , Outline view in View Tab and choose New Slide from the 
popup menu (works in Normal view).. 

 

Figure 3.8 (Right click on option.) 

 When in Slide Sorter view in View Tab, right-click on the main work area and choose 
New Slide from the right-click pop-up menu. 

 

Figure 3.9 (Right click on Slide Sorter View) 
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6.5 Saving Presentation 

 Select Save or Save As from the File menu. 

 

Figure 3.10(Save and Save as Option in File menu) 

 The Save As dialogue box appears as a result shown in Figure 3.10. 
 Additionally, the user has the option of changing the drive and directory where they 

want to save the presentation. 

 

Figure 3.11 (Browser Window to save presentation file.) 

 Enter a file name in the Save As dialogue box, choose the desired file format from the 
Save as type list, and then click Save. 

6.6 Inserting Table, Pictures and Other Objects 

6.6.1   Inserting Table 

 Objects like tables, Excel spreadsheets, formulas, and more can be added by the user. 
 Users must choose the slide on which to put a table. 
 Click Table under the Tables category on the Insert tab. 
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Figure 3.12 (Insert Table) 

 Choose one of these. 
o Users can click after moving the pointer over the grid to choose the number of 

rows and columns. 
o Click Insert Table, then type a value in the boxes for the number of columns 

and row lists. 
 Click a cell in the table, type the text, and then click another cell to add more content. 
 After the user has typed the text, click somewhere outside the table. 
 Click the final cell in the final row, then press TAB to add a row at the end of the 

table. 
 The user must first add a table to the presentation before pasting existing content into 

the table's cell placeholders. 

6.6.2   Inserting Spreadsheet 

 Users must choose the slide on which to put a table. 
 Click Excel Spreadsheet under the Tables category on the Insert tab. 

 

Figure 3.13( Inserting Excel Speadsheet) 
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Figure 3.14( Excel sheet ) 

 Following are the step to apply formula in spreadsheet inside presentation 
o Create a Math object in a PowerPoint by double clicking on table. It will 

enable excel tab on presentation ribbon. 
o Click on Formula tab which contain function library section. You can select 

any formula same as spreadsheet in presentation also. 

 

Figure 3.15( Formula Tab) 

6.6.3    Inserting Pictures 

 To add the photographs, click the appropriate slide. 
  Select "Picture" from the Images group under the Insert tab.  
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Figure 3.16 (Pictures in Insert tab) 

 It will take the user to the Insert Picture dialogue box where they can choose the 
necessary images to insert. 

 

 

Figure 3.17(Browser Window To Select Image) 

6.6.4    Inserting Objects 

 PowerPoint can draw any shape and format their shape as per their requirement. 
 Following are two methods of drawing. 

o The user can sketch and format a drawing in the Drawing part of the Home 
tab. 

 

Figure 3.18 (Drawing section in Home tab) 

o If not, drawing is done using the Insert tab in Illustrations and Text section. 
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Figure 3.19 (Illustrations and Text section in Insert Tab) 

 Shapes 
o Use the Shapes option to design any necessary shapes. You can also edit the 

shapes you've drawn and add text boxes. 
 SmartArt  

o Use the SmartArt option to add SmartArts. You can change size and color. 
 Chart 

o Use the chart option to draw any data chart similar to excel charts using 
datasource. 

 WordArt 
o Use the WordArt in Text section option to add WordArt. 

6.6.5    Resizing and Scaling Object 

 All the modification can be done using Format tab which we be enable when you 
double click on inserted object like image, shape e.t.c. 
 

 

Figure 3.20 (Format Tab ) 

 You can alter the object’s style, colour, outline, and shape effects in different section 
povided in format tab. 

 The user can adjust the object’s height and width using size section  
 Click on the side notch of  size section shown in figure 3.21. 
 It will show you four icon click on image scaling icon which contain all the setting 

related to image scaling. 
 Following modification can be done to object 

o Resizing :  Height and Width of object can be changed. 
o Rotation: Rotation in term of angle can be given to rotate object 
o Scaling : Scaling Height and Width can be set. You can also lock aspect ratio 

or select relative and best scale. 
o Resolution : Resolution of object can be changes depending on requirement. 
o Reset Button : To set everything to default value. 
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Figure 3.21( Size Section) 

6.7 Master Slide 

Applying changes to the entire slide is easy with the slide master. There is always at least one 
slide master in a presentation, but there can be more. If you want to use a theme and background 
throughout the slide, using the slide master is a simpler and more elegant method to go about it. 

 Select the View ribbon and then the Slide Master. 

 

Figure 3.22 (Slide Master on View Tab) 

 Automatically slide master ribbon will be opened. All the slides within this master 
template will follow the settings you add on this master slide. 
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Figure 3.23 (Slide Master) 

 Using the remaining ribbons that are still usable, you can modify the master slide's theme, 
design, font attributes, title position and size, and other content. 

 Even while PowerPoint comes with a few standard slide layouts, you may also design 
your own by selecting "Insert Layout" from the Edit Master area of the Slide Master 
ribbon 

 

Figure 3.24 ( Insert Layout in Slide Master) 

 You can insert multiple slide master using Insert Slide Master in Edit Master section in 
Slide master 

 By selecting "Insert Placeholder" from the Master Layout group under the Slide Master 
ribbon, content placeholders can be added to slide layouts. You have the option of 
creating a placeholder with generic material or specifying the kind of content you want in 
that placeholder under the Placeholder dropdown. 
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Figure 3.25 (Insert Placeholder) 

 From the master slide, you may change the themes, backgrounds, and page setup for 
every slide. 

 Using the menu options provided by the layouts, you can alter individual slide layouts so 
that they differ from the master presentation. 

 

 

Figure 3.26 (Background style changed for individual slide layout) 

6.8 Presentation of Slide 

Use the View button options that are provided in the left corner of the screen to view slides in 
various ways under presentation Views Section. 
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Figure 3.27 (Presentation Section) 

 Normal View 
o Normal View, also referred to as Slide View, is the presentation's primary 

working window.  
o The slide is displayed in its entirety on the screen. 

 Outline View 
o The presentation's whole slide set is included in the outline view, organised by 

slide number.  
o Each slide's outline displays topic headings, bulleted lists, and numbered lists. 
o Each slide only displays the text that is present in the default text boxes.  
o Text boxes and graphic elements added by the user but not displayed on the 

presentations. 
 Slide Sorter View 

o PowerPoint has a window called Slide Sorter View that shows thumbnail copies 
of each slide in horizontal rows. 

o This view can be used to quickly make global changes to several slides. 
o The Slide Sorter view makes it simple to rearrange or delete slides. 

 Notes View 
o The Comments Page View displays a condensed version of a slide with a space 

for notes beneath it. 
o Every slide is made on a separate notes page. 
o These pages can be printed out by the speaker to use as a reference during his 

presentation. 
o During the presentation, the notes are not visible on the screen. 

 Reading View 
o Each slide fills the screen in reading view. 
o When in Slide Show view, the user is unable to alter slides. 
o This view allows the user to preview and present a presentation to an audience. 

6.9 Choosing A Setup For Presentation 

6.9.1   Custom Slide Show 

You may customise slide displays to change a presentation for different audiences. A distinct set 
of the presentation's slides will be shown to each audience. To create a personalised slide show: 

 Select Custom Shows by selecting the Custom Slide Show button under the Slide Show 
menu. 

 

Figure 3.28 (Custom Slide Show) 
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  At the top of the window, click New and give the custom slide presentation a name. 

 

Figure 3.29 (Create New slideshow) 

 Select the slide on the left side of the window, then click the Add button to add it to the 
custom slide show. 

 

Figure 3.30 (Add Slide to custom slide show) 

 Click OK once you've added every slide you want to feature in your personal slide show. 
 The Custom Shows window can be closed by clicking on Esc.  
 Click on Set Up Slide Show and choose the custom slide show from the pull-down menu 

under Show slides to use your personalised slide show. Only the slides you added to the 
custom slide show will appear on the screen when you play your presentation. 

 

Figure 3.31 ( Personalized slide show) 

6.9.2    Structuring Presentation 

 Use visuals to summaries crucial concepts and make them more memorable instead of 
include a lot of words in your slides.  

 By doing this, you can prevent the audience from viewing the words on the screen as you 
speak. Ensure that your text is readable.  

 Stay away from cluttered backdrops and small text.  
 Ensure simplicity.  
 There are many different animations and effects available in PowerPoint, but using too 

many of them in a single presentation might be distracting.  
 Don't utilise the built-in themes and templates. Create a unique template or theme to make 

your presentation stand out.  
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 Instead of putting complex charts on a slide, include them in your handouts. Your 
audience will have more time to study and comprehend them as a result. 

6.10   Running a Slide Show 

 A slide show can be started in one of three ways: 
o  Select Slide Show ->From Beginning. 
o In the lower right corner of the screen, select the slide show button. 
o To start the slide show, press the F5 key. 

 Press the space bar, enter, page down, right arrow, or down arrow to go to next slide 
 Press Backspace, Page Up, the Left Arrow key, or Up Arrow to return to the previous 

slide. 
 Press Esc or Alt+F4 to end the slide presentation at any time. 
 To use the pen tool to draw on the screen, follow these steps: CTRL + P 
 Press E to use the eraser. 
 Press A to hide the pointer. 

 

 

Figure 3.32 ( Slide Show) 

6.11   Transition and Slide Timings 

6.11.1   Transition 

 During a slide show, a transitional effect is utilised to introduce a new slide. 
 Click the thumbnail of the slide that contains the transition the user wants to edit in the 

Slides tab. 
 Select a slide transition effect for that slide by clicking it in the Transition to This Slide 

group of the Ribbon's Transitions tab. 
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Figure 3.33 (Transition Tab) 

6.11.2        Slide Timings 

 Click the thumbnail of the slide with the transition the user wants to adjust the time for on 
the Slides tab in Normal mode. 

 Change the duration time in the Timing groups under the Transitions tab before selecting 
it. 

 

Figure 3.34 (Timing Section on Transition Tab) 

 Use one of the following processes to determine how long will pass before the current 
slide advances to the following: 

o Select the On Mouse Click check box in the Advance Slide section of the 
Transitions tab to advance the slide when the mouse is clicked in the Transition to 
This Slide group. 

o Choose the appropriate choice from the Transition Speed drop-down selection 
under Transition to This Slide on the Transitions tab to advance the slide at a 
predetermined time. 

6.12 Automating a Slide Show 

 Click Set Up Slide Show under the Slide Show menu. 
 

 

Figure 3.35 ( Set up Section in Slide Show) 

 Pick one of the following from Show type: 
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o Select Presented by a speaker to give viewers of your slide show control over 
when the slides advance (full screen). 

o Select Browsed by an individual if you want to showcase your slide show in a 
window where viewers cannot advance the slides (window). 

o Choose Browsed at a kiosk to have your slide presentation loop until the audience 
presses the Esc button (full screen). 

 

Figure 3.36 (Set Up Show) 

6.13    Enhancing Text Presentation 
 

 

 

Figure 3.37 (Font section in Home Tab) 

6.13.1    Font Color 

 Text can be improved by selecting "font colour" from the "Home" menu. 
 The colour you have chosen will be used to show the text. 

6.13.2    Font Style 

 The "Font Style" option under the "Home" menu can be used to enhance text. 
 By choosing from the drop-down menu's options, you can alter the text's font style. 

6.13.3   Font Size 

 Use the "Font size" option under "Home" to change the font size. 

6.13.4   Text Formatting 

 You can choose italic or bold to enhance the text style. 
 Your text can also be highlighted by using the text shadow or underline options. 

Bold 

Italic 

Font Style  

Underline 
Font Color 

Font Size Font Case 
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 "Ctrl + U" is the shortcut key for underlining. 
 "Ctrl + B" is the shortcut key to make text bold. 
 “Ctrl + I” is the shortcut key to make text Italic. 

6.13.5   Font Case 

 By switching the text's case to upper, lower, mixedor you can emphasis it. 

6.14 Working With Color and Line Style 

 Follow these steps to draw shapes and fill them with colour. 
o Open Format Tab and use insert shape to draw shapes. 

 

Figure 3.38 (Insert Shapes) 

o Use the shape fill option in shape style section to fill shape with color. 
 

 

Figure 3.39 (Shape Fill option) 

 Format Background 
o Background colour enhances and beautifies the presentation. Go to the Design 

menu and choose the Color option to apply the background color. 
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Figure 3.40 (Format Background) 

 Line Style 
o Go to Insert tab click on Insert Shapes and choose the desired line styles from 

Lines option as show in figure 3.35 to add a line to your presentation. 
o The slide pane can now be used to create lines. 

 

Figure 3.41 (Insert Lines) 

6.15   Adding Sound And Video 

 Go to the Insert tab, in the media section select video or audio choices and choose the 
desired audio or video file to add a movie or audio to a slide. 
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Figure 3.42 (Media section) 

 The audio or video file you've inserted will play on your slide. 
 Follow the instructions below to play a video or audio file in your presentation. 

o Slide that includes the video or audio file should be opened. 
o From the playback menu, click play. 
o Additionally, you can modify the volume or mute the file's playback while using 

the playback menu to explore options like: Play Full Screen, Hide While Not 
Playing, Loop, etc. 

o The horizontal slider in the file displays the current playback position. 
o To change the playback volume, use the vertical slider. 
o Video files include a selectable zoom-in option in View menu. 

 

Figure 3.43 (Video Playback) 

6.16   Adding Header, Footer and Notes 

 Header and Footer 
o The Header & Footer button must be selected from the insert tab.There will be a 

dialogue box. 

 

Figure 3.44 (Header & Footer) 
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Figure 3.45 (Header and Footer Dialog box) 

o Date and Time is the first option on the menu. Two choices will be shown to you 
if the Date and Time checkbox is selected: Update automatically and Fixed.  
 When you choose Update automatically, the date and time will be changed 

each time you access the presentation,  
 When you select the Fixed option, the date and time will always be set to 

the  
 You will be presented with a selection of various date formats if you 

choose Update automatically. 
o Slide Number and Footer are the next two choices. It is typically a good idea to 

provide the slide number so that you can quickly switch between different slides 
while presenting. 

o You will have the option to create your own unique wording if you choose Footer.  
o By selecting don’t show on title slide in the last option, you can choose whether 

the header and footer are displayed on the title slide. To save the changes and 
update the slides, click Apply to All. 

o You can also add header and footer in the same way for notes and handouts for 
printing. 

 

 

Figure 3.46 (Include header and footer in Notes and Handouts) 



 Chapter 6 

209 
 

 Notes 
o To add notes, you can select the "Notes" button on PowerPoint's bottom bar. 
o To insert the speaker's PowerPoint notes onto the specific slide, click the "Click to 

add notes" area. There is no restriction on how many notes can be added. 
 

 

Figure 3.47 (Adding Notes) 

6.17 Printing Slides and Handouts 

 Go to the File tab and select Print. 
 You can also use the Ctrl + P keyboard shortcut. 

 

Figure 1.48(Print Preview) 

 The presentation’s right side now has printing options. 
 Choose the quantity of copies to be printed under Print. 
 Select the printer's name under Printer. 
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Figure 1.49 (Print Options) 

 The first drop-down list in the Settings offers four choices. 
o For printing all of the slides, select Print All. 
o Print Selection - To print a specific slide. 
o Print Current Slide - To print the currently selected slide. 
o Custom Range: To print only specific slides. 

 By entering the page number in the text field, slides can be selected or you can also give 
selective page range to print in Slide text. 

 Under print Layout, different layout can be selected to print as per your requirement . 
o Print Layout have option to print full page slides, Notes pages and outline. 
o Handout are printed and handed to the audience. For the audience's convenience, 

each handout page includes one to nine thumbnails of the slides horizontally or 
vertically. 

o Frame slide can also be given to printouts 
o Scale to Fit and High quality for printing can also be selected as shown in figure 

1.45. 
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Figure 1.50 (Handouts) 

 Print option can be set as collated and uncollated group of pages. 
 Slide can be print on black and white, greyscale or color using color option. 
 Edit Header & Footer are also present at the bottom in the options. 
 When everything has been changed, use the Print button to obtain a printed copy. 
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6.18     Exercise Problems  and MCQs 
  

 What is presentation? 
 What are Steps required to print Handouts of 2 thumbnails? 
 How to add image in presentation? 
 How to set transition and timing of slides in presentation? 
 How to draw table inside a slide? 
 What are the different type of views in presentation? 

 
MCQs 

1. A PowerPoint tool that enables users to rapidly construct a presentation is 
a) Chart wizard 
b) Animation 
c) Design 
d) AutoContent Wizard 

2. ____________is the name of a file that contains pre-made styles that can be utilised for a 
presentation. 

a) Animation 
b) Transition 
c) wizard 
d) Templates 

3. ___________ manages all of the presentation's primary slide-control activities. 
a) Control Pane 
b) Slide Pane 
c) Task Pane 
d) All of the Above 

4. ____________ is the name of a file that contains pre-made styles that can be utilised for a 
presentation. 

a) Insert option 
b) Autocontent Wizard 
c) Template  
d) None of these 

5. When introducing slides in a presentation, special effects are known as 
a) Transitions 
b) Clips 
c) Comments 
d) Annotations 
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CHAPTER 7 

Data Base Operations 

7.1 Database 

Data is a collection of discrete, unrelated raw facts having an underlying meaning. Anything can 

be considered data, including a person's name, a number, photographs, sounds, etc. 

A database is a structured collection of linked data that a user can quickly and effectively obtain. 

In conventional databases, records, fields, and files are arranged in a hierarchy. A field contains 

only one item of data. A file is a collection of records, and a record is one complete set of fields. 

A database can also be used for other processes, such as the addition, alteration, updating, and 

deletion of data, in addition to the storing and retrieval of data. It is a software application's back-

end. 

7.1.1 DBMS 

A database is created and maintained using a set of integrated tools called a database 

management system (DBMS). Database Management Systems are used to perform activities on 

databases such as adding, updating, and deleting data (DBMS). 

The basic goal of DBMS is to offer a simple and efficient way to define, store, retrieve, and 

manipulate data that is contained in the database. Database system refers to both the database and 

the DBMS software as a whole. Database management systems (DBMSs) are particularly made 

for software programs that communicate with users and other programs. 

DBMS examples include Microsoft Access, SQL Server, MySQL, and others. 

7.1.2 Microsoft Access 

Microsoft Access is a database software is available in Microsoft office. A database is a well-

organized group of documents. The telephone and address book are two examples of paper 

databases. A user can create a digital database using MS-Access. Once an MS-Access database 

has been created, users can search, edit, and retrieve information from it. 

To open Microsoft office, follow below procedure. 

 

Start → All Programs → Microsoft Office → Microsoft Access 2016 
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Figure 7.1 (Microsoft Access) 

7.1.3 Relational Database 

A relational database is a group of data objects arranged as a series of formally stated tables from 

which data can be accessed or reassembled in a variety of ways without requiring the database 

tables to be reorganised. E. F. Codd developed the relational database at IBM in 1970. The 

structured query language serves as the default user and application software interface for 

relational databases (SQL). Both interactive queries for data from a relational database and the 

collection of information for reports employ SQL statements.  

A collection of tables with data arranged into predetermined categories makes up a relational 

database. One or more data types are present in columns of each table, also known as a relation. 

There is a distinct instance of data for the given row in each category that the columns define. A 

relational database’s columnar data layout allows users to compare information quickly. The 

relational database model makes use of this uniformity to create entirely new tables from 

necessary data in the old ones. In other words, it makes use of the connections between related 

data to speed up and expand the database’s use categories 

 

It is possible to make the following intuitive correspondence. 

 Each file in a relation includes just one record type. 

 The documents are not in any particular order. 

 Each field only has one value. 

 The primary key field, also known as a composite field, is used to uniquely identify each 

record. 
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Figure 7.2 (Relational Database) 

7.1.4  Integrity 

The general completeness, accuracy, and consistency of the data are referred to as data integrity. 

The idea of data integrity makes sure that every piece of information in a database can be tracked 

down and linked to other information, making it possible to retrieve and search the information. 

There are four different types of integrity:  

 Domain integrity 

 Referential integrity 

 Entity integrity. 

 

Domain Intrigity 

According to the definitions of the physical and logical domains, a table's values must be legal in 

order to be considered to have domain integrity. The Student ID column domain could be for 

Instant explanation. Physically, it is a "numeric" data type with a length of "4" and a logical 

definition of "the range of the integer between 1000 and 4999"Therefore, only four-digit numbers 

between 1000 and 4999 would be accepted in the field. 

 

Referential Intrigity 

According to referential integrity, every value of the foreign key in R2 must match the primary 

key in some rows of R1 if R2 (the child table) contains a foreign key that matches the primary 

key and can be completely null, meaning all of the columns in that FK must be empty. For 
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instance, the table containing the referred PK must contain values that match when a new row is 

added to a database containing FK. 

Entity Integrity 

The main key column values in a base relation cannot be null, according to the Entity Integrity. 

The definition of a null value is "empty or containing no values. “A primary key is a simple 

identifier used to uniquely identify columns. A DBMS solution like Microsoft Access 

automatically ensures entity integrity by forbidding null entries in the primary key fields. 

7.2  Operations 

7.2.1    CREATING 

 Creation of Database 

A database that has no data in it is said to be blank. All the tables, forms, reports, queries, and so 

on must be created by the user. Users can design a blank template if they are unable to discover 

one that meets their needs. The first step in developing a database is creating tables. these 

directions to make a blank database 

 

o Launch MS-Access, and then select Blank Database as show in figure7.3. 

 

 

Figure 7.3(Blank Database) 

o Blank database will open with 1 table is created by default. 
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Figure 7.4 (Default Table) 

 

o Click on File option from Menu Option. 

 

 

Figure 7.5 (File Option) 

 

 As you click on save, a dialog box will appear with default table name to save the table as 

shown in figure 7.7. 
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Figure 7.8 (Save Option) 

 

 

Figure 7.9 (Table Name Dialog Box) 

o Click on Ok and it will save database in .accdb file format in default directory. 

o If you can use Save as to save File in different format and in different directory 

 

 

Figure 7.10 (Save As Option) 
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Figure 7.11 (Browser to save database file) 

 Table Creation 

MS-Access database is built on tables.MS-Access uses tables to store data. A table is a collection 

of rows and columns. Each row is known as a record, and each column is known as a field. No 

two fields may share the same name, which is a requirement for each field. Each value in a field 

corresponds to a certain type of data. Each row is known as a record. 

 

 

To add fields to a table, follow these steps:  

 Click on the "Click to Add" text box, which displays a drop-down list then, choose any data 

type from the list. 

 Enter the field's name, and MS-Access will create it. 

 User may carry on with this procedure continues until the table's fields are formed. 

 To end their entries, press Enter without specifying a field name. 

 

Table 

Records 

Fields 

Figure 7.11 (Table) 
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Figure 7.12 (Add Fields) 

 

 

 To name and save a table, Follow below instructions. 

o The Save button on the Quick Access toolbar should be clicked. The dialogue 

window for saving appears. 

o Click OK after entering the table's name. 

 

 

Figure 7.13 (Save table from Quick Access Toolbar) 
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Figure 7.14: (Table Name dialog box) 

o To construct a new table using Design view 

o Click Table Design in the Tables group after activating the Create tab.  

 

 

Figure 7.15 (Table Design View) 

 

o Using the Design view, create a new table  

o In the Field Name field, provide the first field's name. 

o Hit the Tab key. 

o When the user clicks on the Data Type field, a down-arrow will display. 

o Choose a data type next. 

 

 

Figure 7.16 (Field Name & Data Type) 

o If the newly created column is the primary key, select the Primary Key option. A key 

appears left to the field name. 
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Figure 7.17 (Primary Key) 

7.2.2     DROPPING 

 In the Datasheet view, delete a field. 

o Double-click the table from which you wish to remove the field in the 

Navigation Pane. The Datasheet view of the table is displayed. 

o Choose the field or column that the user wants to remove. 

o Click the Delete Field option on the right click menu.  

o Alternately, click the Delete button under the Add & Delete group on the 

Fields tab. then select yes to eliminate the column for good. 

 Removing a record from the Datasheet view 

o The same procedure must be used to remove a record from the datasheet view. 

o Choose the row (record) that the user wants to delete. 

o Click the Delete Record option in the context menu or hit the DELETE key. 

o Then select agree to permanently erase the record. 

 Remove a relationship in a table. 

o Close the tables involved in the table relationship if they are open. A table 

relationship between open tables cannot be deleted by the user. 

o Then, in the navigation pane, right-click the table name and select the delete 

option. 

o To delete a table, select yes in the warning dialogue box. As a result, MS-

Access permanently deletes that table. 

7.3  Manipulating Table Structure 

An MS-Access table can be modified, have data manually entered into it, or have data imported 

from other applications like Excel after it has been created. 
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7.3.1 Enter Records 

 Data entry for an AutoNumber field. 

o Pressing the Tab key causes MS-Access to make an automatic input into the 

AutoNumber field whenever the user enters data into another field in the record. 

 To input information into fields with a lookup list 

o When a user clicks in a field, a down arrow appears. 

o Click the desired entry, then select it by pressing the Tab key. 

 

 

Figure 7.18 (Lookup List) 

 

 To enter information into the Yes/No column, choose the Yes checkbox and leave the No 

checkbox empty. 

 

 

Figure 7.19 (Checkbox) 

 

 Type the date into the field designated for entering data. 

o  A calendar will show to the left of the field. You can also choose the date from 

there. 

o  To get to the previous month, click the left arrow at the top of the calendar.  

o To advance to the following month, use the right-arrow at the top of the calendar. 

Click the appropriate date when the user reaches the correct month. 
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Figure 7.20 (Data Picker) 

7.3.2 Modify Table 

 Insert column 

o A column is inserted before the chosen column using the insert option. 

o The user can insert a column by right-clicking the desired column head.  

o A menu appears. Click on the Insert field button. 

 

 

Figure 7.21 (Insert Field) 

 

 Move a column 

o Right click on the field you want to move and select unfreeze all column to move 

column. 

o Move your cursor over the space between the column label and the horizontal line. 

A four-sided arrow appears as the user's mouse pointer. 

o Click and drag the field to the new place while holding down the left mouse 

button. There is now a dark line at the new place. 
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o Let go of the left mouse button. The column is moved using mouse. 

 

Figure 7.22 (Unfreeze fields) 

 

 Delete column 

o The Delete option eliminates all of the columns' data forever. After deleting a 

column, the user cannot undo it. 

o The user can delete a column by right-clicking the desired column head. You see a 

menu. 

o To delete a field, click it. 

o Because selecting the delete option will permanently remove the records, a 

warning dialogue box will display. To delete, select yes. 

 

 

Figure 7.23: Delete Field 

 



  Chapter 7 

226 
 

 

Figure 7.24 (Click yes to delete column) 

 Select Columns. 

o A column or row must be selected for any operation to be performed on it. 

o Click the column head to choose a column. 

o To select several columns, click and drag a column head. 

 Select Rows  

o Click the empty space to the left of the row to choose a row. 

o Click and drag in the empty space to the left of a row to select multiple rows. 

o Click the Select All button in the upper-left corner of the table to select the entire 

thing. 

 Removing a Record 

o Select the record the user wishes to delete in order to delete it. 

o Switch on the Home tab. 

o Within the Records group, select Delete. Or, use the Delete option on the right-

click menu. There is a prompt. 

o Press the Yes button. 

 Import table from MS-EXCEL 

o Data can be imported into MS-Access from Excel using the Excel Spreadsheet 

Wizard. 

o To import information from Excel. 

o Set the External Data tab to active. 

o In the Import section, select the Excel button. Excel's Get External Data Wizard 

for Spreadsheets emerges. 
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Figure 7.25 (Import Excel) 

 

o When you click Browse, the File Open window displays. 

o The user should find the spreadsheet they want to import. 

o Simply press the Open button. The File Name displays the path of the chosen file. 

 

 

Figure 7.26 (Open File) 

o Click "OK." MS Access advances to the following page. 

o Choose Show Worksheets or Show Named naming a range of ranges to import. 

 

Figure 7.27 (Import Spreadsheet Wizard) 
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o Select the named range or worksheet the user wants to import. 
o Select Next. MS Access advances to the following page. 
o In the Field Name field, provide the column heading for the MS-Access table. 
o Select a data type. 
o Determine whether the field has to be indexed and, if so, choose the type of index. 
o For each column that the user does not want to import, check the Do Not Import 

Field box. 

 

Figure 7.28 (Specify about field in wizard) 

o Select Next. MS Access advances to the following page. 
o Click to select the appropriate radio button. 
o Click the Let MS-Access add Primary key option if the user wants MS-Access to add 

the primary key. 
o If the user wants to create a primary key, they should click Choose My Own Primary 

Key or choose the field they wish to use as the key with the down arrow, and then 
click OK. 

 

Figure 7.29 (Choose primary key) 
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o If a user decides not to add a primary key, they should select the No Primary Key 
option. 

o Enter the import table's name. 
o Just press Finish. MS Access advances to the following page. 
o To import the table, click Close at the end. 
o The Excel worksheet is now imported into the Access table by MS-Access. 

 

 

Figure 7.30 (Finish Import) 

 

 

Figure 7.3 ( Excel Sheet on Access) 

7.4  Manipulation of Data 

7.4.1 Query 

A query can be used by the user to view a subset of data or to provide information about their 

own data. For instance, a user can design a query that simply shows the student's first name, last 

name, and email address if they only want to examine a list of student names and email addresses 

without seeing addresses or other data. 

Open Query and tables in Design View 

 To launch Query Design View and open queries .Turn on the Create tab. 
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Figure 7.32 (Query Wizard Option) 

 In the Queries group, select the Query Design button. The dialogue box for the show table 
opens. 

 If the user wants to base their query on tables, they should enable the Tables tab. If they 
want to base their query on queries, they should activate the Queries tab. If they want to 
base their query on both tables and queries, they should active the both tab. 

 Select the table or query on which the user wants to base their query by clicking. 
 Select Add. The window displays the table. 

 

 

Figure 7.33 (Show Table) 

 
 

 Click to select the following table or query as the basis for the user's inquiry. 
 Keep selecting tables or queries until the user has selected all of the tables and queries 

they intend to utilise. 

Display All Records and All Fields 

 In the Query Design view, open a table or query. 
 Select by clicking the downward pointing arrow in the first field on the Field row i.e. the 

option tablename.*  
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 On the table line, the table name is displayed. 
 Select "Run" from the menu. 
 The fields and records for the database are all retrieved through MS-Access and presents 

them in Datasheet view from a table. 
 

 

Figure 7.34 (Datasheet View) 

 

 

Figure 7.35 (Query Output) 
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Sort a Query 

The rows that a user retrieves might be sorted in either ascending or by selecting the appropriate 
option on the Sort row in the Query design view. 

Steps to carry out a sort. 

 A table or query can be opened in the Query Design view. 
 To obtain them, select the field names. 
 Click the down arrow next to the field, then select Ascending or Descending. 
 Select "Run" from the menu. MS-Access pulls up the chosen columns and displays the 

rows in the user-specified order. 
 

 

Figure 7.36 (Sort Query) 

  



  Chapter 7 

233 
 

 

Figure 7.37 (Query Output) 

Save a Query 

 A user can save query. 
 To save query 

 

Figure 7.38 (Save Query) 
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 The Save button on the Quick Access toolbar should be clicked. Access saves queries 

unless they are saved for the first time. 
 In the Save As dialogue box, type the name of the query. 
 Click "OK." The query is saved by MS-Access. The query can now be run in MS-Access 

by using the Navigation pane. 
 

7.4.2 Data Entry Forms 

MS-Access forms resemble paper forms in many ways. You can enter, update, or display data 
using them. Their foundation is in tables. The user can select the format, the hierarchy, and the 
fields to display while using a form. 

How to Use the Form Button 

MS-Access has the ability to generate a variety of forms automatically. For instance, when a user 
clicks the Form button on the Create tab, MS-Access creates a form with all the fields from the 
chosen database. 

If a table and another table or query have a one-to-many relationship, MS-Access produces a 
stacked form for the main form, with the records presented in a column in a table as well as the 
associated table's datasheet.MS-Access does not create datasheet work if there are multiple tables 
with a one-to-many relationship. 

 

 

Figure 7.39 (Form Option) 

 
 Navigate to the Navigation pane. 
 Click the table or query the user wants to use as the basis for their form. 
 Turn on the Create tab. 
 In the Forms group, click Form. A form is created by MS-Access. 
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Figure 7.40 (Form) 

To save a form 

 Click the Save button on the Quick Access toolbar to save a form.  
 Unless the user is saving for the first time, MS-Access saves the form.  
 The Save As dialogue box occurs when a user saves something for the first time. 
 Enter the name the user wants to use on the form. 
 Click "OK." The form is saved by MS-Access. Now, the user can use the Navigation pane 

to access the form. 

 

Figure 7.41 (Save Form) 

 

Form 

Navigation bar 
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Modify a Form 

When the user creates the form, it opens in Layout view and the user can modify the form. 

 To resize the  field  
o Click and drag one side of the box to change the width of the box.  
o Click the top or bottom of the box and drag to change the height of the box.  

 To move the datasheet  
o  Click the datasheet to select it.  
o  Click and drag the 4-way arrow in the upper right corner to move the datasheet.  

 To resize the datasheet  
o Click the datasheet to select it.  
o Click on the side of the data sheet and drag to change the width.  
o Click the top or bottom of the data sheet and drag to change the height.  

 To apply Autoformat 
o Activate the Format tab.  
o Click the [Shape Fill] button and select any color as the background color.  
o Users can also insert background images from the gallery.  
o To change the font color, style and size, click the Select All button and then 

change appropriately.  
o Then go to the form view to see the complete structure of the form  

 Rename the form  
MS-Access uses the form name as the title by default while the user creates the form To 
do. The user can change the title.  

o Activate the Format tab.  
o Click the [Title] button.  
o Enter a new title.  

 Add  date and time  
o Users can easily add date and time to the form.  
o Activate the Format tab.  
o Click the [Date and Time] button. The Date and Time dialog box is displayed.  
o Select the date and time to display on the form. 

7.4.3 Reports 

Reports group and condense data for online or printed viewing. All of the selected records are 
shown in a detail report. 

Reports Creation 

The user can include summary information in a report, including totals, counts, and percentages. 
A summary report summaries the data rather than listing the selected records and just totals, 
counts, percentages, or other summary data are presented. 

With the help of the various report production tools in MS-Access, users can create both reports 
with both detail and summaries rapidly. 

 Pressing the Report button on Create tab. 
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 The Report button generates a straightforward report that lists the data of the chosen table 
or query with columns. 

 You can also choose different view from view option according to your requirement. 
 You can save report using CTRL+ S and give report name. 

 

 

Figure 7.43 (Report Option) 

 

 

Figure 7.44 (Generated Report Design View) 

7.4.4     Using Report Wizard 

A report can also be created by a user using the Report Wizard. More options are available when using the 
Report Wizard than when using the Report button. The user can select fields and tables, group data, sort 
data, and summaries the information, pick a format and orientation, use a style, and give their report a 
title. 

To use the Report Wizard to build a report. 

 Turn on the Create tab. 
 In the Reports group, click Report Wizard. The Report Wizard is displayed. 
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Figure 7.45 (Report Wizard) 

 If there is a relationship between the tables or queries, the user can use fields from several tables 
and/or queries when utilising the Report Wizard. 

 

Figure 7.46 (Selected Fields) 

 Choose the table from which the user wants to pick fields by clicking the down arrow next to the 
Table/Queries field. 

 Click a field, then click the single or double right arrows to choose one field, all the fields, or 
none of them. Likewise, click a field, then click the single or double left arrows to deselect one or 
more fields. 

 Choose Next to go to next page of the Report Wizard is reached. 

Groups 

 Using the Report Wizard, a user can group data. 
 When a field is grouped, all of its values are placed in a single group based on the field's value. 



  Chapter 7 

239 
 

 

Figure 7.47 (Groups) 

 Click the field you wish to use to group your data into. If a user is only picking data from a single 
table, they could not see this page of the wizard. 

 Choose Next. The next page of the Report Wizard is reached. 
 To group by a field, click it. 
 To choose a field, click its right arrow; to deselect it, click its left arrow after selecting it. The 

groupings can be rearranged using the up and down arrows. 
 Choose Next to go to next page of the Report Wizard is reached. 

Sorting 

 Using the Report Wizard, a user can construct up to four levels of sorting. 
 Select the field you wish to sort by clicking the down arrow. 
 To select ascending or descending order, click the button. Toggle between Ascending and 

Descending by clicking the button. Up to four levels of sorting are possible. 

 

Figure 7.48 (Sorting) 

 Choose Next to go to next page of the Report Wizard is reached. 

Orientation 

 The layout and orientation of the user's report are also customizable. 
 Where each field appears on the page is determined by the layout. 
 There are three layout choices offered by MS-Access: Columnar, Tabular, and Justified. 
 The report's orientation controls whether MS-Access creates it in portrait or landscape mode. 
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Figure 7.49 (Layouts) 

 To choose a layout, click. 
 Choose a page orientation by clicking. 
 If a user wants all the fields to fit on one page, they should select the option to Adjustthe Field 

Width So All Fields Fit on a Page. 

Title 

 The user can give their report a title on the Report Wizard's final page. The title can be seen on 
the Navigation pane and at the top of the report. 

 Enter the report's title in the text box. 
 To finish, click. Their report is created, saved, and opened in Layout view using MS-Access. 

 

Figure 7.50 (Set Title) 

 

Figure 7.51 (Report Example) 
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7.4.5      Modify Report 
A report can be modified by the user after it has been created by adding groups or sorting, adding 

fields, changing labels, and doing many other actions. The user has access to the Report view, 

Layout view, Design view, and Print Preview views of a report by right clicking on report. 

 Switch to the layout view 

 Or Open the Home tab, then select the View option. You see a menu. 

 Press Layout View.  

 

Figure 7.52 (Layout View) 

Size change 

 On the field or label, click. It now has a border around it. 

 To make it wider, click one of the border's sides and drag outward. To make the border 

narrower, click one of the sides and drag it inward. 

 

Add Group or sort 

 To create a group or sort, use the Group & Sort button on the Design tab. 

 

Figure 7.53 (Group & Sort) 

 Select the field by which users wish to group by clicking Add a Group. 

 The field is grouped and sorted by MS Access. 

 Select the field on which the user wants to sort by clicking Add a Sort. Fields are sorted 

by MS Access. 

 



  Chapter 7 

242 
 

 

Figure 7.54 (Add group or Sort) 

Add Field 

 Launch the layout view of the report. 

 Turn on the Design tab. In the Tools group, select the Add Existing Fields button. A 

window called Field List emerges. 

 

Figure 7.55 (Add Existing Fields) 

 If the field the user wants to add is missing, click Show All Tables. 

 Drag the field the user wants to put onto their report after clicking it. 

 On the report, there is a thick line. The field appears before the line in MS Access. 

 Drag the field into the detail section if the user wants it to show up there. 

 

 

Figure 7.56 (Adding field) 

Remove a field 

 Launch the layout view of the report. 
 To delete a field, click on it. 
 Hit the Delete key. The field is removed by MS Access. 
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Move Column 

 Open the report in Layout view to move a column. 
 Click on the column heading. 
 Move the column by dragging it. The column is moved to the new place by MS-Access. 

Edit Title 

 Open the report in Layout view to edit the title. 
 Click twice in the Title field. 
 To pick the current title, click and drag. 
 Write a fresh title. 
 Click somewhere besides the Title field. The title is modified by MS-Access. 

Modify the Field label 

 Launch the layout view of the report. 
 Click the field label twice. 
 To choose the label name, click and drag. 
 Write the name of the new label. 
 In any location not on the label, click. The field label was modified by MS-Access. 
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7.5 Exercise Problems  and MCQs 
 

 What is database and how to open MS EXCEL 2016? 
 What is relational database and intrigity of database? 
 How to delete a table and database from MS-ACCESS? 
 Describe query manipulation in MS-Access. 
 Explanation of MS-Access forms and how they are used. 
 Define reports and its modification in Microsoft Access. 

MCQs 

1. Which key can uniquely identify a table in database? 
a) Rows 
b) Primary Key 
c) Candidate Key 
d) Column 

 
2. What is full form of DBMS? 

a) Data Manage Base Software 
b) Database Management Software 
c) Database Software 
d) Database Manage Software 

 
3. A computerised filing system known as a ________ is used to arrange and preserve a collection of 

information for later use. 
a) Database 
b) Spreadsheet 
c) Document 
d) Worksheet 

 
4. In a datasheet, what does each column represent? 

a) Record 
b) Field 
c) Database 
d) Point 

 
5. In a datasheet, what does each row represent? 

a) Field  
b) Record 
c) Database 
d) Point 
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CHAPTER 8 

Introduction to Internet and WWW 

8.1  Basics of Computer Networks 

Computer network is an interconnection of two or more computing devices using either wire or 

wireless media. In every computer network, there are hardware and software that connects 

computers and tools. The essential components of computer networks are switches, routers, Hub, 

servers, printer, PC, Firewall, mobile, tablet etc. 

 

Figure 8. 1 (Components of Computer Networks) 

 

8.2  Local Area Network (LAN) 

The Local Area Network (LAN) is a link of two or more computing devices such as cables, 

switches, routers, servers etc., share a common Ethernet cables and Wireless link to a server, 

limited in a small geographical area. LAN connection is limited to a building, office or home. It 

is the most fundamental or foundation network connection of global network. The applications of 

LAN are Wi-Fi, Intranet etc. 
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Figure 8. 2 (Local Area Network) 

8.3  Wide Area Network (WAN) 

The wide area network (WAN) is a network of computing devices covers a large geographical 

area. By using WAN, we can transmit file such as image, video and audio etc. over a long 

distance and among different LANs and MANs. The applications of WAN include Internet, 

ATM machines etc. 

 

Figure 8. 3 (Wide Area Network) 

 

8.4 Network Topology 

The physical or logical arrangements or connection of computing devices or nodes used in a 

network is known as Network Topology. There are basically five types of network topology 

exists, which are as follows: 

 Bus topology 

 Star topology 

 Ring topology 

 Mesh topology 
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 Hybrid topology 

8.4.1 Bus Topology:  

Bus topology is a type of network topology in which all the computers or computing devices are 

connected by a single cable. Hence, it is also termed as a line topology.  

 

Figure 8. 4 (Bus Topology) 

 

Advantages of Bus Topology: 

 It is simple, reliable, scalable and easy to install and understand. 

 It requires minimum length of cable to connect the computers together. So, it is less 

expensive. 

Disadvantages of Bus topology: 

 It is difficult to identify the problem in case of network failures. 

 It is not advisable for large networks. 

 If the main cable got damaged, the network may fail or split. 

 If there are more devices in this topology, the speed may slow down. 

8.4.2 Star Topology 

Star topology is a type of network topology in which all the computing devices or nodes are 

connected to a switch or hub. 
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Figure 8. 5 (Star Topology) 

 

Advantages of Star Topology: 

 It is easy to add or remove devices in this topology. 

 It is more reliable. 

 Troubleshooting is more efficient. 

 If one or more link may fail, then it will not disturb the other links. 

 High transmission rates may achieve in this topology. 

Disadvantages of Star Topology: 

 If the switch/hub may fail, the whole network gets damaged. 

 It is expensive topology compare to bus topology. In this topology, each device is directly 

connected to switch or hub, so it requires more length of the cable and hence, expensive. 

8.4.3 Ring Topology 

Ring topology is a type of network topology in which all the computing devices or computers are 

connected to each other by a single cable in such a manner that data transfer take place in one 

direction from one node to another node. Hence, this topology is also known as loop topology. 
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Figure 8. 6 (Ring Topology) 

 

Advantages of Ring Topology: 

 It supports very high data transmission rates. 

 Each device does not depend on the central switch or hub, as each device transmit data to 

and from itself. 

 It requires less cable connection and hence, reliability increases. 

Disadvantages of Ring Topology: 

 It is difficult to change the structure of network. 

 If any device or computer stop working, then network may fail or stop working. 

 

8.4.4 Mesh Topology 

Mesh topology is a type of network topology in which each and every computer are connected 

together. Mesh topology is mainly used for wireless networks. Examples: Internet 
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Figure 8. 7 (Mesh Topology) 

Advantages of Mesh Topology: 

 It is easy to troubleshoot. 

 It is more reliable than others. If any of the device or node may fail does not affect the 

others. 

 Data transmission is very high. 

Disadvantages of Mesh Topology: 

 It is costly, due to large number of connected devices. 

 The efficiency of the topology reduces due to more number of redundant connections. 

 It is difficult to maintain and manage. 

8.4.5 Hybrid Topology 

The hybrid topology is a type of network topology in which one or more different type of 

network topology is present to connect the computing devices. 

 

Figure 8. 8 (Hybrid Topology) 

Advantages of Hybrid Topology: 
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 Reliable: In this type of topology, fault in part of network does not affect the other part of 

the topology. 

 Scalable: Size of the network can be easily increased without affecting the other part of 

the networks. 

Disadvantages of Hybrid Topology:  

 It is very difficult to design the architecture of such topology. 

 The cost of hybrid topology is high due to hub and lots of cables. 

8.5 Transmission Media 

Transmission media is a pathway that carries the information from sender to receiver. We use 

different types of cables or waves to transmit data. Data is transmitted normally through 

electrical or electromagnetic signals. An electrical signal is in the form of current. An 

electromagnetic signal is series of electromagnetic energy pulses at various frequencies. These 

signals can be transmitted through copper wires, optical fibers, atmosphere, water and vacuum 

Different Medias have different properties like bandwidth, delay, cost and ease of installation and 

maintenance. Transmission media is also called Communication channel. 

 

8.5.1    Types of Transmission Media: 
In telecommunications, transmission media can be divided into two broad categories: guided and 

unguided. Guided media include twisted-pair cable, coaxial cable, and fiber-optic cable. 

 

Figure 8. 9 (Types of Transmission ) 
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8.6 Cables 

8.6.1 Straight Cable:  
It is used to connect devices having different function. For Example: 

 Connecting a router to a hub or switch.  

 Connecting a server to a hub or switch.  

 Connecting workstations to a hub or switch.  

8.6.2 Cross Cable: 
It is used to connect devices having same functions or roles. For example:  

 Connecting hubs to switches.  

 Connecting a hub to another hub. 

 Connecting PC to PC 

8.7 IP address 
IP address stands for “Internet Protocol address.” The Internet Protocol is a set of rules for 

communication over the internet, such as sending mail, streaming video, or connecting to a 

website. An IP address identifies a network or device on the internet. 

 

8.7.1    Types of IP address 
There are two versions of IP addresses, which are as follows: 

 IPv4 (Internet Protocol version 4) 

 IPv6 (Internet Protocol version 6) 

IPv6 is the new version of Internet Protocol, which is way better than IPv4 in terms of 

complexity and efficiency. The main difference between IPv4 and IPv6 is the address 

size of IP addresses. The IPv4 is a 32-bit address, whereas IPv6 is a 128-bit hexadecimal 

address. 
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8.7.2     Difference between IPv4 and IPv6: 

S. No. IPv4 IPv6 

1. 
IPv4 has a 32-bit address length IPv6 has a 128-bit address length. 

2.  
Address representation of IPv4 is in 

decimal. 

Address Representation of IPv6 is in 

hexadecimal. 

3.  
It can generate 4.29×109 address 

space. 

It can produce 3.4×1038 address space. 

4. 
IPv4 has a header of 20-60 bytes. IPv6 has header of 40 bytes fixed . 

5. 
IPv4 supports VLSM(Variable Length 

subnet mask). 

IPv6 does not support VLSM. 

 

6. 
Example of IPv4:  192.168.10.164 Example of IPv6: 

2001:0000:3238:DFE1:0063:0000:0000:FEFB 

Table 8. 1 (Difference between IPv4 and IPv6) 

8.8 MAC address 

MAC stands for Media access control and it is also known as Physical address or hardware 

address. It is the physical address of the device, which uniquely identifies each device on a given 

network. To make communication between two networked devices, we need two addresses: IP 

address and MAC address. It is assigned to the NIC (Network Interface card) of each device that 

can be connected to the internet. 

 

 It is globally unique; it means two devices cannot have the same MAC address.  

 It is 12-digit, and 48 bits long, out of which the first 24 bits are used 

for OUI(Organization Unique Identifier), and the last 24 bits are for NIC/vendor-specific. 

This address is represented in a hexadecimal format on each device. 

 For example: 00:0a:95:9d:67:16 

 It works on the data link layer of the OSI model. 

 It is provided by the device's vendor at the time of manufacturing and embedded in its 

NIC, which is ideally cannot be changed. 
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 The ARP (Address Resolution protocol) protocol is used to associate a logical address 

with a physical or MAC address. 

8.9 Concept of Internet 

8.9.1 What is Internet? 
The Internet is essentially a global network of computing resources. You can think of the Internet 

as a physical collection of routers and circuits as a set of shared resources. Internet is a collection 

of interlinked computer networks, connected by copper wires, fiber-optic cables, wireless 

connections, etc.  

 

As a result, a computer can virtually connect to other computers in any network. These 

connections allow users to interchange messages, to communicate in real time (getting instant 

messages and responses), to share data and programs and to access limitless information. With 

the Internet, it's possible to access almost any information, communicate with anyone else in the 

world, and do much more. 

 

Figure 8. 10 (Internet and www) 

8.9.2 Applications of Internet 
Some of the basic applications to Internet users are –  

 Email − A fast, easy, and inexpensive way to communicate with other Internet users 

around the world.  

 Telnet − Allows a user to log into a remote computer as though it were a local system.  

 FTP − Allows a user to transfer virtually every kind of file that can be stored on a 

computer from one Internet-connected computer to another.  
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 World Wide Web (WWW) − A hypertext interface to Internet information resources. 

8.10 WWW (World Wide Web) 
WWW stands for World Wide Web. It refers to all the public websites or pages that users can 

access on their local computers and other devices through the internet. These pages and 

documents are interconnected by means of hyperlinks that users click on for information. This 

information can be in different formats, including text, images, audio and video. 

In simple terms, The World Wide Web is a way of exchanging information between computers 

on the Internet, tying them together into a vast collection of interactive multimedia resources. 

8.11 Web Address and URL 
The web address was developed by Sir Tim Berners-Lee and the URL working group of IEFT 

(Internet Engineering Task Force) in the year 1994. It is a name that points to the location of a 

particular web page in the internet world. It can be the address of anything like the address of a 

particular file, directory, photo, video, etc. Every web page on the internet has a unique web 

address, with the help of which the user accesses those web pages. It is the same as the address of 

your house or school or any place on this planet. Web Address is also known as URL i.e. uniform 

resource locator. 

 

 For example: 

https://www.nielit.gov.in 

Here, https is the scheme, www.nielit.gov.in is the domain name and in combination, it is 

known as the web address or URL of NIELIT website. 

8.12 ISP and role of ISP 
ISP stands for Internet service provider. It is a company or entity that organizes the internet 

connection services and other related services. Most telephone companies are Internet service 

providers. They provide services such as connection to the Internet, domain name registration, 

and hosting. 

 

ISP has a network both domestically and internationally so that the customer or the user of the 

connection provided by the ISP to connect to the global Internet network. Here in the form of 

network transmission medium that can stream data can be either wired (modem, leased line, and 

broadband), radio, etc. 

https://www.nielit.gov.in
http://www.nielit.gov.in
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8.12.1 Role of ISP: 

 As a medium that provides services to connect to the internet. 

 Connect customers to the nearest Internet gateway. 

 Provides a modem for dial-up. 

 Connecting an information service to a user of the World Wide Web (www). 

 Allows a user to use the services of electronic mail (e-mail). 

 Allows a user voice conversation via the internet. 

 Gave place to the homepage. 

 ISP do protection from the spread of the virus by applying antivirus systems for his 

customers. 

8.13 Internet Protocol 

The Internet Protocol (IP) is a protocol, or set of rules, for routing and addressing packets of data 

so that they can travel across networks and arrive at the correct destination. Data traversing the 

Internet is divided into smaller pieces, called packets. IP information is attached to each packet, 

and this information helps routers to send packets to the right place. Every device or domain that 

connects to the Internet is assigned an IP address, and as packets are directed to the IP address 

attached to them, data arrives where it is needed. 

Once the packets arrive at their destination, they are handled differently depending on which 

transport protocol is used in combination with IP. The most common transport protocols are TCP 

and UDP. 

8.14 Modes of Connecting Internet 

8.14.1 Mobile 
Many cell phone and smartphone providers offer voice plans with Internet access. Mobile 

Internet connections provide good speeds and allow you to access the internet. 

 

8.14.2  WiFi Hotspot 
Wifi Hotspots are sites that offer Internet access over a wireless local area network (WLAN) by 

way of a router that then connects to an Internet service provider. Hotspots utilize 

WiFi technology, which allows electronic devices to connect to the Internet or exchange data 

wirelessly through radio waves. Hotspots can be phone-based or free-standing, commercial or 

free to the public. 
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Figure 8. 11 (WiFi Hotspot) 

8.14.3  LAN cables 

Cable Internet connection is a form of broadband access. Through use of a cable modem, users 
can access the Internet over cable TV lines. Cable modems can provide extremely fast access to 
the Internet, making a cable connection a viable option for many. 
 

8.14.4  Broadband 

This high-speed Internet connection is provided through either cable or telephone companies. 

One of the fastest options available, broadband Internet uses multiple data channels to send large 

quantities of information. The term broadband is shorthand for broad bandwidth. Broadband 

Internet connections such as DSL and cable are considered high-bandwidth connections. 

Although many DSL connections can be considered broadband, not all broadband connections 

are DSL. 

 

8.14.5  USB Tethering 

When the mobile internet connection is shared with a connected computer or laptop using 

physical USB data cable then it is called USB Tethering. It gives a high-speed connection while 

sharing the internet between mobile devices and connected computer systems, it is because 

Wired connection is quite stronger than Wireless LAN connection. 



  Chapter  8 
 

258 
 

 

Figure 8. 12 (USB Tethering) 

 

8.15 Identifying and uses of IP/MAC/IMEI 

8.15.1 MAC (Media Access Control Address) 

MAC address is the address that uniquely identifies a node on the network. It is also called the 

physical address, or the Burnt-In address, or the software address. The MAC address is provided 

by the manufacturer of the NIC (Network Interface Card). It is embedded into the hardware and 

remains constant for that device. MAC is a 48 bits address.  

 

How to find IP Address and MAC Address of a network card: - 

 Press the Window Start key to open the start menu 

 Type cmd and press enter to launch the command prompt.  

 Type ipconfig/all at the command prompt to check the network card settings. 

 The MAC address and IP address are listed under the appropriate adapter as Physical 

address and IPv4 address. 

 

8.16  IMEI (International Mobile Equipment Identity) Number  

Every mobile phone has an International Mobile Equipment Identity (IMEI) that identifies our 

phone. If our phone is stolen, we can call our network provider and have them blacklist the 

device using its IMEI number, which should make it useless to the thief, even if they change the 

SIM card.  
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8.16.1 How to identify the IMEI number?  

To identify the IMEI number of ios user follow these steps:  

1. Start the Settings app.  

2. Tap "General," and then tap "About."  

3. Scroll to the bottom of the page, and you'll see the IMEI number. 

 4. If we want to record the IMEI number error-free, tap and hold the IMEI number for a second 

or two until we see the Copy bubble appear.  

To identify the IMEI number of Android Phone user follows these steps: 

 1. Open the Settings app on our Android phone.  

2. Scroll down and tap on About Phone. 

 3. Scroll down and we will find the number under IMEI. 

8.17 Web browser 

A web browser, or browser for short, is a computer software application that enables a person to 

locate, retrieve and display content such as webpages, images, video, as well as other files on the 

World Wide Web. 

Examples: Internet Explorer, Google Chrome, Safari, Mozilla Firefox etc. 

 

8.18 Popular Web Browsers 

8.18.1 Internet Explorer 
Internet explorer (formerly Microsoft Internet Explorer and Windows Internet Explorer 

commonly abbreviated IE or MSIE) is a series of graphical web browsers developed by 

Microsoft. Internet browsing software manufactured by Microsoft Corp. and included on 

computers with their Windows operating system. 
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Figure 8. 13 (Popular Web Browsers) 

8.18.2  Microsoft Edge 

Microsoft Edge is an internet browser made by Microsoft, which is installed by default on all 

new Windows computers. Edge was made to replace Internet Explorer, and runs faster and with 

more features. It was first released for Windows 10 and Xbox One in 2015, then for Android and 

iOS in 2017, and for macOS in 2019. Edge includes integration with Cortana and has extensions 

hosted on the Microsoft Store. 

8.18.3  Google Chrome 

Google Chrome is a cross-platform web browser developed by Google. It was first released in 

2008 for Microsoft Windows, and was later ported to Linux, macOS, iOS, and Android. The 

browser is also the main component of Chrome OS, where it serves as the platform for web apps. 

8.18.4  Mozilla Firefox 

Mozilla Firefox, or simply Firefox, is a free and open source web browser developed by the 

Mozilla Foundation and its subsidiary, Mozilla Corporation. Firefox uses the Gecko layout 

engine to render web pages, which implements current and anticipated web standard. 

8.18.5  Opera 

Opera is a freeware web browser for Microsoft Windows, Android, iOS, macOS, and Linux 

operating systems, developed by Opera Software. Opera is a Chromium Blink layout engine. It 

differentiates itself because of a distinct user interface and other features.  
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8.19 Exploring the Internet  

8.19.1  Surfing the Web  
Surfing is the act of browsing the Internet with a specific content about which we know that it 

will be available at particular location. In other words, if we know the address of the website then 

we enter it into directly in the address bar of the browser. For example, if we know the web 

address of NIELIT, then we browse the website directly by entering its URL (which is 

www.nielit.gov.in) into browser.  

 

Steps for surfing the web:  

Step 1: Launch any browser available (for e.g. Google chrome) in the computer.  

Step 2: Type the address (URL) of the web page (for example, www.nielit.gov.in) in the address 

field of the web browser. 

Step 3: Click on go to arrow (forward arrow) from address field or hit enter. The specific website 

will open with its content (The browser automatically attaches http:// into the web address as it is 

the default protocol of most of the browsers). 

 

Figure 8. 14 (Web surfing) 

 

8.20 Popular Search Engines  
A search engine is a software program available through the Internet that searches documents and 

files for specific keywords entered by user and returns the results of any files containing those 

keywords.  

The popular search engines are Google, Bing, Yahoo, Ask, Excite, DuckDuckGo etc.  

 

 

 

http://www.nielit.gov.in)
http://www.nielit.gov.in)
http://


  Chapter  8 
 

262 
 

8.21 Searching on Internet  
Search engines provide a great variety of search results of any topic over internet. By using 

search engines, we can search any topic of interest or found a particular website even if we don't 

know the address of the website. If a user searches for a particular string, there are millions of 

results visible to the user that opens various options to found the content of the user's choice.  

 

Steps to search over Internet:  

Step 1: Open any browser (for example internet explorer) and enter the address of search engine 

(for example, www.google.co.in) at the address field of the browser. Now the search engine 

opens.  

 

Step 2: Type the text that wants to search (for example, computer) and click search or hit enter. 

Various search results are shown on the screen based on the searched string. 

 

Figure 8. 15 (Searching on search engine) 

 

Step 3: Click the URLs of displayed options or open them in new tab. 

http://www.google.co.in)
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Figure 8. 16 (Google Search Result) 

 

8.22 Downloading and Printing Webpage 
Steps for Download and Printing Webpage in different browsers:  

Chrome: 

 

 Step 1: Click the three-dot icon in the top right corner and choose Print… in the drop-down 

menu. Alternatively, press Ctrl + P.  

 

Step 2: In the resulting pop-up window, click the down arrow to the right of Destination and 

select Save as PDF in the drop-down menu.  

 

Step 3: Click More Settings to change the paper size, scaling, and so on if needed.  

 

Step 4: Once we make the necessary changes, click the Save button and select a destination on 

your PC. Click a second Save button to complete. 
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8.23 Exercise Problems and MCQs 

1. What is internet? 

2. What is ‘intranet’? 

3. Explain in detail about world wide web. 

4. What Is ASCII- American Standard Code for Information Interchange? 

5. Explain Web Server? 

6. What is Web Page? 

7. What is WAIS (wide Area Information Service)? 

8. What is URL explaining in detail  

9. Explain Router? 

10. What Is a Protocol? 

11. What is Network Topology? 

12. What is the difference between Hub, Switch, and Router? 

13. What is a Firewall? 

14. What is meant by 127.0.0.1? 

15. What is NIC? 

MCQs 

1.What is the size of MAC Address? 

a. 16-bits 

b. 32-bits 

c. 48-bits 

d. 64-bits 

Correct answer: c 

2.Office LANS, which are scattered geographically on large scale, can be connected by the use of 
corporate _______. 

a. CAN 

b. LAN 

c. DAN 

d. WAN 
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3.WLAN stands for ________. 

a. Wireless Local Area Network 

b. Wire Lost Area Network 

c. Wireless Local Ambiguity Network 

d. Wired Local Area Network 

4.LAN Topology contains 

a. Bus 

b. Star 

c. Ring 

d. All of these 

5.LAN works on which of the following Layers? 

a. Physical 

b. Datalink 

c. Datalink and Network 

d. Physical and Datalink 

6.Which of the following is a small single site network? 

a. LAN 

b. DSL 

c. MAN 

d. WAN 

 
7.What is the address size of IPv6? 

a. 32 bit  

b. 64 bit 

c. 128 bit 

d. 256 bit  

Correct answer: c 

8.IPv6 has ________ bit address. 

a. 32 

b. 64 
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c. 128 

d. Variable 

9.Internet stands for ____. 

a. Interconnected network 

b. Collection of many webpages 

c. Moving from one website to another 

d. A program used to locate and display webpages 

10.A website is ____. 

a. Interconnected network 

b. Collection of many webpages 

c. Moving from one website to another 

d. A program used to locate and display webpages 

11.The full form of WWW is ____. 

a. Wide World Website 

b. World Wide Website 

c. World Wide Web 

d. Wide World Web 

 

12.The full form of URL is ____. 

a. Useful Resource Logo 

b. Uniform Resource Locator 

c. Useful Resource Language 

d. Uniform Resource Language 

 

13.Which of the following is the example of ISP? 

a. Google chrome 

b. Mozila firefox 

c. Internet explorer 

d. Reliance 
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14.A collection of related webpages is called ____. 

a. Hyperlink 

b. Web browser 

c. Website 

d. URL 

 
15.TCP/IP is a: 

a. Network Hardware 

b. Network Software 

c. Protocol 

d. None of these 
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CHAPTER 9 

E-mail 

9.1     What is E-mail? 

E-mail stands for Electronic mail. It is a computer-based application for the exchange of 

messages between users.  It is one of the most commonly used services on the Internet. It allows 

people to send message to one or more recipients.  

 

 

Figure 9. 1 (Email) 

On October 29th 1969, the first message was sent from computer to computer on ARPANET. 

But complete email service was used in year 1971 by Ray Tomlinson. E-mail is a message that 

may contain text, files, images, or other attachments sent through a network to a specified 

individual or group of individuals. Examples of some E-mail service provider companies are: 

Gmail, Outlook, Yahoo! Mail etc.  

9.2    Structure of an email  

There is a standard structure for emails. Email contents are primarily classified as two, the header 

and the body.  

The contents of the header and the body:  

9.2.1    The Header  
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The email header gives us common details about the message such as the unique identity of the 

message. The details of the users of the ‘from’ and ‘to’ ends are also stored here. The email 

header consists of the following parts. However, the exact contents of the header can vary 

according to the email systems that generate the email message.  

i. Subject 

ii. Sender (From:) 

iii. Recipient (To:)  

iv. cc(carbon copy)  

v. Date and time received (On)  

vi. Reply-to  

vii. Recipient email address  

viii. Attachments  

i. Subject  

The subject part is the topic of the message. In most email systems, if the content view of the 

folders is set to view each messages separately, the subject part also will be visible with the 

user’s name.  

ii. Sender (From:)  

This field describes the ‘from’ address of the email. This will specify the sender’s email address. 

Usually, it will be the “reply-to” address.  

iii. Recipient (To:)  

This is the first/last name of the email recipient as configured by the sender.  

iv. cc(carbon copy) 

 A carbon copy, message is an e-mail that is copied to one or more recipients.  

v. Date and time received (On)  

This is the date and time the, message received.  

vi. Reply-to  

This field describes the email address that will become the recipient of the reply to the particular 

email. When you reply, it will go to this email address despite the sender email address. 

vii. Recipient email address  

The email address of the recipient is specified here.  

viii. Attachments  
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Some emails could be attached with files such as text, image, audio, video etc. These files are 

specified here.  

9.2.2. The Body  
The actual content is stored in this part. This will be in the format of text. This field could also 

include signatures or text generated automatically by the sender’s email system. The contents of 

the emails can be varied according to the different email systems used by each user. 

 

9.3  Opening Email(Gmail) account:  
Step 1: Visit Google account creation page, accounts.google.com 

Step 2: Click on Create account. 

Step 3: The sign-up form will appear. Enter your first and last name. 

Step 4: Choose a Username for your account. (Here you can also use an existing email address) 

Step 5: After choosing a username, enter a password. Type the password again to confirm. (As 

per Google's instruction always use 8 or more characters with a mix of letters, numbers & 

symbols) 

Step 6: At last tap on Next. (Right corner of the screen) 

Step 7: On the next page enter your phone number to verify your account. (It is a two-step 

verification process for security) 

Step 8: On the given mobile number you will receive a text message from Google with a 

verification code. Enter the verification code and tap on Verify. 

Step 9: On the next page enter your date of birth (DOB) in the specified fields. 

Step 10: Choose a Gender. 

Step 11: click on Next. 

Step 12: Read, Google's Terms of Service and Privacy Policy will appear on the screen and click 

on I agree. 

Your account has been created. From now onwards every time you sign in you just have to enter 

your email id and password. And every time you sign-in don't forget to sign-out because it 

prevents others from viewing your emails.  

9.4  Mailbox: Inbox and Outbox 
Inbox − Inbox is an area where you can see all the received mails. 

Outbox − Outbox is an area where the outgoing messages or messages which are in process of 

sending or which are failed to send are stored. 

Sent mail − Sent mail is an area to view all the sent or successfully delivered mails. 
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9.5  Creating and sending a new E-mail 
In order to send a new e-mail to the user, first create or compose the mail, which includes the 

following steps. 

Step 1 − Open your mail account by providing correct User name and Password. 

Step 2 − Compose or create your message by selecting "compose" option shown in the window. 

Step 3 − In the window displayed, enter recipient’s address in "To" textbox and add "Subject" of 

message, then add a "Body" of the message and press "Send" button. Remember, the subject of 

the mail should be explicit and short. 

 

Figure 9. 2 (Compose Email) 

9.6  Replying to an E-mail message 
Replying is giving response to the received mail which includes the following steps: 

Step 1 − Open an email to which you want to reply and press the "Reply" button or press 

"Shift+R" on the keyboard. 

Step 2 − In the window displayed, enter "Body" of the mail and click "Send" button. The mail 

will be sent automatically to the corresponding person without having to re-type the "To" 

address. 
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Figure 9. 3 (Replying to Email) 

9.7  Forwarding an E-mail message 
Forwarding is a process of resending an email message that you received from another email id. 

This option saves time as the user doesn’t have to re-type the same message again. It includes the 

following steps: 

Step 1 − Open the email which you want to forward and click on "Forward" option or press 

"Shift + F" on the keyboard. 

 

Step 2 − In the window displayed, enter the recipient address in "To" textbox and press "Send" 

button. The mail will be forwarded to the corresponding person. 

9.8  Searching Emails 
Searching email is a process of finding the desired email without going through all the emails. 

Step 1 − Type the name, email id or key-term in the search box displayed on top of the window. 

Step 2 − From the list of displayed mails, select desired mail or message. 

9.9  Attaching files with email 

 On your computer, go to Gmail.  

 Click Compose. 

 At the bottom, click Attach . 

 Choose the files you want to upload. 

 Click Open. 
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9.10 Email Signature 
 Select New Email. 

 Select Signature > Signatures. 

 Select New, type a name for the signature, and select OK. 

 Under Edit signature, type your signature and format it the way you like. 

 Select OK and close the email. 

 Select New Email to see the signature you created. 

If you have multiple signatures, go to Choose default signature and select the one you want to 

appear on New messages. You can always change to another signature when writing the email. 

9.11 Introduction to MS Outlook: Configuration and Usage 
Microsoft Outlook is the preferred email client used to send and receive emails by 

accessing Microsoft Exchange Server email. Outlook also provides access contact, email 

calendar and task management features. 

Microsoft Outlook may be used as a standalone application, but it is also part of the Microsoft 

Office suite and Office 365, which includes Microsoft Excel and PowerPoint. Outlook can be 

used as a standalone personal email software, and business customers can use Outlook as 

multiuser software. Users can integrate it with Microsoft Share Point to share documents and 

project notes, collaborate with colleagues, send reminders and more. 

9.12 Configuration of MS Outlook 
What are the steps to configure Outlook? 

Step1:  Setup Outlook Email 

i. Open Outlook. 

 

Figure 9. 4 (Outlook) 

ii. Click the File menu. 
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Figure 9. 5 (File Menu) 

iii. Click Add Account. 

 

Figure 9. 6 (Add account) 

 

iv. Select Manual setup or additional server types and click Next. 

 

Figure 9. 7 (Manual Setup) 

 

v. Select POP or IMAP. Click Next. 
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Figure 9. 8 (POP or IMAP) 

 

vi. Within POP and IMAP account settings, fill out your name and full e-mail address. 

vii. For Server Information, select IMAP for Account Type. Incoming mail server should be 

set to imap-mail.outlook.com, and Outgoing mail server (SMTP) should be set to smtp-

mail.outlook.com. 

 

Figure 9. 9 (IMAP for Account Type) 

viii. Next to Logon Information, fill in your User Name and Password and put a check next 

to Remember password. Then click the More Settings button. 

ix. Go to the Outgoing Server tab. Enable My outgoing server (SMTP) requires 

authentication and Use the same settings as my incoming mail server. 

x. Go to the Advanced tab. For port settings, set Incoming server 

(IMAP) to 993 with SSL encryption, then set Outgoing server 

(SMTP) to 587 with TLS encryption. 

xi. Click OK then Next when finished. 
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xii. Click Close if the account logs in properly. 

xiii. Click Finish. 

xiv. Outlook will need to restart in order to finalize settings. Click 'OK' then re-launch 

Outlook. 

xv. Mail should automatically sync. It may take some time to complete. 

9.13 Usage of MS Outlook 
Basic features of Outlook include the email service, email search, flagging and color coding, 

along with preview pane options. The calendar function enables scheduling, viewing and 

communicating about appointments and meetings. Outlook provides 99 gigabytes of archiving 

data and the ability to set automatic replies. 

 

9.14 Social Networking and e-commerce  
In order to understand their customer in a better way and finding their inclination towards their 

products, the marketers and advertisers are always looking for a number of ways. This requires a 

lot of information to be gathered about the customers. This information could be gathered from 

social media about online users which could be further analyzed to trace the behavior of 

consumers. 

 The various businesses are using social networks like Twitter and Facebook to help them sell 

more products and services. Social media marketing is the latest trend that evolved since last few 

years when it started ruling online communication. It is a form of internet marketing that uses 

various social media platforms in order to achieve marketing and advertising objectives. Social 

media marketing basically involves sharing of content, videos, and images for advertising 

reasons. The various marketing techniques adopted by business is focused on targeting the right 

audience, Consumer Online Brand related activities, and electronic word of mouth.  

9.14.1 Advantages of social media marketing 
The various advantages of using social media marketing are: 

 Social media posts can be used to drive targeted traffic to a specific audience of people. 

 Social media can act as a very useful tool for boosting the business site’s SEO. The traffic 

building on social media pages of one’s business will help their websites get better search 

engine results. 
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 Social media may help to build real producer consumer relationship as the tweets on 

Twitter and Posts on Facebook get an insight into the daily lives of their customers and 

this help them build better marketing strategies. 

 While maximum users take, Twitter and Facebook as simple social networks and not as 

advertising and marketing platforms which makes them respond to one’s business idea in 

a more open way. 

 The most important advantages of using social media is the recognition of a brand, as the 

media itself becomes brand’s content and voice. 

9.14.2 Whatsapp 
WhatsApp is free to download messenger app for smartphones. WhatsApp uses the internet to 

send messages, images, audio or video. The service is very similar to text messaging services, 

however, because WhatsApp uses the internet to send messages, the cost of using WhatsApp is 

significantly less than texting.  

 

figure 9. 10 (Whatsapp) 

9.14.3 Facebook 
Facebook is a social networking website which allows users, who sign-up for free profiles, to 

connect with friends, work colleagues or people they don’t know, online. It allows users to share 

pictures, music, videos, and articles, as well as their own thoughts and opinions with however 

many people they like. 

Users send “friend requests” to people who they may – or may not – know.Facebook has over 1 

billion users. Once accepted, the two profiles are connected with both users able to see whatever 

the other person posts. “Facebookers” can post almost anything to their “timeline”, a snapshot of 

what is happening in their social circle at any given time, and can also enter private chat with 

other friends who are online. 

 

Figure 9. 11 (facebook) 
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9.14.4 Twitter 
Twitter is a free social networking site where users broadcast short posts known as tweets. These 

tweets can contain text, videos, photos or links. To access Twitter, users need an internet 

connection or smart phone to use the app or website, Twitter.com. 

It is a microblogging service -- a combination of blogging and instant messaging -- for registered 

users to post, share, like and reply to tweets with short messages. Nonregistered users can only 

read tweets.People use Twitter to get the latest updates and promotions from brands; 

communicate with friends; and follow business leaders, politicians and celebrities. They also use 

it to stay current on news and events. 

Twitter is another great platform for ecommerce companies. It has 800 million users, and 52% of 

its users say they’ve bought a product they first saw on Twitter. In addition, 81% say that Twitter 

impacts their purchasing decisions more than TV commercials. 

 

Figure 9. 12 (twitter) 

9.14.5 Instagram 
Instagram is a free photo and video sharing app available on iPhone and Android. People can 

upload photos or videos to our service and share them with their followers or with a select group 

of friends. They can also view, comment and like posts shared by their friends on Instagram. 

 

Figure 9. 13 (Instagram) 

9.15 BLOG 
The word “blog” derives from an earlier version “weblog”.A blog is a personal online diary or 

magazine or informational website. A blog is like a website that one can keep updating on a 

regular basis.It is a platform that allows you to share your thoughts among people worldwide.  

Blogs are defined by their format: a series of entries posted to a single page in reverse-

chronological order.Blogs generally represent the personality of the author or reflect the purpose 

of the website that hosts the blog.The author of a blog is often referred to as a blogger. Many 

blogs syndicate their content to subscribers using RSS, a popular content distribution tool. 
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9.16 E-commerce 
E-commerce, also known as electronic commerce or internet commerce. It refers to the buying 

and selling of products and services online. It also refers to the transmitting of funds through the 

Internet. Ecommerce is often used to refer to the sale of physical products online, but it can also 

describe any kind of commercial transaction that is facilitated through the internet. 

 

9.17 Types of e-commerce Models 
There are four main types of ecommerce models that can describe almost every transaction that 

takes place between consumers and businesses. 

1. Business to Consumer (B2C): 
When a business sells a good or service to an individual consumer. A website following the B2C 
business model sells its products directly to a customer. A customer can view the products shown 
on the website. The customer can choose a product and order the same. The website will then 
send a notification to the business organization via email and the organization will dispatch the 
product/goods to the customer. 

e.g. You buy a pair of shoes from an online retailer. 

 

Figure 9. 14 (Business to Consumer Model) 

2. Business to Business (B2B): 
When a business sells a good or service to another business. A website following the B2B 
business model sells its products to an intermediate buyer who then sells the product to the final 
customer. As an example, a wholesaler places an order from a company's website and after 
receiving the consignment, sells the endproduct to the final customer who comes to buy the 
product at one of its retail outlets. 
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Figure 9. 15 (Business to Business) 

e.g. A business sells software-as-a-service for other businesses to use. 
 
3. Consumer to Consumer (C2C): 

When a consumer sells a good or service to another consumer. A website following the C2C 

business model helps consumers to sell their assets like residential property, cars, motorcycles, 

etc., or rent a room by publishing their information on the website. Website may or may not 

charge the consumer for its services. Another consumer may opt to buy the product of the first 

customer by viewing the post/advertisement on the website. 

 

Figure 9. 16 (Consumer to Consumer) 

e.g. You sell your old furniture on eBay to another consumer. 
 
4. Consumer to Business (C2B): 
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When a consumer sells their own products or services to a business or organization. In this 
model, a consumer approaches a website showing multiple business organizations for a 
particularservice. The consumer places an estimate of amount he/she wants to spend for a 
particular service. For example, the comparison of interest rates of personal loan/car loan 
provided by various banks via websites. A business organization who fulfills the consumer's 
requirement within the specified budget, approaches the customer and provides its services. 

 

Figure 9. 17 (Consumer to Business) 

e.g. An influencer offers exposure to their online audience in exchange for a fee. 

 

 

 

9.18 Netiquette 
Netiquette is an abbreviation of network etiquette or Internet etiquette. It is made up of two 

words network and etiquette. The word etiquette refers to a code of polite behaviour in society. 

Hence, netiquette is a code of good behaviour on the Internet.  

This includes several aspects of the Internet, such as email, social media, online chat, web 

forums, website comments, multiplayer gaming, and other types of online communication. 

Netiquette also dictates that users should obey copyright laws and avoid overusing emoticons. 

Netiquette includes rules that provide guidance for appropriate social interaction and technical 

performance online. What constitutes good netiquette varies among the many subcultures of 

the internet and, of course, netiquette issues change with time and technology.  

 

9.18.1 The Common Netiquettes You Must Follow 
Let us now check out some of the common netiquette rules that one must follow while being 

active online − 
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 Apply the same standards online as we do in public 

Remember the etiquette principles you observe in everyday life when speaking online. Avoid 

offending, provoking, threatening, or insulting anyone. Respect your chat counterparts' 

perspectives and offer constructive criticism. Remember that you could face legal consequences 

if you offended someone online. 

 

 Keep away from flames 

A flame message comprises harsh personal criticism or abuse. It is strongly urged that users 

refrain from flaming or participating in flame wars. One must treat others as one would want to 

be treated; therefore, profanity is not acceptable netiquette. It is preferable to speak in a sensible 

tone and polite manner. 

 

 Refusing to encourage internet abuse and harassment 

Accepting that the laws now in place to safeguard citizens' rights and dignity will apply online 

and that laws are revised as needed to embody these rights in the expanded context. 

 

 

 

 

 Protocols for composition when writing messages 

Users should use proper grammar and be mindful of punctuation and spelling. Online 

communications should be clear, brief, and well-organized; a well-written, thoughtful message 

elicits more responses. 

 

 Recognizing cultural differences 

Intercultural acceptance and understanding should continue to exist even after national 

boundaries are no longer applicable. This necessitates accepting that the societal morals of some 

netizens will not be the same as those of all netizens. 

 

 Share with discretion 

Avoid disclosing too much personal information online. Once these details are on the Internet, 

they become immediately accessible to the entire world. Even if you attempt to remove these 

posts later, it may be too late. Some posts may potentially result in serious consequences such as 

identity theft. 
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 Respect people's privacy 

Don't forward information without first verifying with the original sender, as doing so behind 

their back can cause mistrust if they find out. Copy-pasting text or providing screenshots are 

examples of this. The same level of privacy is required when submitting images or videos that 

feature other people to the Internet, whether in a shared environment or on your personal social 

media profile. 

 

 Fact check before reposting 

If you are unsure about the facts behind an internet story or social media post, ask someone who 

knows or can find out. Another alternative is to conduct a Google search to see whether the post 

is true or fake. Urban legends, forged merchant coupons, and other misinformation contribute to 

the Internet's clutter and consume people's time. 

 

 Don't spam 

The term "spam" refers to receiving any unwelcome message. Spamming generally refers to an 

unwelcome email, text message, or social media communication online. If you avoid doing this 

with your contacts, you will be able to keep your connections intact. 

If you wish to share anything with your contacts, make sure you get permission first. This single 

step can save you from becoming stymied. 

 

Furthermore, many of the most dangerous virus attacks on record have been distributed via mass 

emails. So, don't open an email or a social media message from somebody you don't know. If the 

communication includes a download link, double-check with the source before accessing it to 

ensure it isn't sent by someone impersonating them. 

 

 Update online information 

Don't put misleading information online simply because you're too busy to update your profile or 

your company's website if you operate a business. If you're likely to be unavailable, don't leave 

your work hours online, implying that you'll be available. Takedown your website if you can't 

maintain it up to date. 
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If you're actively hunting for work online, following this netiquette standard is vital. If 

prospective employers see outdated information on your professional platform profile, they may 

conclude that you are uninterested in finding a job. 

 

9.19 E-GOVERNANCE  
Electronic governance or e-governance is a means to provide the government services to the 

doors of the citizens. It is an integration of all government departments and their services with 

the use of information and communication technology (ICT). Through the e-Governance, the 

Government services will be made available to the citizens in a convenient, efficient and 

transparent manner. 

The aim is to enhancing the government ability to address the needs of the general public. The 

basic purpose of e-governance is to simplify the accessibility of the government services for 

citizens at national, state and local levels. Hence e-Governance is basically a move towards 

SMART governance implying: simple, moral, accountable, responsive and transparent 

governance. 

Some of the important e-governance services are mentioned below 

 

 

9.20 RAILWAYS RESERVATION  
In order to provide the services of railways to each and every passenger in hassle free manner is 

achieved by the concept of e-governance. It makes the services and policies more transparent, 

easy and less corrupted. Some the applications that were launched by the government of India in 

past few years which make functionality of railways more efficient are given below: 

 

9.21 CRIS (Centre For Railway Information System)  
CRIS is currently developing systems to cover emerging needs of the Railways including the 

protection of Railway assets, energy management, and management of the overhead 

electrification system, parcel management, employee’s health management and a comprehensive 

financial management system. Other projects under execution include development of ticketing 

on mobile phones, linking tickets to Aadhaar, tracking of trains in real time through GPS, 

tracking of rolling stock using radio frequency identification, setting up a geo-spatial database for 

the Railways and the setting up a state-of-the-art data centre to house the Railways IT system.  
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9.22 RAIL SAARTHI  
Rail saarthi stands for “Synergised advanced application rail travel help and information”. It 

provides options such as safety for women, complaint facility and suggestion for improvement. It 

is an integrated mobile application to cater various passenger requirements, including ticket 

booking, inquiry on board cleaning and ordering meal on a single platform.  

 

9.23 UTS ON MOBILE  
UTS mean “Unreserved Ticketing System”. It is a mobile application which enables booking and 

cancellation of unreserved tickets among a host of other facilities. This app will also enable issue 

and renewal of season and platform tickets, check and load R-wallet balance and help maintain 

user profile management and booking history. 

 

9.24 Passport  
The Ministry of External Affairs (MEA) is responsible for issuance of Passports to Indian 

Citizens through a network of 37 Passport offices across the Country and 180 Indian Embassies 

and Consulates abroad.  

 

Passport Seva is a step taken by Ministry of External Affairs (MEA) which enables simple, 

efficient and transparent processes for delivery of passport and related services. It converts the 

long and complex process of passport into easy and time bounded process such as it integrates 

the State Police for physical verification of applicant's credentials and India Post for delivery of 

passports.  

9.25 e-Hospital[ORS] 

Online Registration System (ORS) is a framework to link various hospitals across the country for 

Aadhaar based online registration and appointment system, where counter based OPD 

registration and appointment system through Hospital Management Information System (HMIS) 

has been digitalized. The application has been hosted on the cloud services of NIC. It is a 

workflow based ICT solution for Hospitals specifically meant for the hospitals in Government 

Sector. This covers major functional areas like Patient care, Laboratory services etc.  

 

Online Registration System (ORS) provides services such as:   
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 Book Appointment Now- Book the appointment with the doctor without standing in 

longqueue.   

 Lab Reports- Reports can be downloaded from the website directly. 

 Blood Availability- Blood donor and receiver both can see the blood availability. 

 Payment- Online payments can be made for the doctor consult fees and medicine costs. 

9.26 e-Governance services on Mobile Using “UMANG APP”  
UMANG stands for “Unified Mobile Application for New-age Governance”. This app is 

developed by Ministry of Electronics and Information Technology (MeitY) and National e-

Governance Division (NeGD) to drive mobile Governance in India. UMANG provides a single 

platform for all Indian Citizens to access PAN India services. UMANG service has been made 

available on multiple channels like mobile application, web, IVR (Interactive Voice Response) 

and SMS which can be accessed through smart phones, feature phones, tablets and desktops. 

 

Figure 9. 18 (Umang App) 

 

 Key features of “UMANG APP UMANG intends to provide major services offered by Central 

and State Government departments, Local bodies and other utility services from private 

organizations. Some of the key features of UMANG App are:  

 Integration with Aadhaar, PayGov, DigiLocker 

 Ease of Access 

 Government Services on your finger tips 

 Dedicated Customer Support286 
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9.27 Digital Locker 
DigiLocker is an Indian digitization online service provided by Ministry of Electronics and 

Information Technology (MeiTY), Government of India under its Digital India initiative. 

Government come up with the concept of DigiLocker, where registered user can upload their 

important documents.  

 

Figure 9. 19 (DigiLocker) 

It minimizes the usage of physical documents and enables the sharing of e-documents across 

various agencies. Indian citizens, who sign up for a DigiLocker account gets a dedicated cloud 

storage space that is linked to their Aadhaar(UIDAI) number. Indian citizens or Organizations 

that are registered with Digital Locker can upload electronic copies of documents and certificates 

(e.g. driving license, Voter ID, School certificates). These documents can be electronically 

signed using the e-Sign facility. 

9.27.1  How to create a DigiLocker account? 

 Type https://digitallocker.gov.in/ in the address bar of the browser. 

 Click on the Sign Up option on the right top corner of the screen. 

 On next screen, enter mobile number and click continue. 

 OTP will be sent on entered mobile number. Type the received OTP  

 Now a User creation window will open Where user has to fill its Username and Password 

for its digital locker account  

 Then press the Sign up option. 

 

 

https://digitallocker.gov.in/
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9.28 AarogyaSetu 
AarogyaSetu is a mobile application to keep people informed of their potential risk of Covid19 

infection. The Government of India launched AarogyaSetu mobile App on 2nd April,2020 to 

protect Indian citizens from mass spread of coronavirus. The AarogyaSetu App on your phone 

detects other devices that have the same app when they come within the bluetooth proximity of 

your phone. When this happens, both the phones securely exchange a digital signature of that 

interaction, including time, proximity, location and duration.  

This data is stored on devices of all individuals. In case any person that you came in contact with 

in the last 14 days tests positive for coronavirus, the app calculates your risk of infection based 

on your proximity of interaction with that person. The app then recommends a suitable action.  
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9.29 Exercise Problems and MCQs 
1. What do CC and BCC mean? 

2. What’s the difference between IMAP and POP3? 

3. What is a phishing email? 

4. What is e-government and e-governance? 

5. Why is e-governance important? 

6. What are the 4 models of e-governance? 

7. What are the main challenges and courses that control e-governance in India? 

8. Which is the utilization of electronic technology in the administration? 

9. What do you understand by E-services? 

10. Explain government to the business model? 

 

MCQs 

1. Sending an e-mail is similar to 
a. picturing an event 
b. narrating a story 
c. writing a letter 
d. creating a drawing 

 
 

2. What is an E-mail 
a. An electronic mail that established person to person connectivity 
b. it enables the computer users to send , store & retrieve message by computer at any 
time from any location 
c. Both a & b 
d. Either a or b 
 
 

3. Facebook and Linked are popular social networks globally. 
a.True 
b.False 
c.Maybe 
d.Maybe not 
 

4. White label social network’s primary difference is that it is privately run by a nonprofit 
organization. 
a.True 
b.False 
c.maybe 
d.Maybe not 
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5. G2C stands for …………… 

a. Government to cooperation 

b. Grievances to cooperation 

c. Government to citizen 

d. None of these 
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CHAPTER 10 

 Digital Financial Resources 
  
10.1     Digital Financial Tools 
When something is digitalized, it may be accessed or obtained in a digital version via devices 

like tablets, laptops, and mobile phones. The development of computers and smartphones has had 

a significant effect on the financial services industry. Today, a person can check his or her bank 

account, confirm account information, transfer funds, deposit cash, renew deposit, pay bills, book 

tickets, etc. using computers and mobile phones. Additionally, the time it took to withdraw 

money from banks was shortened by the invention of ATMs. By offering services with a single 

touch, digital services contribute to time savings. They desire constant access to information. 

This information is provided by Digital Financial Tools. 

Delivering financial services via technical advancements like mobile phones is the primary goal 

of digital financial services. For small businesses, digital finance also has a crucial role to play. 

In addition to giving them access to funding, it also gives them the chance to access safe financial 

goods, electronic payment systems, and a financial history. A variety of different financial 

services, such as credit, insurance, savings, and financial education, may be offered and used as a 

result. Components which are involved in digital financial tools are platform, agent and device. 

Platforms enable a customer to utilise a device to send or receive payments. Agent is digital 

service used to send and receive transaction details which is connected to communications 

infrastructure. Device may be digital, such as a mobile phone, which is used to transfer data and 

information, or it may be a physical object, such as a credit card reader, which is connected to a 

digital device, such as a POS terminal. 

10.2 Understanding OTP and QR Code 

10.2.1 OTP 
A one-time password (OTP) is a randomly generated string of letters or numbers that serves as 

the user's authentication for a single login or transaction. A dynamic password commonly 

referred to as a one-time pin or an OTP which is more secure than a static password. Static 

password may be vulnerable or used on many accounts. OTPs could be used as login credentials 

for authentication, or they could be used in addition to them to add a further measure of 

protection. 

An authentication manager on the network server uses one-time password methods to produce a 

number or shared secret whenever an unauthorised user tries to enter a system or carry out a 
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transaction on a device. The security token on the smart card or device uses the same number and 

algorithm to compare and validate the one-time password and user. 

Following are the features provided by QR code 

 The one-time password helps security managers and IT administrators avoid common 

password security issues.  

 They don't need to be concerned about composition guidelines, well-known terrible and 

weak passwords, sharing of login information, or using the same password across several 

systems and accounts. 

 One more benefit of one-time passwords is that they expire after a short period of time, 

preventing hackers from gaining and reusing the secret information. 

10.2.2 QR Code 
QR Code is acronym for Quick Response Code. Smartphones can read two-dimensional barcodes 

called QR Codes. In addition to opening a URL, adding a contact to the address book, and 

displaying content to the user, QR codes can also be used to create text messages. DENSO 

WAVE INCORPORATED has "QR Code" on file as a trademark. It is an optical label that can 

be read by machines and contains details about the related object or product. To keep track of 

automobile part inventories, QR codes were created for auto production facilities. To store 

information effectively, a QR code uses four defined encoding formats: numeric, alphanumeric, 

byte/binary, and kanji. 

You need the software installed on your phone in order to read QR Codes with a smartphone. 

You may use QR code Scanner on Android-based devices. There are also QR Code scanners for 

iOS devices like iPhones in the AppStore. 

Once you've installed one, open the app and use your smartphone's camera to scan the QR code. 

The encoded address or action will be immediately accessed if the Code is readable. 

 

Figure 6.1 (QR code) 

Following are the features provided by QR code: 

 Standard bar codes can hold up to 20 digits of data. However, compared to bar codes, QR 

codes can offer up to a hundred times more information. All forms of data, including 

words, figures, images, and audio or video files, can be managed using QR codes. 
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 Due to the two-dimensional layout of the QR code symbol, it can encode 10 times more 

data than a barcode of the same size. For a print size that is smaller, a tiny QR code can 

be used. 

 The QR code has the capacity to remedy mistakes. Even if a portion of the sign has been 

lost or damaged, data in QR codes can still be recovered. 

 Easily readable from any angle 

10.3 UPI 
Unified Payment Interface (UPI) is a system developed by National Payments Corpotation to 

quickly transfer money for payments in real time. A smartphone app called Unified Payment 

Interface (UPI) enables users to transfer money between bank accounts. The National Payments 

Corporation of India developed the single-window mobile payment system (NPCI). Every time a 

customer starts a transaction, there is no longer a need to enter sensitive information like bank 

account numbers. With the help of the innovative payment system known as UPI, you may 

securely link your bank account to a smartphone application and conduct transactions. 

A bank account's UPI ID serves as a special identity that may be used to transfer and receive 

money. To authorise a money transfer via UPI, a 4-digit personal identification number known as 

the UPI PIN must be entered. The account holder has the option of choosing the PIN. 

To facilitate seamless settlement across accounts, UPI makes use of already-existing systems like 

Immediate Payment Service (IMPS) and Aadhaar Enabled Payment System (AEPS). It enables 

push (pay) and pull (receive) transactions and even accepts barcode or over-the-counter payments 

in addition to several regular payments like utility bills, tuition, and other subscriptions. 

 

Figure 6.2 (UPI logo) 

On the UPI, sending money is referred to as "pushing." The user logs into the interface and 

chooses the Send Money/Payment option to send money. He selects the account from which the 

funds will be debited after inputting the necessary amount and the recipient's virtual ID. After 

entering a unique personal identification number (PIN), the user is given a confirmation.’ 

The UPI application is downloaded by the user through the bank's or app store website. User 

establishes profile by providing information such as name, password, virtual id (payment 
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address), etc. The user selects "Add/Link/Manage Bank Account" and associates the virtual ID 

with the bank and account number. 

Following are the features provided by QR code 

 Instantaneous fund transfers using the quicker-than-NEFT Immediate Payment Service 

(IMPS).  

 UPI may be used whenever you want, including on all national holidays because it is 

entire digital. 

 Access to many bank accounts using a single mobile application. 

 One can file complaint online for their transaction. 

 Each bank offers a unique UPI for various versions of Android, Windows, and iOS. The 

UPI service may or may not be charged for by the banks. 

10.4 AEPS 
Aadhaar Enabled Payment System is known as AEPS. It is a brand-new payment service that 

uses "Aadhaar" and is provided to banks and other financial institutions by the National 

Payments Corporation of India. Aadhaar-enabled payment system (AEPS) You can carry out a 

variety of fundamental banking operations with the aid of AEPS, including multiple payments, 

intrabank or interbank money transfers, cash withdrawals, cash deposits, checking your account 

balance, etc. The AEPS platform is straightforward, secure, and user-friendly for all of your 

financial activities. 

 

Figure 6.3 (AEPS)  

The 12-digit Aadhaar number is exclusively given to Indian citizens by the UIDAI (Unique 

Identification Authority of India). The AEPS device functions similarly to a Point of Sale (POS) 

device. The customer's Aadhaar number must be entered by the retailer in place of a debit or 

credit card pin in order to confirm the transaction using the customer's biometric information. 

Service which are offered by AEPS are Cash Withdrawal, Cash Deposit, Balance Enquiry, 

Aadhaar to Aadhaar Fund Transfer and Mini Statement . 

Customer requited to have Bank’s Issuer Identification Number (IIN) or name , Aadhaar Number 

and  Fingerprint. 
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How to use AEPS 

1. Go to a micro ATM or banking correspondent 

2. Enter your Aadhaar number and bank information. 

3.  then select the sort of transaction you wish to complete  

4. Fingerprint or iris scan is used for verification. 

5. Generate transaction receipt. 

 

Following are the features provided by AEPS 

 Completely secure and safe payment method 

 Compatible with a variety of banks 

 With AEPS digital India payments, the only requirements for initiating a transaction are 

an Aadhaar number and the appropriate biometric data. 

  Using AEPS, bank account holders would be able to access their accounts in banks 

using Aadhaar verification. 

10.5 USSD 
Unstructured Supplementary Service Data is referred to as USSD. It is a technological 

framework that enables information to be transmitted on a basic phone over a GSM (Global 

System for Mobile Communications) network. All mobile phones with SMS capabilities will be 

able to access this service. 

USSD enables customers to access mobile banking via the *99# code even without a smartphone 

or data/internet connection. There are 12 languages supported by this programme, including 

English and other Indian languages. The *99# service is currently offered by various banks in 

India. 

Users only need to dial *99# and choose an option from the interactive menu in order to use 

USSD mobile banking. The *99# service is currently offered by various banks in India. The *99# 

payments service's principal goal is to enable the underbanked and economically underprivileged 

segments of society to participate in mainstream banking. 

User can perform financial services as well as non-financial services.Financial services include 

fund transfer using MMID, Aadhar and account number. Non-financial services include balance 

enquiry , mini statement  and pin generation. 

How to use USSD 

 When you phone *99# from your registered mobile number , an interface will appear 

where you can click "Send 
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  Type the first four letters of your bank's IFSC or the first three letters of your bank's short 

name. 

 Now choose 3 and " enter the payee's or beneficiary's mobile number. 

 The beneficiary/payee MMID and transaction amount should now be entered. 

 Enter your MPIN and your bank account number's last four digits. 

 

Following are the features provided by USSD 

 It works on a basic phone without a data connection. 

 Simple to use 

 Support all GSM mobile phones 

 Extremely safe interface 

10.6 Cards 
With 16-digit card numbers, expiration dates, and personal identification numbers (PIN) codes, 

credit and debit cards often have a similar appearance. Customers of banks can use their debit 

cards to make purchases using money they have deposited at the bank. Customers who use credit 

cards can borrow money from the card issuer up to a predetermined limit in order to make 

purchases or cash withdrawals. 

 

10.6.1 Credit Card 
A credit card is a payment card that users (cardholders) can use to borrow money from financial 

institutions. Cardholders consent to returning the money, plus interest, in accordance with the 

institution's rules. Banks, credit unions, or other financial institutions often issue the majority of 

popular credit cards, including Visa, MasterCard, Discover, and American Express. 

 

Following are the features provided by Credit Card 

 Carrying cash is riskier than using a credit card. 

 Earn points for your purchases. 

 Credit cards are accepted in all currencies. 

 Credit cards provide you with an emergency credit line. 
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10.6.2  Debit Card 
An alternative to borrowing money from a bank, a debit card deducts funds from the user's 

checking account. Using your savings to make purchases without carrying cash or paper checks 

is possible with debit cards. It is sometimes referred to as a check card or bank card. Debit cards 

can act as an ATM card for instant cash withdrawals and as a check when making a purchase. 

 

Following are the features provided by Debit Card 

 A debit card is simple to obtain. 

 There are no more debts, and they are generally recognised everywhere. 

 You are not need to bring cash with you. 

 Multiple debit cards may be linked to a single account. 

10.7 E-Wallet 
A sort of electronic card called an e-wallet, often known as a "digital wallet," enables you to 

make purchases using a computer or a smartphone. It's a pre-paid account where a user can keep 

money for upcoming internet purchases. It has a password lock. To make payments, an E-wallet 

must be connected to the user's bank account. It serves the same purpose as a credit or debit card. 

An electronic wallet is a safe location where you can store other things like your driver's licence, 

gift cards, tickets, and transportation passes. The primary goal of an e-Wallet is to facilitate 

paperless financial transactions. Paytm, Mobikwik, PhonePe, Freecharge, Airtel Money, State 

Bank Buddy, ICICI Pockets, and other e-Wallet payment gateways are among the numerous ones 

available in India. 

 

How to transact in e-wallet 

 Install the e-wallet app on your phone. 

 Register by providing the necessary information. 

 A password will be given to the user. 

 After making an online purchase, the e-wallet will automatically fill up the user's 

information on the payment form. To load money, use a debit/credit card or Net banking. 

 Once an online payment has been made, the user is not necessary to fill out an order form 

on another website because the data is automatically updated and kept in the database. 

Following are the features provided by e-wallet. 

 Simple to use 

 Quick Transaction 
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 Digital wallets do not have a minimum balance requirement. 

 Given that they are password-protected, digital wallets are secure. 

10.8 POS 
POS is acronym for Point of Sale. Any location where a transaction can take place, whether it is 

for a good or a service, is referred to as a POS. In other terms, the point of sale (POS) is where a 

customer pays for goods or services at your business. In a store, a POS is where transactions like 

checkout, order processing, and bill payment take place. It may be at a physical sales point like a 

retail location where card payments are handled by POS terminals and systems, or it may be a 

virtual sales point like a computer or mobile device. 

 

Figure 6.4 (POS terminal) 

The hardware and software system used for billing in a POS Store is known as a POS System. 

Additionally, card readers have grown to be crucial components of POS systems. 

A display unit to show the billing and a keyboard/touchscreen device to pick products and enter 

data are often included in a POS system. A barcode scanner for billing objects, along with a pos 

terminal for transactions. 

Following are the features provided by POS. 

 POS reduces human mistake and, over time, saves money. 

 POS keeps track of your sales data and notifies you when stock levels are low. 

 POS maintains accurate records of everyday transactions and reports on stock volume. 

 Because the programme verifies that the information entered is precise and correct, POS 

lessens the likelihood of user errors. 

 POS enables you to include product discounts and promotions. 

10.9    Internet Banking 
Online banking, often known as Net Banking, is another name for internet banking. The 

customer has the option to execute both financial and non-financial transactions through his net 

banking account. It enables you to carry out a variety of transactions online while relaxing in the 
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comfort of your home. The user can transfer money from his account to other accounts at the 

same bank or at another bank using Internet Banking. 

 

Internet access is necessary for the user. The safety of transactions is a serious problem. 

Password security is another important concern in internet banking as it have to  follow strong 

password policy and changed in every 6-month.Your banking information may be dispersed 

across multiple devices, increasing its risk. Deposits are inconvenient to make in internet 

banking. 

 

Following are the features provided by POS. 

 Account statements are accessible to the user. 

 Various paperwork, including bank statements, are available for download. 

 The user can recharge mobile phones, DTH connections, pay any form of bill, and 

transfer money. 

 On e-commerce sites, users can buy and sell products. 

 The user can also reserve travel, medical, and transportation services. 

 The user may also review the transaction history kept by the relevant bank for a specific 

time period. 

 

10.10 National Electronic Fund Transfer (NEFT) 

National Electronic Funds Transfer is known as "NEFT." One of India's most well-known 

electronic fund transfer systems is NEFT. It is a service offered to bank customers that enables 

quick and secure one-to-one money transfers. It denotes a system for moving money online 

between financial institutions in India, typically banks. The Reserve Bank of India (RBI) 

launched the National Electronic Funds Transfer (NEFT) in November 2005. 

The NEFT system allows individuals, businesses, and corporations with accounts at any bank to 

transfer money. Using the NEFT system, people, businesses, and corporations with accounts at 

any bank can receive money. Therefore, the beneficiary must have a bank account with the local 

branch of the destination bank that supports NEFT. 

 

The NEFT system is accessible every day, i.e., on a 24 hour, 7 day, a year basis. NEFT currently 

runs in batches throughout the day at intervals of every half-hour. If NEFT is unavailable for 
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whatever reason, RBI will broadcast the relevant notification to all system users. It is suitable for 

small money transfer. 

Minimum charges by RBI  

 Upto 10,000 – Rs. 2.5 

 from 10,001 to 1 lac – Rs. 5  

 from 1 to 2 lacs – Rs. 15  

 Above 2 lacs – Rs. 25 

 

Following are the features provided by NEFT. 

 No need to visit bank due to online money transfer via NEFT. 

 No upper and lower limits are imposed. 

 All domestic bank offices offer this service.  

 NEFT is constructed on a safe foundation. 

 It is available throughout regular business hours, which are 8 am to 6:30 pm, Monday 

through Friday, and 8 am to 1 pm, on working Saturdays. 

10.11 Real Time Gross Settlement (RTGS) 
Real Time Gross Settlement is what "RTGS" stands for. It is a Reserve Bank of India-managed 

electronic payment system that enables real-time, gross settlement interbank money transfers. 

Real-time refers to the fact that there is no waiting involved in the payment transaction. As soon 

as the processing is complete, the transaction will be finished. 

Gross settlement refers to the completion of the transaction one to one, without clustering with 

other transactions. It is suitable for large money transfer. 

Minimum charges by RBI  

 Upto 2 to 5 lacs - Rs. 25-30 

 Above 5 lacs -  Rs. 50-55  (charges are lower in  first half of day) 

Following are the features provided by NEFT. 

 Real-time, in a short while. 

 A minimum of Rs. 2,000,000 is allowed. 

 Only branches with RTGS capabilities are able to offer it. 

 It is been offered between 8 a.m. and 4 p.m. on bank working days. Working Monday 

through Friday and on Saturday. 
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10.12 Immediate Payment System (IMPS) 
Immediate Payment Service is referred to as IMPS. Through mobile phones, there is an 

immediate interbank electronic fund transfer service. Additionally, it is being spread through 

additional channels including ATMs and online banking. Banks offer this service to guarantee 

real-time interbank cash transfer. Contrary to NEFT, IMPS allows for the transmission of funds 

on any day of the week, including holidays and weekends. 

 

The main benefit of IMPS is that it is constantly usable. It is a superb banking platform in an 

emergency and sends money instantly. The transaction cap for IMPS transfers is typically set at 

Rs. 2 lakh. But banks are free to set their own maximum amount for an IMPS transaction. 

Customers can do mobile banking operations, receive payments, and transfer funds using the 

IMPS service. When transferring cash via IMPS, we are required to have at least one of the 

beneficiary's mobile number, Mobile Money Identifier (MMID), bank account number, and IFSC 

Aadhaar number. 

10.13     Online Bill Payment 
Online bill payment options provide a practical, secure, and reasonably priced way to guarantee 

that all of your payments are paid on time. It is a service that enables you to safely pay your bills 

online or through an app. This service is provided by numerous financial institutions. Customers 

can pay their bills online using a safe electronic service instead of writing cheques and mailing 

them. The majority of the time, online bill payment is linked to a bank account from which 

money is electronically withdrawn to pay one-time or recurring bills. 

The reduction of paper waste is one of the main advantages of online bill payment. Online bill 

payment will help you use fewer paper checks. It also removes the expense of postage and 

envelopes in addition to eliminating paper waste. 

 

Following are the features provided by online bill payment. 

 It saves time and simple to use. 

 It aids in record keeping, is safe, and secure. 

 Online Bill Pay is Ecological and simplifies financial management. 
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10.14     Exercise problems and MCQs 

 Explain briefly about IMPS AND Online bill Payment 

 What are the Transaction limit regarding RTGS and NEFT 

 Write short note on RTGS AND NEFT 

 What is Digital Financial Tools and its main component. 

 Explain OTP 

 

MCQs 
1. What is the  Full Form Of MMID? 

a) Mobile Money Identificator 

b) Mobile Money Information 

c) Mobile Money Identifier 

d) None of these 

 

2. USSD was launched by which organisation 

a) RBI 

b) SBI 

c) BANK OF BARODA 

d) UNION BANK OF INDIA 

 

3. What benefit does using the internet to pay bills have? 

a) You can pay faster 

b) You can save money 

c) You can track transactions on real time 

d)  All of the above 

4. How many NEFT daily settlement batches exist on a weekday? 

a) 12 

b) 24 

c) 11 

d) 23 
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5. Which is not necessary in order to use the POS system's services? 

a)  PIN 

b) Internet 

c) Debit/Credit Card 

d) Account Number 
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